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Introduction

Enterprise Architect, in addition to its extensive features as a fully fledged Integrated Development Environment,
provides tools for visualizing and analyzing software execution that have a profound effect on the way that code is
managed, maintained and documented. Much of this capability is unique to Enterprise Architect, which uses its rich
visualization and modeling facilities to bring programming code to life, effectively allowing the code to be put under the
microscope.

Code hot spots and faults can be analyzed, errors and opportunities for speed improvements can be identified quickly,
and resolutions to errors found. These features can be used while building and testing software products, but are also
profoundly useful for documenting existing or legacy systems. Commonly there is no documentation for these systems
and it is prohibitively expensive or even intractable to get the code documented by conventional means. Enterprise
Architect can create sophisticated, elegant and valuable models and documents that completely describe the code base,
including expressive Sequence diagrams and static models. This type of documentation is a number of generations more
advanced than the simplistic and often opaque documentation generation tools such as JavaDoc.
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Execution Analysis
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The Visual Execution Analyzer (VEA) is made up of an advanced and comprehensive suite of tools that allow you to
build, debug, record, profile, simulate and otherwise construct and verify your software development while keeping the
code tightly integrated with your model. Enterprise Architect has rich support for a wide range of popular compilers and
platforms, in particular the Java, .Net and Microsoft Windows C++ environments. Software development becomes a
highly streamlined visual experience, quite unlike working in traditional environments.

Enterprise Architect is itself modeled, built, compiled, debugged, tested, managed, profiled and otherwise constructed
totally within the Visual Execution Analyzer built into Enterprise Architect. While the VEA can be used to complement
other tool suites, it also shines when used as the primary development IDE in close coupling with the model and project
management capabilities provided by Enterprise Architect.

Access
Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer
Keyboard Shortcuts Shift+F12

Execution Analyzer Features

Feature Description

Build and Debug Using Analyzer Scripts linked to Model Packages, it is possible to tightly integrate
the code/build/debug cycle into Enterprise Architect. For Java, .Net and Microsoft
C++ in particular, it is simple to link to project code bases and take over the
building and debugging within Enterprise Architect's Model Driven Development
Environment. In addition to standard debugging features, the strong coupling with
the model and the use of advanced debugging features such as Action Points makes
Enterprise Architect the ideal platform from which to both design and construct
your software application.

Simulation Bring your behavioral models to life with instant, real-time behavioral model
execution. Coupled with tools to manage triggers, events, guards, effects,
breakpoints and simulation variables, plus the ability to visually track execution at
run-time, the Simulator is an effective means of 'watching the wheels turn' by
visualizing execution of your behavioral models.

Profiling Lift the hood on software performance and see what is actually going on. Quickly
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gain a clear picture of why certain tasks behave poorly or worse than expected.
Whether its Microsoft .NET, native C++ or Java, use profiles to effectively judge
Gl - R changes in performance over your software lifecycle.

Recording Execution Record the execution of code without the need for instrumentation. Control the
amount of detail through filters and stack depth. Generate beautiful Sequence
diagrams and diagrams that illustrate Class collaboration. Use recording to create
Test Domain diagrams that can be used with the VEA Testpoints feature.

Testing Create and manage test scripts for model elements. Explore the Testing interface,
supporting unit, integration, scenario, system, inspection and acceptance tests.
— Employ programming by contract methodology with the Testpoints facility.

=

Object Workbench Workbench Class behavior on the fly, by instantiating them in the Object
Workbench and then invoking their operations. You can even pass objects on the

. \ workbench as parameters to other workbench objects.

Visual Execution Analyzer Try our sample patterns to set up and explore the rich set of features in the Visual
Samples Execution Analyzer.

Benefits of the Execution Analyzer

The Execution Analyzer provides an integrated development and testing environment for multiple platforms, including
Microsoft .NET, Java, Native C++, Mono and Android. It includes a feature-rich debugger, execution recording and
profiling, and Testpoint management.

It helps you to generate Sequence, Test Domain Class and Collaborative Class diagrams from a single recording. This is
a great way to understand and document your application.

e Visualize program execution

e  Optimize existing system resources and understand resource allocation

e  Verify that the system is following the rules as designed

e  Produce high quality documentation that more accurately reflects system behavior
e Understand how and why systems work

e Train new employees in the structure and function of a system

e Provide a comprehensive understanding of how existing code works

e  Identify costly or unnecessary function calls

e [llustrate interactions, data structures and important relationships within a system
e Trace problems to a specific line of code, system interaction or event

e Establish the sequence of events that occur immediately prior to system failure

e Simulate the execution of behavior models including StateMachines, Activities and Interactions
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Operations

Operation

Simulate Behavior

Record Execution

Profile Behavior

Test Use Cases with the
Testpoints System

Open Console Window

Object Workbench
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Description

Simulate UML behavior models to verify their logical and design correctness, for:
e Activities
e [nteractions and Sequences

e  StateMachines

Record executing programs and represent the behavior as a UML Sequence
diagram; recording is supported for:

e  Microsoft Windows Native C, C++, Visual Basic
e  Microsoft .NET Family (C#, J#, VB)

e Java

e Mono

e Android
e PHP

Quickly view / report on behaviors of running applications. Profiling is supported
for these platforms:

e  Microsoft Native C, C++, Visual Basic

e Microsoft NET Family (C#, J#, VB) (including any unmanaged / managed

code mix)
e Java
e Mono

Testpoints Management provides a facility to define the constraints on a Class
model as contracts. The contracts provide the assets on which to create Test
domains. A single Testpoint domain can then be used to test and report the behavior
of multiple applications. You can also use the Execution Analyzer to record a Use
Case and generate a Test Domain diagram with very little effort. Any existing
Testpoints are automatically linked to the generated domain or the Test Domain
diagram can be used as the context for new contract compositions. How an
application behaves for a given Test domain can be seen immediately in real time!
Results are displayed in the Testpoint report window every time a contract is passed
or failed. The decoupling of test measurement from the code-base has a number of
benefits, one of which is aiding the reconciliation of multiple systems with a
common Test domain, rather than one another.

The Testpoint system supports these contracts:
e (Class invariants

e Method pre-conditions

e  Method post-conditions

e Line conditions

The Console window is a command line interpreter through which you can quickly
create a terminal window to enable a script engine and enter commands to act on
the script (JScript, JavaScript and VBScript).

Create and work with objects created within the Enterprise Architect modeling
environment using a dynamic Object Workbench.
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e Create objects from Class model

e Invoke methods and view results

e  Workbench Class collaboration

e Pass objects as parameters to other objects

e  Full debugging features including recording

Run xUnit Tests Run nUnit and jUnit tests for Java and Microsoft NET

Record and document results.

Import Code from Analysis Execution Recording and Profiling both acquire a collection of relevant code files,
which you can reverse-engineer to the current model in a single operation.
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Build and Debug
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Enterprise Architect builds on top of its already exceptional code generation, diagramming and design capabilities with a
complete suite of tools to build, debug, visualize, record, test, profile and otherwise construct and verify software
applications. The toolset is intimately connected to the modeling and design capabilities and provides a unique and
practical means of constructing software from a model and keeping model and code synchronized.

Enterprise Architect helps you define 'Analyzer Scripts' linked to Model Packages that describe how an application will
be compiled, which debugger to use and other related information such as simulation commands. The Analyzer Script is
the core configuration item that links your code to the build, debug, test, profiling and deployment capabilities within
Enterprise Architect.

As a measure of how competent the toolset is, it should be noted that Enterprise Architect is in fact built, debugged,
profiled, tested and otherwise constructed fully within the Enterprise Architect development environment. Many of the
advanced debugging tools such as Action Points have been developed to solve problems inherent in the construction of
large and complex software applications (such as Enterprise Architect) and are routinely used on a daily basis by the
Sparx Systems development team.

It is recommended that new users take the time to fully understand the use of the Analyzer Scripts and how they tie the
model to the code, to the compilers and to other tools necessary for building software.

Integrating Model and Code

Model Driven Engineering is a modern approach to software development and promises greater productivity and higher
quality code, resulting in systems getting to market faster and with fewer faults. What makes this approach compelling is
the ability for the architecture and the design of a system to be described and maintained in a model, and then generated
to programming code and schemas that can be synchronized with and visualized within the model.

Enterprise Architect's Model Driven Development Environment (MDDE) supports this approach and provides a set of
flexible tools to increase productivity and reduce errors. These include the ability to define the architecture and design in
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models, generate code from these models, synchronize the code with the models and maintain the code in sophisticated
code editors. Source code or binaries can also be imported, and users can record and document pre-existing or recently
developed code. The Analyzer Script tool helps you to describe how to build, debug, test and deploy an application.

Facility Description
Model Driven Model Driven Development provides a more robust, accessible and faster
Development development cycle than traditional coding-driven cycles.

A well constructed model, intimately linked with source code build, run, debug, test
and deploy capabilities provides a rich, easily navigated and easily understood
target architecture. Traceability, linkage to Use Cases, Components and other
model artifacts, plus the ability to readily record and document pre-existing or
recently developed code, make Enterprise Architect's development environment
uniquely effective.

Enterprise Architect incorporates industry standard intelligent editing, debuggers
and modeling languages.

The Model Driven The MDDE provides tools to design, visualize, build and debug an application:
Development Environment

e UML technologies and tools to model software
(MDDE)

e Code generation tools to generate/reverse engineer source code
e Tools to import source code and binaries

e  Code editors that support different programming languages

e Intelli-sense to aid coding

e  Analyzer scripts that enable a user to describe how to build, debug, test and
deploy the application

e Integration with compilers such as Java, .Net, Microsoft C++
e Debugging capabilities for Java, NET, Microsoft C++ and others

e  Advanced visualization, recording, inspection, testing and profiling capabilities

pApp = new CBCGPAppointmentDemo
(

A 2 of 2 ™ CBCGPAppointmentDemonCBCGPAppointmentDemo(COleDateTime8: dtStart,
COleDateTimed dtFinish, CString & strText, COLORREF clrBackground, COLORREF
clrfForeground, COLORREF clrDuration)

i RGE (les%, 222, 399),
CLE_DEFAULT,
RGE (128, O, 128)

:}:
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Analyzer Scripts

Analyzer Scripts are used by the Execution Analyzer. You do not need to worry about creating these. They are not the
same type of script as JavaScript or PHP, but are managed using a familiar user interface - a tree view - and you can
quickly locate the feature to change. Analyzer Scripts can be shared by users of a community model and are easily
imported and exported as XML files.

» Tomcat
El- Build

i Testpoints
- Debug

* X

Build Execute Command as: Batch File =

javac.exe -g -verbose -cp ".;%CLASSPATH%, %APACHE_HOME%‘\lib\servlet-api.jar" -d clia
IF ERRORLEVEL 1 GOTO BUILD_END

cd ..

jar cvf servlet.war *

(BUILD_END

- Platform
- Runtime Host
- Tracepoints
- Workbench
El- Source Contro
- Merge
- Changes
- Histary
- Commit
- Working Copy
- Repository ]
El- Code Miner
Service Default Directory:  %VEA%)\] ava\Tomcat\HelloServiet\WEB-INF
- Libraries
El- Private Options Parse Output: Java SDK -
L Services
- RUN
- Deploy Deploy after build
- Recording
- Simulation
- Run Javascript

Remote host: eqg: mypc0l: 7777

Close

A single project can have multiple configurations and these can be found grouped together in the Analyzer window.

Execution Analyzer v q

B E-d ¥ Bugdh @
4 [ Example Model.Analysis and Business Modeling.DMN Examples.Packagel
[ [ DMN.Affordability calculation.Java
] [ DMM.Application risk score model.Java
Ol DMM.Bureau call type table.Java
[ [ DMM.Credit contingency factor table.Java
Ol DMN.Eligibility rules.Java
[l [ DMM.Installment calculation.Java
Ol DMN.Post-bureau risk categery tableJava
[ [ DMM.Pre-bureau risk category tableJava
' :. [ DMMN.Routing rules.Java
4 03 Example Model.Model Simulation.Executable State Machine Entering A State
Il Simulation.StateMachine Artifact].C++ Microsoft Mative
O [ Simulation.StateMachine.EnteringAStateSimulation JavaScript.Scripting
[+ @ Exarnple Model.Model Simulation.Executable State Machine.Entry and Exit Points (Connecti
> 9 Example Model.Model Simulation.Executable State Machine.Example: CD Player
[+ @ Exarnple Model.Model Simulation.Executable State Machine. Example: Regular Expression P:
> 9 Example Model.Model Simulation.Executable State Machine.FerkMloin
[+ @ Exarnple Model.Model Simulation.Executable State Machine History Pseudostate
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Each Analyzer Script is defined for a Package, so projects can co-exist quite happily. In many organizations, the
procedures to manage systems are distributed, and vary from individual to individual and group to group. Analyzer
Scripts in an Enterprise Architect model can provide some peace of mind to these organizations, by trusting a single,
shared and accountable procedure for building and deploying any variety of configurations. All aspects of a script are
optional. You can, for instance, debug without one; however, with a few lines they can enable these useful features:

e Building

e  Testing

e Debugging
e Recording

e  Execution

e  Deployment

e  Simulation

Remote Script Execution

Various Analyzer Script sections such as Build and Run, provide a 'Remote Host' field. This field is used to describe the
computer on which the script should run. In order to use this feature, the Sparx Satellite service must be running on the
machine. The format of this field is hostname:port, where hostname is the IP address or network name of a Windows or
Linux machine and port is the Port number that the Satellite service is listening on. The primary goal of this feature is to
allow a user of Enterprise Architect running on Linux to execute commands native to Linux.
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Managing Analyzer Scripts

The Execution Analyzer window enables you to manage all Analyzer scripts in the model. You can use the window
toolbar buttons or script context menu options to control script tasks. Scripts are listed by Package; the list only shows
Packages that have Analyzer scripts defined against them. Each user can set their own active script, independent of other
users of the same model; one user activating a script does not impact the currently active scripts for other users or affect
the scripts available to them. The active script governs the behavior of the Execution Analyzer; when choosing the build
command from a menu, for example, or clicking the Debug button on a toolbar.

There can be a lot of Packages with scripts listed in the window. To help you locate and isolate a particular Package, use
the 'Filter Packages' context menu options, described in the Context Menu Options table in this topic.

Note that when a script is highlighted in the Execution Analyzer window, the window context menu options and
Execution Analyzer window toolbar buttons will operate on the highlighted script. However, Execution Analyzer options
on any ribbon or floating toolbar, or in the Debugger (which are not on the window) will always use the default Analyzer
script - the one that has the selected checkbox beside the script name.

Access
Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer
Keyboard Shortcuts Shift+F12
Toolbar Options
Toolbar Button Action

¥ - Quick access to the Analyzer core windows such as Call Stack or Local Variables,
plus the power features:

e Profiling
e Recording
e  Testpoints

e Simulation

Create and edit a new Analyzer Script for the selected Package, under either Linux
or Windows™.

ﬂ

. Export Scripts.

Export one or more Analyzer Scripts to an XML file, which can be used to import
the scripts into another model.

The 'Execution Analyzer: Export' dialog displays from which you select the script
or scripts to export, followed by a prompt for the target file name and location.

& Import Scripts.

Import one or more Analyzer Scripts into the current model from a previously
exported XML file.
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The 'Find Package' dialog displays, on which you select the Package into which to
import the scripts, followed by a prompt for the source filename and location.

Execute the 'Build' command of the active script.

Cancel the 'Build' command currently in progress.

7 Execute the 'Run' command of the active script.
& Execute the 'Test' command of the active script.
7 Execute the 'Deploy' command of the active script.

Context Menu Options

Right-click on the required script or Package to display the context menus.

Option Action

Add New Script Add a new script to the selected Package.
The Execution Analyzer window displays, showing the 'Build' page.

Paste Script Paste a copied script from the Enterprise Architect clipboard into the selected
Package.

You can paste the copied script several times; each copy has the suffix 'Copy'.

To rename the copied script, press F2 and overtype the script name.

Export Scripts Export scripts from the selected Package.

The 'Execution Analyzer: Export' dialog displays, from which you select the script
or scripts to export, followed by a prompt for the target filename and location.

Import Scripts Import scripts from a . XML file into the selected Package.

A prompt displays for the source filename and location.

Filter Packages Displays a submenu of options to:

e  Enter the Package path against which to filter the list of Packages - when you
select the 'Filter Packages' option, a prompt displays to accept the
currently-selected Package path, or you can remove the end elements of the
path to specify a larger set of Packages; when you click on the OK button the
first Package in the list is expanded to list the scripts it contains

e  Switch between showing the full list of Packages and hiding the full list of
Packages to expose only the currently-selected Package

e Remove the currently-active filter to show the full list of Packages
Select In Project Browser Highlight the selected Package in the Browser window.

Display the Browser window, which is now expanded to show the highlighted
Package.
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Build
Clean
Rebuild
Debug
Run

Test
Deploy
Merge
Changes
History
Commit
Working Copy
Repository

Run JavaScript

Start Simulation

Run Executable
Statemachine

Edit

Copy
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Execute the 'Build' command of the selected script.

Execute the 'Clean' command of the selected script.

Execute the 'Clean' and 'Build' commands of the selected script.
Execute the 'Debug' command of the selected script.

Execute the 'Run' command of the selected script.

Execute the 'Test' command of the selected script.

Execute the 'Deploy' command of the selected script.

Execute the 'Merge' source control command of the selected script.
Execute the 'Changes' source control command of the selected script.
Execute the 'History' source control command of the selected script.
Execute the 'Commit' source control command of the selected script.
Execute the "Working Copy' source control command of the selected script.

Execute the 'Repository' source control command of the selected script.

Execute the 'Run JavaScript' command of the selected script. When this option is

selected, a job is created in the Job Queue window.

Job Queue
o X 1 =
Mame Task Status E

= Actionpoint tests...  JavaScript Active

4
Execution Analyzer | Job Queue

Start the simulation referenced by the 'Analyzer Script Simulation' page.

Start a simulation of the selected Executable Statemachine Artifact.

Open the selected script in the 'Analyzer Scripts Editor'.

Copy the selected script to the Enterprise Architect clipboard.
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Paste Paste the most-recently copied script to the same Package as the selected script.
You can paste the copied script several times; each copy has the suffix 'Copy'.

To rename the copied script, press F2 and overtype the script name.

Delete Delete the selected script; there is no prompt for confirmation.

To delete a Package from the Execution Analyzer window, delete the scripts from
the Package. When the last script is deleted, the Package is no longer listed.

Package Default Set the selected script as the default script for the Package.

The icon to the left of the script changes color; any previous Package default reverts
to normal.
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Analyzer Script Editor

The Analyzer Script Editor has a straightforward user interface, with a tree view of the scripts on the left enabling easy
navigation of the script groups, and a content view on the right in which you define and configure the scripts.

» Tomcat
El- Build
- Build
= Clean
Bl Test
Test
Testpoints
El- Debug
- Platform

- Runtime Host
- Tracepoints
- Workbench
El- Source Contro

- Merge

- Changes

- History

- Commit

- Working Copy
- Repository
El- Code Miner
E----Ser\:ice

i Libraries

i}
M

- Private Option:
i Senices

. Run

. Deploy

- Recording

- Simulation

- Run |avascript

Close

Access

* x
Execute Command as: Batch File -
javac.exe -g -verbose -cp . %CLASSPATHY; %APACHE_HOME®%'\1lib\servlet-api.jar" -d clia
IF ERRORLEVEL 1 GOTO BUILD_END
cvf servlet.war *
:BUILD_END
>

Default Directory: | %VEA%)\] ava\Tomcat\HelloServiet\WEB-INF
Parse Output: Java SDK -

Remote host: eq: mypc0L: 7777

Deploy after build

From the 'Execution Analyzer' window, either:

e Double-click on a script to edit it or

e  Right-click on a script and select the 'Edit' option

Ribbon

Keyboard Shortcuts

Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Shift+F12

Execution Analyzer Scripts

Task - Page

Build - Build

Build - Clean

(c) Sparx Systems 2025

Action

Enter the script or command to build the application. This can be an Apache Ant or
Visual Studio command, but can also be tailored depending on your development
environment. Note: Remember to select a parser to get directly to the source code
in the event of any errors. The parser field is on the same page and offers support
for many languages.

Enter the script or command to clean the previous build. This is the command line
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Test - Test

Test - Testpoints

Debug - Platform

Debug - Tracepoints

Debug - Workbench

Debug - Runtime Host

Source Control - Merge

Source Control - Changes

Source Control - History

Source Control - Commit

Source Control - Working
Copy

Source Control -

Repository

Code Miner - Service
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you would normally issue to build your system. This can be an Apache Ant or
Visual Studio command depending on your development environment.

Enter the script or command to test the application. This is typically where an nUnit
or jUnit invocation might be configured, but it just as easily could be any procedure
or program.

Specify where the output from a Testpoint run is sent.

Specify the debugging platform, the application to be debugged, and the mode of
debugging (attach to process or run).

Specify where the output from Tracepoints encountered during a debug session are
sent.

For .NET projects, the assembly to load. Not required for Java.

Allows Enterprise Architect to launch the program to be debugged using a
command line. This is typically used for Mono or Java programs that use a socket
transport for debugging. This command is executed prior to the Debugger being
run. The Port number specified in this command should be the same value passed to
the 'Port’ option in the Debug page. When the Debugger starts, it will attempt to
connect to the runtime on this Port. If successful, it then binds any breakpoints and
resumes the program,which it assumes to be suspended. Java and Mono both have
command line options on the debugging transport to initially suspend the process
till the Debugger connects.

This is the script that executes when the 'Merge' option is chosen from the context
menu of an Analyzer Script. It provides a place to run a program or shell script to
examine the differences between source files.

This is the script that executes when the 'Changes' option is chosen from the context
menu of an Analyzer Script. It provides a place to run a source control program
such as 'svn' that might list current changes to a source control repository.

This is the script that executes when the History' option is chosen from the context
menu of an Analyzer Script. It provides a place to run a source control program
such as 'svn' that might list a history of changes to a source control repository.

This is the script that executes when the 'Commit' option is chosen from the context
menu of an Analyzer Script. It provides a place to run a source control program
such as 'svn' that might commit changes to a source control Working Copy.

This is the script that executes when the "Working Copy' option is chosen from the
context menu of an Analyzer Script. It provides a place to run a source control
program such as 'svn' to perform actions on the current working copy of a source
repository.

This is the script that executes when the 'Repository’ option is chosen from the
context menu of an Analyzer Script. It provides a place to run a source control
program such as 'svn' to perform actions on a source repository.

In this section you can choose how the Code Miner service operates. You can
choose either a remote server or to use libraries locally.
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Code Miner - Libraries This section provides a place for the management of Code Miner libraries. Here,
you can create libraries based on a project codebase or repository. Code Miner
libraries created here can be searched using mFQL queries. Queries composed in
mFQL can be used to search one or more libraries in a single operation.

Private Options - Services This is where the IP address and Port of Enterprise Architect Satellite services for
Linux and Windows are configured. These services provide enterprise-wide support
for system management functions and remote debugging scenarios.

Job Settings Most of the commands contained in an Analyzer Script are executed as jobs in the
Job Queue. Each script can be configured to post a notification to a specified user
group when a specified job completes. The 'Job Settings' group provides the
'Notifications' option, which displays the fields through which you enter the job
identity as part of the text to display to the members of the Model Mail user group,
and the user group name.

[ Build ]
b Test | Post on completion
SR Joh Identity
[» Source Contral
[: Code Miner
[» Private Options A friendly mnemonic for eazy identification in posts
4 Job Settings
Motifications User Group
Run .

e Post on completion - select this checkbox to enable the other two fields

e Job Identity - Type in the text to display, which should also identify the job; for
example: 'Installers Completed'

e  User Group - Click on the drop-down arrow and select the appropriate Model
Mail user group

Run JavaScript In this section you can create and store a JavaScript that you can execute by
selecting the 'Run JavaScript' option from the context menu of an Analyzer Script.

‘Warkbench -

- — 3
P e—— 215 :f ( theElement != null && theElement.CbjectType == EA.ObjectType.otElement )
Merge 21 var addedMethodID = 0;
Changes 22
Histary 23 Session.Output{ "JavaScript METHOD LIFE CYCLE EXAMPLE™ )
Commit 24 Session.Output{ y:
Working Copy 25 Session,Output{ "Uorking on element '" + theElement.Neme + "' (Type=" + cheElement.Type +
26 ", ID=" + theElement.ElementID + "] " )}
Repasitary o
4 Code Miner ze i
Service 29 // ADD A METHOD
Libraries El] I
4 Private Options 31 // Create a method to work on
-— 3z var methods as EA.Collection:
ervices
33 methods = theElement.Methods;
4 Job Settings Ba
Notifications EH var neullethod as EA.Method;
Run 36 neuMethod = methods.AddNew{ "TestMethod”, "bool™ ):
Deploy 37 newlethod. Update() ;

EL] methods. Refresh()
ag
an AddeAMet hnd TN = neaMethnd Methad TN -

Recording
Simulation
Run JavaScript 1[4
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Build Ctrl=5Shift=F12
Clean

Rebuild

Debug F&

Run Ctri+Alt=N

Test Ctri+Alt=T

Deploy Ctrl+5hift+Alt+F12

Merge
Changes
History
Commit
Narking Copy
Repository

Run Javascript

Start Simulation

Run Executable Statemachine
Edit

Copy

Paste

Delete

Filter Packages k

Package Default

Help

When this option is selected, a job is created in the Job Queue window.

Job Queue
m 4+ + %X 1 3
MName Task Status E

=+ Actionpoint tests...  JavaScript Active

l
Execution Analyzer | Job Queue

Run Enter a command to run an application.
Deploy Enter a script or command to deploy the project. Build your jar file. Deploy to your
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device, an emulator or Tomcat server. Publish a web site. Its up to you.

Recording Does your Sequence diagram resemble the national grid? Reduce the clutter with
filters. Filters define exclusion zones in your code base that can cut down
dramatically on any 'noise' that is being recorded. Even accurate noise is not always
helpful.

Simulation Complete the configuration for Simulation Control.
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Build Scripts

The "Build' page enables you to enter commands to build your project. You can use Enterprise Architect Local Paths and
environment variables in composing your command line(s). You can choose to create your own build script, entering
various shell commands. You can also choose to simply run an external program or batch file such as an Ant script.

Access
On the Execution Analyzer window, either:
e Locate and double-click on the required script and select the 'Build > Build' page or

s
e Clickon % ~ in the window Toolbar, select the Package in which to create a new script, and select the 'Build >
Build' page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Analyzer Context Menu Build
Keyboard Shortcuts Ctrl+Shift+F12
Build

Write your script in this text box, using the windows shell commands; the format and content of this section depends on
the actual compiler you use to build your project. If the path or arguments contain spaces, surround them with quotes; for
example: "c:\program files (x86)\java\bin\javac.exe".

Here are some examples:
Visual Studio:
"C:\Program Files (x86)\Microsoft Visual Studio 9.0\Common7\IDE\devenv.com" /Rebuild Debug RentalSystem.sln
Visual Studio using a Local Path:
"%VsCompPath%\devenv.exe" /build Debug Subway.sln
Java:
C:\Program Files (x86)\Java\jdk1.6.0 22\bin\javac.exe" -g -cp "%classpath%;." %r* java
Java using a Local Path:
"%JAVA%\bin\javac.exe" -g -cp "%classpath%;." %r*.java

Wildcard Java Builds (%r) - Source files in sub-folders can be built using the %r token. The token has the effect of
causing a recursive execution of the same command on any files in all sub-folders, as shown in the example.

Execute Command as

Click on the drop down arrow and select the mode of executing the script:

e Batch File - Use this option to execute a shell script in a system command window; environment variables can be
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accessed by commands in this script

e  Process - Use this option to execute the command as a single program; the command should specify the path to the
program, plus any command line arguments

Default Directory

Browse for or type in the default directory path in which the build script process will run.

Parse Output
Click on the drop-down arrow and select a method for automatically parsing the compiler output.

If you select this option, output from the script is logged in the System Output window; Enterprise Architect parses the
output according to the syntax you specify.

Remote Host

Type in the ID of the remote host system and its port; for example, mypc01:7777.
If you set this property to #SYSTEMHOST#, the script is sent to the Windows Satellite Service when running on

Windows, and the Linux Satellite Service when running under Wine. The service IDs and Ports are defined in the
'"Private Options - Services' section of the Analyzer Scripts Editor.

Deploy after Build

Check this box to cause the Deploy script to be executed immediately after this Build script completes.

Notes

To execute the Build script, click on the Package in the Browser window and either:
e Right-click on any Toolbar and select 'Analyzer Toolbars | Build', or
e  Press Ctrl+Shift+F12 or

e  Select the 'Execute > Source > Build > Build' ribbon option
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Cleanup Script

Incremental builds are the practice of only building those assets that have changed in some way. There are times,
however, when there is cause to build everything again from scratch. This command is used for those occasions, to
remove the binaries and intermediary files associated with a particular build or configuration. The project can then be
rebuilt. When you execute the 'Rebuild' menu option on a script, the command(s) you specify in this field are executed,
followed immediately by the 'Build' command from the same Analyzer script. Some compilers have options do this for
you. Visual studio for example has the "/clean" command line switch.

This is an example script: devenv.com /Clean Debug MyProject.sln

Access
On the Execution Analyzer window, either:
e Locate and double-click on the required script and select the 'Build > Clean' page or

—Hh
e Clickon # 7 in the window Toolbar, select the Package in which to create a new script, and select the 'Build >
Clean' page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Source > Build > Clean

Analyzer Context Menu Clean
Keyboard Shortcuts Shift+F12
Aspects
Aspect Detail
Clean Enter the command to be executed when you select 'Clean’ from the script context
menu.
Execute Command as Click on the drop-down arrow and select the appropriate option:

e Batch File - Use this option to create a shell script that is executed in a system
command window; environment variables can be accessed by commands in
this script

e  Process - Use this option to run a single program - the command should specify
the path to the program, plus any command line arguments; - if the path or
arguments contain spaces, surround them with quotes - for example:
"c:\program files (x86)\java\bin\javac.exe"

Default Directory Defaults to the value entered for the Build script. If a value has not been set for the
Build script, browse for or type in the default directory path in which the Clean
script process will run.

Parse Output Click on the drop-down arrow and select a method for automatically parsing the

compiler output.

If you select this option, output from the script is logged in the System Output
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window; Enterprise Architect parses the output according to the syntax you specify.

Remote Host Type in the ID of the remote host system and its port; for example, mypc01:7777.

If you set this property to #SYSTEMHOST#, the script is sent to the Windows
Satellite Service when running on Windows, and the Linux Satellite Service when
running under Wine. The service IDs and Ports are defined in the "Private Options -
Services' section of the Analyzer Scripts Editor.
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Test Scripts

These sections explain how to configure the 'Test' page of an Analyzer Script for performing unit testing on your code.
Most users will apply this to NUnit and JUnit test scenarios. Enterprise Architect accepts the output from these systems
and can automatically add to and manage each unit test case history. To view the case history, you would select the test
case Class element and press Alt+2 > Testing.

Access
On the Execution Analyzer window, either:
e Locate and double-click on the required script and select the "Test > Test' page or

s
e Clickon % 7 in the window Toolbar, select the Package in which to create a new script, and select the "Test >
Test' page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Analyzer Context Menu Test
Keyboard Shortcuts Shift+F12
Actions

Test Type the Test command or script in this field. For example:

®  NUnit - "C:\Program Files\NUnit\bin\nunit-console.exe"
"bin\debug\Calculator.exe"

e JUnit - java junit.textui. Testrunner %N

The command listed in this field is executed as if from the command prompt; as a
result, if the executable path or any arguments contain spaces, they must be
surrounded in quotes.

If you include the string %N in your test script it is replaced by the fully
namespace-qualified name of the currently selected Class when the script is
executed.

Execute Command As Click on the drop-down arrow and select the appropriate option:

e Batch File - Use this option to create a shell script that is executed in a system
command window; environment variables can be accessed by commands in
this script

e  Process - Use this option to run a single program - the command should specify
the path to the program, plus any command line arguments; if the path or
arguments contain spaces, surround the path with quotes - for example:
"c:\program files (x86)\java\bin\javac.exe"

Default Directory Defaults to the value entered for the Build script. If a value has not been set for the
Build script, browse for or type in the default directory path in which the Clean
script process will run.
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Parse Output When a parser is selected, output of nUnit and jUnit tests can be parsed, saved and
managed from the model; (Alt+2 > Testing). Be aware that output is only captured
when a parser is selected.

Remote Host Type in the ID of the remote host system and its port; for example, mypc01:7777.

If you set this property to #SYSTEMHOST#, the script is sent to the Windows
Satellite Service when running on Windows, and the Linux Satellite Service when
running under Wine. The service IDs and Ports are defined in the 'Private Options -
Services' section of the Analyzer Scripts Editor.

Build First Select to ensure that the Package is compiled each time you run the test.
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Testpoints Output

The 'Testpoints' page of the Analyzer Script helps you to configure the output of a Testpoint run.
By default the output is logged to the System Output window, as in this example.

System Output

System Script Testpoints 4

StockExchange!Exchange. Stock. GetStockCost
Hoard Rescurces unit cost is 523,31

StockExchange!Exchange. Account.Credit
Credit: purchased 132 of stock "Hoard Resources” (id: 4)
Credit: cost §-3036

Total Test Count: 10

Total Passes: 10

Total Failures: 0

Total Invalid constraints: O

Total Test Peints encountered in run: 10

Total Test Points not encountered in run: 0

Total Test Points evaluated by Analyzer: 668

Simulation Events Breakpoints & Markers System Qutput | Execution Analyzer

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Test > Testpoints' page or

sl
e Clickon # ™ in the window Toolbar, select the Package in which to create a new script, and select the 'Test >
Testpoints' page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer > View Analyzer Scripts

Keyboard Shortcuts Shift+F12
Options
Option Description
Output You can select from two options:

e 'Screen’ (the default) - The output is directed to the "Testpoints' tab of the
System Output window
e 'File' - The output is directed to file
Folder Click on the folder to use for Testpoint log files.

Filename Enter the name to use for the Testpoint log files.
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Overwrite When this option is selected, the file specified is overwritten each time a Testpoint
run is performed.

Auto Number When this option is selected, the Testpoint output is composed of the filename you
specify and the number of the Test run; each time you perform a Test run the
number is incremented.

Prefix trace output with When this option is selected, any trace statements executed during the Testpoint run
function are prefixed with the current function call.
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Debug Script

The process of configuring the Debug section of an Analyzer Script is usually a one-time affair that rarely has to be
revisited. So once you have your script working, you probably won't have to think about it again. The details you provide
are not complicated, yet defining a script provides access to a great many benefits such as:

e Debugging

e  Sequence diagram recording

e Executable StateMachine execution and simulation

e Test domain authoring and recording

e Behavioral profiling of processes on a variety of runtimes

All you need to do is select the appropriate platform and enter some basic details. The debugger platforms you can use
include:

e Java

e Java Debug Wire Protocol (JDWP)

e Microsoft NET Debugger

e Microsoft Native Code Debugger (C++, C, VB)
e Mono

e The PHP Debugger

e The GNU Debugger (GDB)

Access
Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts
Execute > Tools > Analyzer
Keyboard Shortcuts F6
Notes

e An Analyzer script is not necessary for debugging Enterprise Architect model scripts such as JavaScript or VBScript
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Operating System Specific Requirements

The Enterprise Architect debugger is able to operate on a number of different platforms. This table describes the
individual requirements for debugging on each platform.

Platforms
Platform Detail

Microsoft NET e  Microsoft™ NET Frameworks 4.0, 3.5 and 2.0
e Language support: C, C#, C++, J#, VB.NET

Java e Java SE Development Kit from Oracle™ (version 5.0 minimum) (either 32 bit

or 64 bit JDK)

The Java Platform Debugger Architecture (JPDA) was introduced in Java SE
version 5.0. The JPDA provides two protocols for debugging; the Java Virtual
Machine Tools Interface (JVMTI), and the Java Debug Wire Protocol (JDWP).
Enterprise Architect's debugger supports both protocols.

GNU Debugger (GDB) Enterprise Architect supports debugging using the GNU Debugger, which enables
you to debug your applications under Linux either locally or remotely.
Requires GDB version 7.0 or higher.
The source code file path must not contain spaces.

Windows for Native Enterprise Architect supports debugging native code (C, C++ and Visual Basic)

Applications compiled with the Microsoft™ compiler where an associated PDB file is available.

PHP Enterprise Architect enables you to perform local and remote debugging of PHP
scripts in web servers.
Requires web server to be configured to support PHP.
Requires PHP to be configured to support XDebug PHP (3rd party PHP extension).

Notes

e The debugging facility is available in all editions of Enterprise Architect
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UAC-Enabled Operating Systems

The Microsoft operating system Windows 7 provides User Account Control (UAC) to manage security for applications.

The Enterprise Architect Visual Execution Analyzer is UAC-compliant, and users of UAC-enabled systems can perform
operations with the Visual Execution Analyzer and related facilities under accounts that are members of only the Users

group.

However, when attaching to processes running as services on a UAC-enabled operating system, it might be necessary to
log in as an Administrator.

Log in as Administrator

Step Action

1 Before you run Enterprise Architect, right-click on the Enterprise Architect icon on the desktop and select
the 'Run as administrator' option.

Alternatively

Edit or create a link to Enterprise Architect and configure the link to run as an Administrator.

Step Action

1 Right-click on the Enterprise Architect icon and select the "Properties' option.
The Enterprise Architect 'Properties' dialog displays.

2 Click on the Advanced button.
The 'Advanced Properties' dialog displays.

3 Select the 'Run as administrator' checkbox.

4 Click on the OK button, and again on the 'Enterprise Architect Properties' dialog.
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WINE Debugging
Configure Enterprise Architect to debug under WINE

Step Action

1 At the command line, run § winecfg.

2 Select the 'Applications' tab. Add the Enterprise Architect executable 'EA.exe' from the Enterprise
Architect installations folder. Then add these programs from the VEA sub directories:

e SSampler32.exe
e SSampler64.exe
e  SSProfiler32.exe
e  SSProfiler64.exe

3 Select each program in turn, then switch to the 'Libraries' tab. Ensure these values are listed with a (native,
built-in) precedence:

e dbghelp
e msxml4

e msxml6

4 Copy the application source code plus executable(s) to your bottle.
The path must be the same as the compiled version; that is:

If Windows source = C:\Source\SampleApp, under Crossover it must be C:\Source\SampleApp.

5 Copy any Side-By-Side assemblies that are used by the application.

Permissions

An installation of Enterprise Architect contains some native Linux programs that provide building and debugging
services to Enterprise Architect under Wine. These programs need to checked using the Linux file system or shell to
ensure they have the 'Execute’ permission set appropriately. The programs are located in the "VEA/x86/linux"
subdirectory of the Enterprise Architect installation.

Access Violation Exceptions

Due to the manner in which WINE handles direct drawing and access to DIB data, an additional option is provided on
the drop-down menu on the Debug window toolbar to ignore or process access violation exceptions thrown when your
program directly accesses DIB data.

Select this option to catch genuine (unexpected) access violations; deselect it to ignore expected violations.

As the debugger cannot distinguish between expected and unexpected violations, you might have to use trial and error to
capture and inspect genuine program crashes.
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Notes

e If WINE crashes, the back traces might not be correct
e Ifyou are using MFC remember to copy the debug side-by-side assemblies to the C:\window\winsxs directory

e To add a windows path to WINE, modify the Registry entry:
HKEY LOCAL MACHINE\System\CurrentControlSet\Control\Session Manager\Environment
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Java

This section describes how to set up Enterprise Architect for debugging Java applications and Web Servers.
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General Setup for Java

The general setup for debugging Java Applications supports two options:

e Debug an Application

e  Attach to an application that is running

Option 1 - Debug an Application

Field
Debugger

x64

Mode

Default Directory

Application Class

Command Line Arguments

Java Virtual Machine
Options

(c) Sparx Systems 2025

Action

Select Java.

Select this checkbox if you are debugging a 64 bit application.
Deselect the checkbox if you are debugging a 32 bit application.

Select Run.

This path is added to the class path property when the Java Virtual Machine is
created.

Identify the fully qualified Class name to debug; the Class must have a method
declared with this signature:

public static void main(String());

Application Class samples, Collector
Command Line "paraml” param2 "param3” param+4
Arguments:

Specify any parameters to be passed to the main method of the Application Class.

Parameters containing spaces should be surrounded with double quotes.

Specify command line options for Virtual Machine creation.

You also must provide a parameter for the Java Runtime Environment (JRE) as the
path to be searched for the jvm.dll; this is the DLL supplied as part of the runtime
environment or JDK from Sun Microsystems™.

The JRE parameter can be either:
e An Enterprise Architect-defined Local Path

e An absolute file path (with no double quotes) to the installation folder of the
Java JDK to be used for debugging

The JRE parameter must point to the installation folder for the Java JDK. A JDK
installation is necessary for debugging to succeed. The JRE should not point to the
installation of the public Java Runtime Environment, if that is installed.
Environment variables can be used when specifying the VM startup options, such
as classpath.

For example, using:

e An Enterprise Architect Local Path JAVA and an environment variable
classpath:
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Java Virtual Machine Options;
JRE=":JAVAY:, Djava.dass. path="%dasspath%;. ;

e  Or an absolute path to the JDK installation directory and an environment
variable classpath:

Java Virtual Machine Options:
JRE=C:'Program Files (x86)Javatjdk 1. 7.0,-Djava. dass. path=%dasspath ¥%;.;

In these two examples, the debugger will create a virtual machine using the JDK
located at the value of the JRE parameter.

If no classpath is specified, the debugger always creates the virtual machine with a
class path property equal to any path contained in the environment variable plus the
path entered in the default working directory of this script.

If source files and .class files are located under different directory trees, the
classpath property MUST include both root path(s) to the source and root path(s) to
binary class files.

Option 2 - Attach to Virtual Machine

There is very little to specify when attaching to a VM; however, the VM must have the Sparx Systems debugging agent
loaded.

Field Action
Debugger Select Java
Mode Select Attach to Virtual Machine
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Advanced Techniques

In addition to the standard Java debugging techniques, you can:

e Attach to Virtual Machine

e Internet Browser Java Applets
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Attach to Virtual Machine

You can debug a Java application by attaching to a process that is hosting a Java Virtual Machine; you might want to do
this for attaching to a webserver such as Tomcat or JBOSS.

The Java Virtual Machine Tools Interface from Sun Microsystems is the API used by Enterprise Architect; it allows a
debugging agent to be specified when the JVM is created.

To debug a running JVM from Enterprise Architect, the Sparx Systems' debugging agent must have been specified as a
startup option to the JVM when it was started; how this is accomplished for products such as Tomcat and JBOSS should
be provided by that product's own documentation.

For java.exe, the command line option to load the Enterprise Architect debugging agent could be (depending on your
environment):

e -agentpath:"c:\program files\sparx systems\ea\VEA\x86\SSJavaProfiler32"
e -agentpath:"c:\program files (x86)\sparx systems\ea\VEA\x86\SSJavaProfiler32"
e -agentpath:"c:\program files (x86)\sparx systems\ea\VEA\x64\SSJavaProfiler64"

The appropriate option will depend on your operating system and whether you are working on a 32 bit application or a
64 bit application.

Alternatively, if you add the appropriate VEA directory to your PATH environment variable you can choose to use:
e -agentlib:SSJavaProfiler32
e -agentlib:SSJavaProfiler64

It is not necessary to configure an Analyzer Script when you attach to a Virtual Machine; you can just use the Attach
button on one of the Analyzer toolbars.

If you configure an Analyzer Script, there are only two things that must be selected:
e Select 'Java' as the debugging platform
e  Choose the 'Attach to Virtual Machine' option
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Internet Browser Java Applets

This topic describes the configuration requirements and procedure for debugging Java Applets running in a browser from
Enterprise Architect.

Attach to the browser process hosting the Java Virtual Machine (JVM) from
Enterprise Architect

Step

1

Action

Ensure binaries for the applet code to be debugged have been built with debug information.

Configure the JVM using the Java Control Panel.

In the 'Java Applet Runtime Settings' panel, click on the View button.

On the installed version to use, include one of these options in the 'Runtime Parameters' field, depending

on your environment and whether you are working on a 32 bit application or a 64 bit application:
-agentpath:"c:\program files\sparx systems\ea\VEA\x86\SSJavaProfiler32"

-agentpath:"c:\program files (x86)\sparx systems\ea\VEA\x86\SSJavaProfiler32"
-agentpath:"c:\program files (x86)\sparx systems\ea\VEA\x64\SSJavaProfiler64"

In this field add the required Class paths.

At least one of these paths should include the root path of the source files to use in debugging.
Set breakpoints.
Launch the browser.

Attach to the browser process from Enterprise Architect.
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Working with Java Web Servers

If you are debugging Java web servers such as JBOSS and Apache Tomcat (both Server configuration and Windows
Service configuration) in Enterprise Architect, apply these configuration requirements and procedures.

Note: The debug and record features of the Visual Execution Analyzer are not supported for the Java server platform
"Weblogic' from Oracle.

Attach to process hosting the Java Virtual Machine from Enterprise Architect

Step Action

1 Build binaries for the web server code to be debugged, with debug information.

2 Launch the server with the 'Virtual Machine startup' option, described in Server Configuration.
3 Import source code into the Enterprise Architect Model, or synchronize existing code.

4 Set breakpoints.

5 Launch the client.

6 Attach to the process from Enterprise Architect.

Server Configuration

The configuration necessary for the web servers to interact with Enterprise Architect must address these two essential
points:

e Any VM to be debugged, created or hosted by the server must have the Sparx Systems Agent command line option
specified or in the VM startup option (that is:
-agentlib:SSJavaProfiler32 or -agentlib:SSJavaProfiler64)

e The CLASSPATH, however it is passed to the VM, must specify the root path to the Package source files

The Enterprise Architect debugger uses the java.class.path property in the VM being debugged, to locate the source file
corresponding to a breakpoint occurring in a Class during execution; for example, a Class to be debugged is called:

a.b.C
This is located in physical directory:
C:\source\a\b
So, for debugging to be successful, the CLASSPATH must contain the root path:

c:\source

Analyzer Script Configuration

Using the 'Debug' tab of the 'Build Script' dialog, create a script for the code you have imported and:
e  Select the 'Attach to process' radio button and, in the field below it, type 'attach'
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In the 'Use Debugger' field, click on the drop-down arrow and select 'Java'

All other fields are unimportant; the 'Directory’ field is normally used in the absence of any Class path property.

Run the Debugger

The breakpoints could show a question mark. In this case the Class might not have been loaded yet by the VM. If the
question mark remains even after you are sure the Class containing the breakpoint has been loaded, then either:

Step

1

The binaries being executed by the server are not based on the source code
The debugger cannot reconcile the breakpoint to a source file (check Class paths), or

The JVM has not loaded the Sparx Systems agent

Action

Run the server and check that the server process has loaded the Sparx Systems Agent:
DLL SSJavaProfiler32.DLL or SSJavaProfiler64

Use 'Process Explorer' or similar tools to prove that the server process has loaded the agent.
In Enterprise Architect, open the source code and set some breakpoints.

Click on the Run Debug button in Enterprise Architect.
The 'Attach To Process' dialog displays.

Select the server process hosting the application.

Click on the OK button.

A confirmation message displays in the Debug window, stating that the process has been attached.
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JBOSS Server

In this JBoss example, for a 32 bit application, the source code for a simple servlet is located in the directory location:
C:\Benchmark\Java\]BOSS\Inventory

The binaries executed by JBOSS are located in the JAW.EAR file in this location:
C:\JBOSS\03b-dao\build\distribution

The Enterprise Architect debugger has to be able to locate source files during debugging; to do this it also uses the
CLASSPATH, searching in any listed path for a matching JAVA source file, so the CLASSPATH must include a path to
the root of the Package for Enterprise Architect to find the source during debugging.

This is an excerpt from the command file that executes the JBOSS server; the Class to be debugged is at:
com/inventory/dto/carDTO
Therefore, the root of this path is included in the JBOSS CLASSPATH.

Example Code

set SOURCE=C:\Benchmark\Java\JBOSS\Inventory

set JAVAC JAR=%JAVA HOME%\lib\tools.jar

if "%JBOSS_CLASSPATH%" ==""

(

set JBOSS CLASSPATH=%SOURCE%;%JAVAC_ JAR%;%RUNJAR%;

)

else

(

set JBOSS CLASSPATH=%SOURCE%;%JBOSS CLASSPATH%;%JAVAC JAR%;%RUNJAR%;

)
set JAVA_OPTS=%JAVA_OPTS% -agentpath:"c:\program files\sparx systems\vea\x86\ssjavaprofiler32"
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Apache Tomcat Server

The Apache Tomcat Server can be configured for debugging using the Java debugger in Enterprise Architect. This
example shows the configuration dialog for Apache Tomcat 7.0 on a PC running Windows 7.

‘g. Apache Tomcat 7.0 Tomcat? Properties

23|

| General I Log On | Logging | Java |513rtu|:| | Shutdown

[] Use default
Java Virtual Machine:

C:\Program Files (x36)Javayjdk 1. 7.0_04rebinidientjvm.dl D
Java Classpath:
C:\Tomcatwebappsserviet\WEB-IMNF\src; C: \Tomcatbin'bootstrap.jar; C

Java Options:

-Djava util, Ingglng manager = Drg apache.juli, CIassLDaderLogManage -

Initial memory poal: ME
Maximum mermory poal: ME
Thread stack size: KB

[ Ok, ][ Cancel H Apply

These three points are important:

The 'Java Virtual Machine' specifies the runtime from an installation of the Java JDK

The source path to any servlet to be debugged is added to Java Classpath; in this case we add the path to the Tomcat

servlet:
c:\tomcat\webapps\servlet\ WEB-INF\src

The 'Java Options' include the path to the Sparx Systems debugging agent:
-agentpath:c:\program files (x86)\sparx systems\vea\x86\ssjavaprofiler32
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Apache Tomcat Windows Service

Configuration

For users running Apache Tomcat as a Windows™ service, it is important to configure the service to enable interaction
with the Desktop; failure to do so causes debugging to fail within Enterprise Architect.

Log on as:

@) Local System account
Allow service to interact with desktop

Select the 'Allow service to interact with desktop' checkbox.
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NET

This section describes how to configure Enterprise Architect for debugging .NET applications. It includes:
e General Setup for NET

e  Debugging an Unmanaged Application
e Debug COM Interop
e Debug ASP .NET
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General Setup for .NET

This is the general setup for debugging Microsoft .NET applications. You have two options when debugging:

e Debug an application

e  Attach to an application that is running

Option 1 - Debug an application

Field
Debugger

x64

Mode
Default Directory

Application Path

Command Line Arguments
Show Console

Symbol Search Paths

Action

Select Microsoft .NET as the debugging platform.

Select this checkbox if you are debugging a 64 bit application.
Deselect the checkbox if you are debugging a 32 bit application.

Select the Run radio button.
This is set as the default directory for the process being debugged.

Select and enter either the full or the relative path to the application executable.
e Ifthe path contains spaces, specify the full path; do not use a relative path

e [fthe path contains spaces, the path must be enclosed by quotes
Parameters to pass to the application at start up.
Create a console window for the debugger; not applicable to attaching to a process.

Specify any additional paths to locate debug symbols for the debugger; separate the
paths with a semi-colon.

Option 2 - Attach to an application that is running

Field
Debugger

x64

Mode

(c) Sparx Systems 2025

Action

Select Microsoft .NET as the debugging platform.

Select this checkbox if you are debugging a 64 bit application.
Deselect the checkbox if you are debugging a 32 bit application.

Select the Attach to Process radio button.
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Debugging an Unmanaged Application

If you are debugging managed code using an unmanaged application, the debugger might fail to detect the correct
version of the Common Language Runtime (CLR) to load.

You should specify a config file if you don’t already have one for the debug application specified in the Debug command
of your script.

The config file should reside in the same directory as your application, and take the format:
name.exe.config
where 'name' is the name of your application.

The version of the CLR you specify should match the version loaded by the managed code invoked by the debuggee.
In the sample code that follows, "clr_version" represents the version of the CLR targeted by your plug-in or COM code.

Sample Config File

<configuration>
<startup>
<requiredRuntime version="clr_version"/>
</startup>

</configuration>
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Debug COM Interop

Enterprise Architect enables you to debug .NET managed code executed using COM in either a Local or an In-Process
server.

This feature is useful for debugging Plug-ins and ActiveX components.

Debug .NET Managed Code Executed Using COM

Step Action

1 Create a Package in Enterprise Architect and import the code to debug.

2 Ensure the COM component is built with debug information.

3 Create a Script for the Package.

4 In the 'Debug | Platform' page, you can select to either attach to an unmanaged process or specify the path

to an unmanaged application to call your managed code.

5 Add breakpoints in the source code to debug.

Attach to an Unmanaged Process

If you are using:
e  An In-Process COM server, attach to the client process
e A Local COM Server, attach to the server process

Click on the Debug window Run button (or press F6) to display a list of processes from which you can choose.

Notes

e Detaching from a COM interop process you have been debugging terminates the process; this is a known issue for
Microsoft .NET Framework, and information on it can be found on many of the MSDN .NET blogs
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Debug ASP .NET

Debugging for web services such as ASP requires that the Enterprise Architect debugger is able to attach to a running
service.

Begin by ensuring that the directory containing the ASP NET service project has been imported into Enterprise
Architect and, if required, the web folder containing the client web pages.

If your web project directory resides under the website hosting directory, you can import from the root and include both
ASP code and web pages at the same time.

It is necessary to launch the client first, as the ASP .NET service process might not already be running; load the client
using your browser - this ensures that the web server is running.

In the debug set up you would then select the 'Attach’' radio button. When this choice is selected, the debugger will
prompt you each time for the process to debug.

Click on the Debug window Run button to start the debugger; the 'Attach To Process' dialog displays.

The name of the process varies across Microsoft operating systems, as explained in the ASP .NET SDK; for example, on
Windows XP, the name of the process resembles aspnet wp.exe, although the name could reflect the version of the NET
framework that it is supporting.

There can be multiple ASP.NET processes running under XP; you must ensure that you attach to the correct version,
which would be the one hosting the .NET framework version that your application runs on; check the web.config file for
your web service to verify the version of NET framework it is tied to.

The Debug window Stop button should be enabled and any breakpoints should be red, indicating they have been bound.

You can set breakpoints at any time in the web server code. You can also set breakpoints in the ASP web page(s) if you
imported them.

Notes

Some breakpoints might not have bound successfully, but if none at all are bound (indicated by being dark red with
question marks) something has gone out of synchrony; try rebuilding and re-importing source code
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The Mono Debugger

Mono is a software platform sponsored by the .NET Foundation to facilitate cross-platform development. It is popular
with game developers for its rich gaming, API-based and portability features.

Enterprise Architect provides support to the Mono community by providing a modern environment for both modeling
and developing software. Existing projects can be imported, built and debugged natively on both Linux and Windows.

Overview

Debugging under Mono involves the cooperation of three processes. The Mono runtime manages the application and
communicates using a socket protocol with the Enterprise Architect Debugger, which in turn communicates with
Enterprise Architect acting as the front end. When you launch Mono you need to direct it to support debugging, which
you achieve using a command line directive in which you name the host and Port number that Mono should listen on.
The host can be omitted, in which case Mono will accept connections from any IP address. The host can have the value
'localhost' to restrict connections to the same machine. The Port number is a number of your choosing.

The host and Port number are the important pieces of information, as they are used when configuring the Analyzer
Script.

Requirements for Windows

e Enterprise Architect (version 14 minimum)

e Mono for Windows (version 5.4 minimum)

Requirements for Linux

e  Enterprise Architect (version 14 minimum)
e Mono for Linux (version 5.4 minimum)

e  Wine for Linux

The Runtime Host Page

This page is optional and is only useful where Mono and Enterprise Architect will be running on the same machine. It
provides the ability to run Mono first with the required debugging directives, before the Enterprise Architect debugger is
started. After the debugger connects, it resumes the Mono runtime, which has been started as suspended. If the
application runs on a different machine from the Enterprise Architect you are using, you should clear this section.
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Debugging Configuration Linux

Debugger Configuration

This section describes the Debug section of an Analyzer Script in respect to debugging Mono under Linux. Fields that
are not listed here are not required.

Debugger Select 'Mono'.

Default Directory This is the fully qualified native Linux path where the application is located in Unix
format.

Connection e port: the debugging Port

e host: the name or IP address of the machine where Mono runs ('localhost' if the
machine is the same)

e |ocalpath: the root path of the source code in Windows format; this is the path
to the source files that you use to set breakpoints in the code editor in
Enterprise Architect

e remotepath: the root path of the source code in Unix format, this being the path
to the source files used to build the program under Linux

These paths are returned during debug events, and are then mapped to the local
path, so that Enterprise Architect can display the source file during a
breakpoint or step - both parameters can specify the same physical source file
root, but must use the Windows or Unix format for each field

e shutdown: (true or false); when true the VM is terminated when the Debugger
is stopped

e timeout: the timeout in milliseconds for socket calls
e output: the Wine / Windows path of the log file to write to

e logging: (true or false); when true, extra messages are logged in the Debug
window and socket messages are logged to the specified output file

Starting Mono Automatically

You can configure Enterprise Architect to start Mono for you when you start the debugger. You do this by configuring
the 'Runtime Host' page of your Analyzer Script. The format of the commands is described here:

cd path-to-program
/usr/bin/mono --debug --debugger-agent=transport=dt_socket,address=host:port,server=y,suspend=y program
where:
- path-to-program is the directory path where the program is located
- host is one of these:
e Jocalhost
e an [P address

e anetworked machine name
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- port is the Port for the socket

- program is the name of the application (such as MonoProgram.exe)

Starting Mono Manually using the Command Line

You can start Mono manually from a console. Locate the program in your file explorer, then open a console at that
location. The format of the command line is described here:

/ust/bin/mono --debug --debugger-agent=transport=dt_socket,address=host:port,server=y,suspend=y program
where host is one of these:
e localhost
e an [P address
e anetworked machine name

port is the Port for the socket and program is the name of the application (for example, MonoProgram.exe).
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Debugging Configuration Windows

Debugger Configuration

This section describes the Debug section of an Analyzer Script in respect to debugging Mono under Windows. Fields
that are not listed here are not required.

Field Description
Debugger Select 'Mono'.
x64 Select if the program to be debugged is a 64 bit executable.
Run or Attach Choose 'Run' to name the program to launch. Choose 'Attach'’ if you will always

attach to a running process.

Default Directory The default directory that the program will take when it runs.
Application Path The full path of the Mono application.
Command Line Arguments Any parameters to pass to the program. If the parameters contain spaces, surround

them in double quotes (")

Starting Mono Automatically

You can configure Enterprise Architect to start Mono for you when you start the debugger. You do this by configuring
the 'Runtime Host' page of your Analyzer Script. The format of the commands is described here:

cd path-to-program
mono --debug --debugger-agent=transport=dt_socket,address=host:port,server=y,suspend=y program
where:
- path-to-program is the directory path where the program is located
- host is one of these:
e localhost
e an [P address
e anetworked machine name
- port is the Port for the socket

- program is the name of the application (such as MonoProgram.exe)

Starting Mono Manually using the command line

You can start Mono manually from a console. Locate the program in your file explorer, then open a console at that
location. The format of the command line is described here:

mono --debug --debugger-agent=transport=dt_socket,address=host.port,server=y,suspend=y program

where host is one of these:
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e Jocalhost
e an IP address
e anetworked machine name

port is the Port for the socket and program is the name of the application (for example, MonoProgram.exe).
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The PHP Debugger

The Enterprise Architect PHP Debugger enables you to debug PHP.exe scripts. This section discusses basic set up and
the various debugging scenarios that are commonly encountered; the scenarios concern themselves with the mapping of
file paths, which is critical to the success of a remote debugging session.

e Script Setup

e Local Windows Machine (Apache Server)
e Local Windows Machine (PHP.exe)

e Remote Linux Machine (Apache Server)

e Remote Linux Machine (PHP.exe)

Setup and Scenarios

Scenario Details

Script Setup An Analyzer Script is a basic requirement for debugging in Enterprise Architect;
you create a script using the toolbar of the Execution Analyzer.

Select PHP.XDebug as the debugging platform; when you select this platform the
property page displays these connection settings:

e host - localhost - The adaptor that Enterprise Architect listens on for incoming
connections from PHP

e localpath - %LOCAL% - Specifies the local file path to be mapped to a remote
file path; this is a remote debugging setting - for local debugging, clear the
value, the value is a placeholder and you should edit it to fit your particular
scenario

e remotepath - %REMOTE% - Specifies the remote file path that a local file path
is to be mapped to; this is a remote debugging setting - for local debugging,
clear the value, the value is a placeholder and you should edit it to fit your
particular scenario

e logging - Enter true or false to enable logging of communication from XDebug
server

e output - names the file path on the remote machine to be used with the logging
option; this file will always be overwritten

Local Machine Apache In this situation, consider this configuration:
Server e O/S: Windows7
e Network computer name: MyPC
e Network share MyShare mapped to c:\myshare

e Source files in Enterprise Architect have been imported from
c:\myshare\apache\myapp\scripts

e Apache document root is set to /MyPC/MyShare/apache

In this scenario an Analyzer Script for the connection parameters might be
configured as:

e  host: localhost

port: 9000

localpath: c:\myshare\apache\

e remotepath: MyPC/MyShare/apache/
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Local Machine PHP.EXE In this scenario an Analyzer Script for the connection parameters might be
configured as shown, as file paths always map to same physical path:

e  host: localhost
e port: 9000
e localpath:

e remotepath:

Remote Linux Machine In this situation consider this configuration:
Apache Server Local Machine:
e O/S: Windows7

e  Source files in Enterprise Architect have been imported from
c:\myshare\apache\myapp\scripts

Remote Machine:

e O/S: Linux

e Apache document root is set to home/apache/htdocs

e Source files in Apache are located at home/apache/htdocs/myapp/scripts

In this scenario an Analyzer Script for the connection parameters might be
configured as:

e  host: localhost
e port: 9000
e localpath: c:\myshare\apache\

e remotepath: home/apache/htdocs/

Remote Linux Machine In this situation consider this configuration:
PHP.exe e Local Machine
e O/S: Windows7

e Source files in Enterprise Architect have been imported from
c:\myshare\apache\myapp\scripts

e Remote Machine
e O/S: Linux
e Source files in Apache located at home/myapp/scripts

In this scenario an Analyzer Script for the connection parameters might be
configured as:

e host: localhost
e port: 9000
e localpath: c:\myshare\apache\

e remotepath: home/

PHP Global variables When you are at a breakpoint, you can examine the values of PHP globals using the
Analyzer Watches window. To list every global, type either 'globals' or
'superglobals' into the field. To show an individual item, enter its name. This image
shows the value of the PHP environment variable $_SERVER being displayed.

(c) Sparx Systems 2025 Page 59 of 253 Created with Enterprise Architect



Visual Execution Analysis 2 September, 2025

Watches v X
$_SERVER =
Variable Value Type Address
= & % _SERVER array[31] 00000001k | &

& $_SERVER[O] "127.0.0.1" string 00000001

& $_SERVER[1] "keep-alive" string 0x0000001d

& $_SERVER[Z] "max-age=0" string Ox0000001e

& $_SERVER[3] -1~ string 0x0000001F

& $_SERVER[¥] "Mozilla/5.0 (X11; Linux x86_64) AppleW string 000000020

& $_SERVER[3] “text/html,application/xhtml+xmlLapplic  string Ox00000021

& $_SERVER[g] "gzip, deflate, sdch" string 000000022

& $_SERVER[T] "en-Us,en; q=0.8" string 000000023

& $_SERVER[2] "fusrflocalfsbin: fusrflocal/bin:fusrisbin:/ string Ox00000024

@& $_SERVER[Z] "<address=Apache/2.4.7 (Ubuntu) Serv  string Ox00000025

& E f "A Ubuntu)” string 3

& $_SERVER[11] "127.0.0.1 string 000000027

& $_SERVER[1Z] "127.0.0.1" string (00000028  |w
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PHP Debugger - System Requirements

This topic identifies the system requirements and operating systems for the Enterprise Architect PHP debugger.

System Requirements:

e  Enterprise Architect version 9
e  PHP version 5.3 or above
e  PHP zend extension XDebug 2.1 or above

e For web servers such as Apache, a server version that supports the PHP version

Supported Operating Systems:

e  Client (Enterprise Architect)

e Microsoft Windows XP and above
e Linux running Crossover Office

e Server (PHP)

e Microsoft Windows XP and above

e Linux

(c) Sparx Systems 2025 Page 61 of 253 Created with Enterprise Architect



Visual Execution Analysis 2 September, 2025

PHP Debugger Checklist

This topic provides a troubleshooting guide for debugging PHP scripts in Enterprise Architect.

Check Points

Check Point Details

System Requirements e Apache HTTP Web Server version 2.2
e PHP version 5.3 or above

e  XDebug version 2.1.1

Enterprise Architect e The model has an Analyzer Script configured to use the PHP XDebug platform

e PHP source code has been imported into the model (for recording and
testpoints)

e When the PHP XDebug platform is selected from the 'Analyzer Script' dialog,
default runtime settings are listed in the 'Connection' field:

localpath:%LOCAL%
remotepath:%REMOTE%

Either define local paths for these default variables or edit the script to provide
actual paths.

For example: local source, remote source
localpath:c:\code samples\vea\php\sample
remotepath:webserver/sample

e 'webserver' is a network or local share

e ‘'sample' is a folder below share

PHP In order to debug PHP scripts in Enterprise Architect, it is a requirement that the
PHP is configured properly to load the XDebug extension.

Settings similar to these should be used (for XDebug version 3 or higher):
e [xdebug]

e zend extension=xdebug.so

e xdebug.mode=debug

e xdebug.mode=debug

e xdebug.start with request=yes

e xdebug.client host=localhost

e xdebug.client_port=9003

For Xebug versions less than 3 use the old settings such as:
e [xdebug]

e xdebug.extended info=1

e xdebug.idekey=eca

e xdebug.remote enable=1

e xdebug.remote handler=dbgp

e xdebug.remote autostart=1
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e xdebug.remote host=X.X.X.X
e xdebug.remote port=9000
e xdebug.show local vars=1

The IP address X.X.X.X refers to and should match the host specified in the model
Analyzer Script.

The IP address is the address XDebug connects with and the same address the
Enterprise Architect PHP agent listens on.

Apache For debugging using Apache, these lines should be present in the Apache
configuration file, httpd.conf:

LoadModule php5 module "php _home/phpSapache2 2.dIl"
AddHandler application/x-httpd-php .php
PHPIniDir "php _home"

The value "php_home" is the PHP installation path (the path where php.ini and
apache dll exist).

Troubleshooting To prevent both PHP and Apache timeouts during a debugging session, these
settings might require modification.

The settings were used while developing the PHP Debugging agent in Enterprise
Architect.

PHP File: php.ini
; Enterprise Architect prevents PHP timeouts when debugging PHP extensions

max_execution_time =0

; Enterprise Architect prevents web server timeouts when debugging PHP
extensions

max_input_time = -1

; Enterprise Architect logs errors

display_errors = On

; Enterprise Architect displays startup errors

display_startup errors = On

Apache File: httpd.conf
; Enterprise Architect prevents timeouts while debugging php extensions
Timeout 60000
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The GNU Debugger (GDB)

When debugging your applications you can use the GNU Debugger (GDB), which is portable and runs on Unix-like
systems such as Linux, as well as on Windows. The GDB works for many programming languages including Ada, Java,
C, C++ and Objective-C. Using the GDB, you can debug your applications either locally or remotely.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Debug > Platform' page  or

sl
e Clickon % ~ in the window Toolbar, select the Package in which to create a new script, and select the 'Debug >
Platform' page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer
Context Menu Browser window | Right-click on Package | Execution Analyzer

Keyboard Shortcuts Shift+F12

Set up the GNU Debugger

Task Details

Set up Script An Analyzer Script is a basic requirement for debugging in Enterprise Architect;
you create a script using the Execution Analyzer toolbar.

On the 'Platform' page of the Execution Analyzer Script Editor, in the 'Debugger’
field click on the drop-down arrow and select 'GDB'.

Define Connection Settings The property panel displays a number of connection settings for which you provide
values.

e path - <path> - The complete file path of the GDB executable; you only
specify this if the GDB cannot be found in the system path

e  source - <path>, <path> - The path in which the debugger will search for
source files, if they do not reside in the executable directory

e remote - F - Set for remote debugging; otherwise leave blank
e port - <nnnnn> - The Port to connect to on the remote server
e  host - localhost - The host name to connect to

e fetch - T - Set to retrieve the binary from the remote system
e dumpgdb - <path> - The filename to write the GDB output to
e initpath - <path> - The complete file path to the gbinit file
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Notes

e A requirement of the GDB is that your source code file path does not contain spaces; the debugger will not run
correctly with spaces in the file path
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If you are developing Java applications running on Android devices or emulators, you can also debug them. The Local

and Remote machines can be on either a 32 bit platform or a 64 bit platform.

Remote Machine
ExecutionEnvironment @

Port Forwarding
Software

Local Machine

ExecutionEnvironment @

Android Debug
Bridge (ADB) Android Emulator

Android Device
ExecutionEnvironment

Java
)
-

System Requirements

On the Remote machine, this software is required:

Enterprise
Architect

e Android SDK, which includes the android debug bridge, ADB (you need to be familiar with the SDK and its tools)

e Java JDK (32 and 64 bit support)
e  Port Forwarding software (3rd party)

On the Local machine, this software is required:

e  Enterprise Architect Version 10 or higher

Analyzer Script Settings

Field/Button Action
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Debugger Click on the drop-down arrow and select Java (JDWP).

Run Click on this radio button.

Default Directory Not applicable - leave blank.

Application path Not applicable - leave blank.

Command Line Arguments Not applicable - leave blank.

Build first Not applicable - leave blank.

Show console Not applicable - leave blank.

Show diagnostic messages Not applicable - leave blank.

Connection Not applicable - leave blank.

Port This is the application port, forward-assigned using adb or other means, through
which eqerprise Architect and the Android Virtual Machine (VM) can
communicate.

Host Host computer (defaults to localhost)

If Android is running on an emulator on a device attached to a networked computer,
enter the network name here.

By default, debugging will attempt to connect to the Port you specify on the local
machine.

Source This is the source equivalent of the classpath setting in Java.

The root to each source tree should be listed. If more than one is specified, they
should be separated by a semi-colon; that is:

c:\myapp\src;c:\myserver\src

You must specify at least one root source path.

When a breakpoint occurs the debugger searches for the java source in each of the
source trees listed here.

Logging Enables logging additional information from debugger

possible values: true,false,1,0,yes,no

Output Specifies the full name of the local log file to be written.
The folder must exist or no log will be created.

The log file typically contains a dump of bytes sent between debugger and VM.

Platform If you are debugging Java running under any android scenario, select Android.

For all other scenarios, select Java.
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Configure Ports for Debugging - Port Forwarding (Local)

The debugger can only debug one VM at a time; it uses a single Port for communication with the VM. The Port for the
application to be debugged can be assigned using ADB, which is supplied with the Android SDK.

Before debugging, start the application once in the device. When the app starts, discover its process identifier (pid):
adb jdwp

The last number listed is the pid of the last application launched; note the pid and use it to allow the debugger to connect
to the VM:

e adb forward tcp:port jdwp:pid
- port = Port number listed in analyzer script
- pid = process id of the application on the device

Configure Ports for Debugging - Port Forwarding (Remote)

To debug remotely, the same procedure should be followed as for the local machine, but the communication requires
additional forwarding as the socket created using the adb forward command will only listen on the local adapter. The
socket is bound to the localhost, and attempts to connect to this Port will be met with 'connection refused' messages.

In order to achieve remote debugging it is necessary to have a proxy running on the remote machine that listens to all
incoming connections and forwards all traffic to the adb Port; there are numerous software products available to do this.

Remote debugging with Enterprise Architect will not work unless you have configured a proxy Port forwarder.
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Java JDWP Debugger

Java provides two main debugging technologies: an in-process agent-based system called the Java Virtual Machine Tools
Interface (JVMTI) and a socket-based paradigm called the Java Debug Wire Protocol (JDWP). A Java Virtual Machine
can name either one of these but not both, and the feature must be configured when the JVM is started.

System Requirements

1. The Enterprise Architect JDWP debugger will only be able to communicate with a JVM started with the 'TDWP'
option. Here is an example of the command line option:
java -agentlib:jdwp=transport=dt_socket,address=localhost:9000,server=y,suspend=n -cp
"c:\java\myapp;%classpath%" demo.myApp "param1" "param2"

2. The Virtual Machine should not be currently attached to a debugger.

3. Itis not possible for a VM to be debugged by Enterprise Architect and Eclipse at the same time.

Analyzer Script Settings

Field/Button
Debugger
Run
Default Directory
Application path
Command Line Arguments
Build first
Show console
Show diagnostic messages
Connection

Port

Host

Source
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Action

Click on the drop-down arrow and select Java (JDWP).

Click on this radio button to run the debugger when the script is executed.
Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Not applicable - leave blank.

Set the application Port forward-assigned to the VM process during start-up, in the
Java command-line options.

Set the host computer (defaults to localhost)
If VM is running on a networked computer, enter the network name or url here.

By default debugging will attempt to connect to the Port you specify on the local
machine.

This is the source equivalent of the classpath setting in Java.

List the root to each source tree; specify at least one root source path. If you specify
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more than one, separate them with a semi-colon; for example:
c:\myapp\src;c:\myserver\src

When a breakpoint occurs the debugger searches for the Java source in each of the
source trees listed here.

Logging Enable or disable logging of additional information from the debugger.
Possible values include:
® true
e false
o 1
e 0
® yes
e no
Output Specify the full name of the local log file to be written. If the folder does not

already exist, no log will be created.

The log file typically contains a dump of bytes sent between the debugger and VM.

Platform Select Java.

Configure Ports for Debugging

The debugger can only debug one VM at a time; it uses a single Port for communication with the VM. The Port for the
application to be debugged is assigned when the VM is created.

Local Debugging

Where both Enterprise Architect and the Java VM are running on the same machine, you can perform local debugging. It
is necessary to launch the VM with the JDWP transport enabled - see the documentation on Java Platform Debugger
Architecture (JPDA) at Oracle for the command line option specifications. For example:

java -agentlib:jdwp=transport=dt_socket,address=localhost:9000,server=y,suspend=n -cp
"c:\samples\java\myapp;%classpath%" samples.MyApp "param1" "param2"

In this example the values for the Analyzer script would be 'host: localhost' and 'port:9000'.

Remote Debugging

Where Enterprise Architect is running on the local machine and the Java VM is running on a remote machine, you can
perform remote debugging. It is necessary to launch the VM with the JDWP transport enabled - see the documentation
on JPDA at Oracle for the command line option specifications. Here is an example, where the remote computer has the
network name testmachinel:

java -agentlib:jdwp=transport=dt_socket,address=9000,server=y,suspend=n -cp
"c:\samples\java\myapp;%classpath%" samples.MyApp "param1" "param2"

Note the absence of a host name in the address. This means the VM will listen for a connection from any machine. In this
example the values for the Analyzer script would be 'host: testmachinel' and 'port: 9000'.
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Tracepoint Output

The Tracepoints page of the Analyzer Script enables you to direct where the output from any Trace statements goes
during a debug session.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Debug > Tracepoints' page  or

s
e Clickon % ~ in the window Toolbar, select the Package in which to create a new script, and select the 'Debug >
Tracepoints' page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer > select and run script
Context Menu Browser window | Right-click on Package | Execution Analyzer

Keyboard Shortcuts Shift+F12

Tracepoint properties

Field Detail

Output You can select from two options:
e 'Screen' (the default) - The output is directed to the Debug window
e 'File' - The output is directed to file

Folder Enter the folder to use for Trace statement log files.

Filename Enter the name to use for the Trace statement log files.

Overwrite If selected, the specified file is overwritten each time a debug session is started.

Auto Number If selected, the Trace log file is composed of the filename you specify and a
number.

Each time you start a debug session, the number is incremented.

Prefix trace output with If selected, any Trace statements executed during the debug session run are
function prefixed with the current function call.

(c) Sparx Systems 2025 Page 72 of 253 Created with Enterprise Architect



Visual Execution Analysis 2 September, 2025

Workbench Setup

This topic describes the requirements for setting up the Object Workbench on Java and Microsoft .NET.

Access
On the Execution Analyzer window, either:
e Locate and double-click on the required script and select the 'Debug > Workbench' page  or

sl
e Clickon # ™ in the window Toolbar, select the Package in which to create a new script, and select the 'Debug >
Workbench' page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shortcuts Shift+F12
Platforms
Platform Detail
Platforms Supported The Workbench supports these platforms:

e  Microsoft .NET (version 2.0 or later)
e Java (JDK 1.4 or later)

Microsoft NET The .NET workbench requires an assembly, which is used to create the workbench
Workbench items.

You specify the path to the assembly on the '"Workbench' page of the Analyzer
Script.

There are two constraints in using the .NET workbench:
e Members defined as struct in managed code are not supported

e (lasses defined as internal are not supported

Java Workbench The Java workbench uses the Virtual Machine settings configured in the Analyzer
Script 'Debug' page to create the JVM.
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Microsoft C++ and Native (C, VB)

You can debug native code only if there is a corresponding PDB file for the executable. A PDB file is created as a result
of building the application.

The build should include full debug information and there should be no optimizations set.
The script must specify two things to support debugging:

e  The path to the executable

e  Microsoft Native as the debugging platform
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This is the general setup for debugging Microsoft Native Applications (C++, C, Visual Basic). You have two options

when debugging:

e Debug an application

e  Attach to an application that is running

Option 1 - Debug an application

Field
Debugger

x64

Mode
Default Directory

Application Path

Command Line Arguments
Show Console

Symbol Search Paths

Action

Select Microsoft Native as the debugging platform.

Select this checkbox if you are debugging a 64 bit application.
Deselect the checkbox if you are debugging a 32 bit application.

Select the Run radio button.
This is set as the default directory for the process being debugged.

Select and enter either the full or the relative path to the application executable.
e Ifthe path contains spaces, specify the full path; do not use a relative path

e Ifthe path contains spaces, the path must be enclosed by quotes
Parameters to pass to the application at start up.
Create a console window for the debugger; not applicable for attaching to a process.

Specify any additional paths to locate debug symbols for the debugger; separate the
paths with a semi-colon.

Option 2 - Attach to an application that is running

Field
Debugger

x64

Mode

Symbol Search Paths
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Action

Select Microsoft Native as the debugging platform.

Select this checkbox if you are debugging a 64 bit application.
Deselect the checkbox if you are debugging a 32 bit application.

Select the Attach to Process radio button.
Specify any additional paths to locate debug symbols for the debugger.

You could specify a symbol server here if you prefer; separate the paths with a
semi-colon or comma.
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Debug Symbols

For applications built using Microsoft Platform SDK, Debug Symbols are written to an application PDB file when the
application is built.

The Debugging Tools for Windows, an API used by the Visual Execution Debugger, uses these symbols to present
meaningful information to Execution Analyzer controls.

These symbols can easily get out of date and cause aberrant behavior - the debugger might highlight the wrong line of
code in the editor whilst at a breakpoint; it is therefore best to ensure the application is built prior to any debugging or
recording session.

The debugger must inform the API how to reconcile addresses in the image being debugged,; it does this by specifying a
number of paths to the API that tell it where to look for PDB files.

For system DLLs (kernel32, mfc90ud) for which no debug symbols are found, the Call Stack shows some frames with
module names and addresses only.

You can supplement the symbols translated by passing additional paths to the API; you pass additional symbol paths in a
semi-colon separated list in the 'Debug' tab.
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Merge Script

A Merge command in an Analyzer Script gives users an additional command to perform some action. The merge action
is dependent on your requirements.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Merge' page or

s
e Clickon % ~ in the window Toolbar, select the Package in which to create a new script, and select the 'Merge'
page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Source > Merge

Keyboard Shortcuts Ctrl+Alt+M
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Code Miner Script

The Code Miner system uses a set of databases to provide fast and comprehensive access to information derived from
existing source code. The Intelli-sense features of Enterprise Architect's code editors and its search tools can make use of
the information mined from these databases.

Through the Code Miner script pages, you can specify which Code Miner databases to use with a particular project and
you can create, update and add new databases to the Code Miner library. The 'Services' page allows you to specify a
local Code Miner library, or that you want to access the library available through the Sparx Intel Service.

Different Code Miner details can be specified for each Analyzer Script, so the Code Miner libraries that are used are
determined by the active Analyzer Script.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Code Miner' page or

s
e (Clickon B in the window Toolbar, select the Package in which to create a new script, and select the 'Code
Miner' page

Ribbon Execute > Tools > Analyzer > View Analyzer Scripts > Double-click on Script
name > Code Miner > Service

Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts >
Double-click on Script name > Code Miner > Service

Keyboard Shortcuts Shift+F12

Sparx Intel Service

A Code Miner Library can be used locally, or it can be deployed to a server location where it can service multiple clients.
You select the scenario to use on the 'Code Miner Service' page of the Analyzer Script.

Merge -
Changes Code Miner Service:

History Use L
Cormmit ) Lze Library
Working Copy Use Server Host : Port Macro
Repositary
4 Code Miner - HINTELHOST#
Service
Libraries
4 Private Options
Services
4 Job Settings Limit Query Results ta: 0 dEr
Motifications

Run Code Miner databases provides support to Enterprize Architect intelizense, metrics and zearch tools.

r'ou can chooze between a local library or server.
Deploy

Recording
Sirmulation

Run Jawvascript
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Code Miner Libraries

The Code Miner Database Libraries are a collection of databases containing information derived from source code.
Together, these databases form the Code Miner Library used by the Intelli-sense features of Enterprise Architect.
Usually, a library would be created for each framework or project. The Code Miner Libraries page allows new databases
to be created, and existing databases to be added, updated or removed from a library.

Code Miner Query Libraries are a collection of functions, written in Code Miner's mFQL language, bundled together into
one source file.

The Code Miner Database Library and Query Library for a given Analyzer Script are specified on the 'Code Miner |
Libraries' page of the Script Editor.

Execution Analyzer: Exchanger.debug.jdwp

B B:'-'”d Code Miner Database Library
i~ Build
L Clean MNew
B Test
Test Library Path Language  Source Recursive
5....Tegtpgi|-,ts E\java\jdk-1.8.0_31\java|DK.cdb Java E\ava\jdk-1.8.0_31\src\  True
Bl Debug E\cladeonia-xstiexchanger.cdb Java E\cladenia-slst\exchan... True
f E\java\gwt-2.8.cdb Java E\java\gwt-2.8 1\samples True

i Platfarm
DebugRun
Tracepoints
‘- Workbench
[l Code Miner
service
- Libraries
=1 Private Options
. Services P »
- Run . i '
- Deplaoy Code Miner Query Library
- Recording
- Simulation
- Merge

| e:\javahspam-queries.qul
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Services Script

The 'Services' page of an Analyzer Script describes the default ports used when scripts are created by various Visual
Execution Analyzer functions (Import project, Generate Executable StateMachine). You can update any of the Port
specifications on this page.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Private Options | Services' page or

s
e Clickon % ~ in the window Toolbar, select the Package in which to create a new script, and select the 'Private
Options | Services' page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shortcuts Shift+F12
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Run Script

This section describes how to create a command for running your executable code.

Access

On the Execution Analyzer window, either:

e Locate and double-click on the required script and select the 'Run' page or

sl
e Clickon # ™ in the window Toolbar, select the Package in which to create a new script, and select the 'Run' page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shortcuts Ctrl+Alt+N

Script elements

Element Description

Command This is the command that is executed when you select the 'Execute > Run > Start'
ribbon option; at its simplest, the script would contain the location and name of the
file to be run.

Examples These two examples show scripts configured to run a .Net and a Java application in
Enterprise Architect.

Net:
C:\benchmark\cpp\example net 1\release\example.exe
Java:
customer

The command listed in this field is executed as if from the command prompt; as a
result, if the executable path or any arguments contain spaces, they must be
enclosed by quotes.

Notes

e  Enterprise Architect provides the ability to start your application normally OR with debugging from the same script;
the 'Analyzer' menu has separate options for starting a normal run and a debug run
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Deploy Script

These sections explain how to create a command script for deploying the current Package. The script can be executed by
selecting the 'Execute > Source > Build > Deploy' ribbon option or by pressing Ctrl+Shift+Alt+F12.

Access
On the Execution Analyzer window, either:
e Locate and double-click on the required script and select the 'Deploy' page or

s
e Clickon % ~ in the window Toolbar, select the Package in which to create a new script, and select the 'Deploy’
page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shortcuts Ctrl+Shift+Alt+F12
Actions
Action Detail
Execute Command as: Process

If the deployment is handled externally, enter the path to the program or batch file
to run, followed by any parameters; the program is launched in a separate process.

Example:

C:\apache-ant-1.7.1\bin\ant.cmd myproject deploy

Batch File

When using this option, you can enter multiple commands that are then executed as
a single script in a command console; you have access to any environment variables
available in a standard command console.

Example:
@echo on
IF NOT EXIST "%1%" GOTO DEPLOY _NOWAR
IF "%APACHE HOME%" =="" GOTO DEPLOY NOAPACHE

xcopy /L "%1%" "%APACHE HOME%\webapps"
GOTO DEPLOY_END

rem

rem NO WAR FILE

rem

:DEPLOY_NOWAR

echo "%1% WAR file not found"

GOTO DEPLOY_END
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rem

rem NO APACHE ENVIRONMENT VARIABLE

rem

:DEPLOY_NOAPACHE

echo "APACHE_HOME environment variable not found"
:-DEPLOY_END

pause

Parse Output Selecting a Parser from the list causes output of the deploy script to be captured; the
output is parsed according to the syntax selected from the list.

To display the System Output window, select the 'Start > All Windows > Design >
Explore > System' ribbon option.
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Recording Scripts

The beauty of recording is not really that we always get to see the bigger picture, but a chance to see a smaller picture
that has some truth to tell. We have all seen Sequence diagrams that are less than helpful. (The same message appearing
100 times in succession on a diagram does tell us something, but not much.) Fortunately Enterprise Architect takes care
of this first point through the use of fragments. Repeating behaviors are identified as Patterns and represented once as a
fragment on the Sequence diagram. The fragment is labeled according to the number of iterations. The recording history,
of course, always shows the entire history. We also need tools to help us focus the recording on particular areas of
interest and reduce the noise from others. We can use filters to do this. With filters, you can exclude any Classes,
functions, or even modules from any recording. You can create multiple sets of filters and use them with marker sets to
target different Use Cases.

Access
On the Execution Analyzer window, either:
e Locate and double-click on the required script and select the 'Recording' page or

—Hh
e Clickon % 7 in the window Toolbar, select the Package in which to create a new script, and select the 'Recording'
page

Ribbon Develop > Source Code > Execution Analyzer > Edit Analyzer Scripts

Execute > Tools > Analyzer

Keyboard Shortcuts Shift+F12
Filter Strings
Element Discussion
Filtering If the 'Enable Filter' checkbox is selected on the 'Recording' page of the Execution

Analyzer Script Editor, the debugger excludes calls to matching methods from the
recording. The comparison is case-sensitive.

To add a value, click on the 'New' ('Insert") icon in the right corner of the 'Exclusion
Filters' box, and type in the comparison string; each filter string takes the form:

class name token::method name token

The class name token excludes calls to all methods of a Class or Classes that have
a name matching the token; the string can contain the wildcard character *
(asterisk).

The method name token excludes calls to methods having a name that matches the
token; again, the string can contain the wildcard character *.

Both tokens are optional; if no Class token is present, the filter is applied only to
global or public functions (that is, methods not belonging to any Class).

Example In this Java example, the debugger would exclude:
e  (Calls to the OnDraw method for the Class Example.common.draw.DrawPane

e  (Calls to any method of any Class having a name beginning with
Example.source.Collection
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e  (alls to any constructor for any Class (such as <clint> and <init>)

Filters

Example.common. draw. DrawPane: :OnDraw
Example.source. Collection™
Fuinit®

In this Native Code example, the debugger would exclude:
e (Calls made to Standard Template Library namespace
e (Calls to any Class beginning with TOb

e  (Calls to any method of Class CLock

e  (Calls to the method GetLocation for Class CTrain

e (Calls to any Global or Public Function with a name beginning with Get

Filters
std™®
TOb™
Clock
CTrain::Getlocation
Get®
Filters
Use Filter Entry To Filter
= Get* All public functions having a name beginning with 'Get' from the recording session
(for example, GetClientRect in Windows API).
*..Get* All methods beginning with 'Get' in any Class.
CClass::Get* All methods beginning with Get for the CClass Class.
CClass::* All methods for CClass Class.
ATL* All methods for Classes belonging to Standard Template and Active Template
std* Libraries.
CClass::GetName The specific method(s) GetName for the CClass Class.
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The Job Queue Window

The Job Queue window streamlines the process of working with Analyzer Scripts, which originally were worked on
individually and if no other script was being executed. In versions of Enterprise Architect from Release 16.0 onwards,
when an Analyzer Script context menu option is executed (for example, 'Build") it is placed in a job queue; multiple jobs
can be queued, and other work performed while the jobs are processed.

The name of the Analyzer Script is used as the name of the job. An Analyzer Script can have multiple sections, such as
Build, Test, Run and Deploy, and each section is assigned as a task of the job.

Job Queue v 1 X

m 4+ + ¥ 1 3

Name Task Status | Erro... Completed Host
! Simulation.State...  Build Failed 1 6/09/2021 2:30:...
+ (ClassLibrary Build 0K B/09/2021 2:30:...
¥ (CityLoop Build OK 6/09/2021 2:30:...
+ BookTest Build OK 6/09/2021 2:15:...
! DMN Module Com... Build Failed 1 B/09/2021 2:15:...

The output from each job executed from the Job Queue window is captured to the 'Job History' tab in the System Output
window.

Access

Ribbon Execute > Tools > Analyzer > View Job Queue

Start > All Windows > Design > Explore > System > Job History

Job Queue Columns

Column Description

Name The name of the Analyzer Script for which the job has been added to the Job
Queue. If the job has been executed, the name will have a tick(for successful
completion) or exclamation mark (for failure) in front of it.

Task The section of the Analyzer Script that the job is executing - for example, Build or
Deploy.

Status The completion status of the job - whether the job completed successfully ('OK') or
failed.

Errors If the job has been executed and failed, the number of errors that arose.

Completed The date and time at which the job completed.

Host If the job is run remotely, the IP address or host name of the remote machine.
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If the job is run remotely, any return message from the host machine.

Right-click on a job name, or on the background of the window, to display the 'Job Queue' context menu.

Job Queue

1] 1

Mame
i Actionpoint tests...

4

FS
-

Task Status Erro...
|avaScript i

View Log

Cancel Job

Execution Analyzer | Job Queue

Option

View Log

Cancel Job

(c) Sparx Systems 2025

Description

Select this option to display the 'Job History' tab of the System Output window, for
a job that has been executed.

Right-click on a job name and click on this option, as necessary and at any time, to
cancel the selected JavaScript task.

The cancellation is indicated in the Job Queue window by a 'no entry' icon next to
the job name.

Job Queue v
] x 1 3
Name Task Status Erro... Completed

@ Actionpoint tests...  JavaScript Cancelled 8/09/2021 11:23...

1

Execution Analyzer | Job Queue

In the 'Job History' tab of the System Output window, the output is terminated with
a 'Script Cancelled' message.
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System Output

System  Job History  Script

JsonlLDExport

Actionpoint tests xb4

Templates
Factions
GameState
Messages
Items
Weapons
Messaging
Script cancelled

Delete Job Click on a job that has not yet started and select this option to remove it from the
Job Queue.
Re-Run Job Select this option to execute the selected completed job again.

Re-Run Selected Jobs

(Ctrl+click on a number of required jobs.) Select this option to execute all the

selected completed jobs again.

Re-Run Completed Jobs

Select this option to execute all the completed jobs in the current list again.

The Job History Tab

The output from each job executed from the Job Queue window is captured to the 'Job History' tab in the System Output
window. From there, any job log can be viewed at your discretion, by selecting it from the drop-down list in the toolbar.
If the job has failed and there are error messages, you can skip from message to message using the red arrow icons.

These icons are disabled if there are no active error messages.
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System Qutput

Systemm  Job History  Script  JsonLDExport :

Actionpoint tests x64 -

1>—r- Build started: Project: ActionPoints, Configuration: Debug x64 -——---
1=stdafx.cpp

1>ActionPoints.cpp

1=ActionPoints.voxproj -=> C:\EA\Stephen\ActionPoints\x64\Debug\ActionPoints.exe
========== Build: 1 succeeded, 0 failed, 0 up-to-date, 0 skipped ==========
process ended, exitcode 0

Completed Build section

Build succeeded

Started Deploy section

Executing script on remote host 192.168.20.9:9000

Connecting to 192.168.20.9:3000...

Connected.

Job Queue Toolbar Options

Option Description

i Click on a job name and click on this icon to pause or resume the selected job.

3+ Click on a job name and on one of these two arrows to move the job up or down in
the job queue, making it earlier or later in the order of processing.

*® Click on a job name for a job that has not yet started, and on this icon to delete that
job from the Job Queue window.

1 = Click on the up or down arrow to set the number of jobs that can run concurrently,
up to a maximum of 8.

The count defaults to 1 so that the Job Queue will process jobs one at a time, First
In First Out.
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Build Application

This topic explains how to execute a Build script on your application, within Enterprise Architect.

Access
Ribbon Execute > Source > Build > Build
Keyboard Shortcuts Ctrl+Shift+F12
Other 'Build' toolbar > =
Execution Analyzer window | 4
Action

When you select the 'Build' option, it executes the 'Build' command in the script selected in the Execution Analyzer
window. The progress and outcome of the build operation are displayed in the 'Build' tab of the System Output window.

You can quickly visit the line of code for any compilation error appearing by double-clicking the error.
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Locate Compiler Errors in Code

When you build an application using an Analyzer Script, compiler output is logged in the System Output window. You
can double-click on any error message that appears here and be taken to the source code. When you do, the cursor is
positioned on the line containing the error.

n

51

62 if(PeopledFF > 8)

63 re turn PeopleOFF * 28;
54

B5 return @;

=14
57
58| Running Analyzer Script - CityLoop

581 Microsoft (R) Visual Studio Version 10,0,30319.1.

Qutput

7 Copyright (C) Microsoft Corp. All rights reserved.
;3 12-mmee- Build started: Project: CityLoop, Configuration: Debug Win32 ------

72| 1= Train.cpp

yZ 1> c\data\wea\microsoft native\cityloop\train.cpp(63): error C2065: 're' : undeclared identifier

75 1=chdata\wea\microsoft nativelcityloop\train.cpp(83): error C2146: syntax error : missing ;' before identifier 'turn’
78| 1> chdatatwea\microsoft native\cityloopitrain.cpp(G3): error C2065: 'turn’ : undeclared identifier

Tip

If output is missing, check that a language parser is mentioned in the Analyzer Script (Shift+F12).

Parse Output: Java SDK i
Access
Ribbon Start > All Windows > Design > Explore > System
Keyboard Shortcuts Ctrl+Shift+8
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Debugging

@ vea-demo - Enterprise Achitect -8 x
FILE EDN VIEW PROJECT PACKAGE DIAGRAM ELEMENT JOOLS ANALYZER EXTENSIONS WINDOW HELP
DS -d| ¥ Al {E/ <t -ll@.
© ) / b Model Find Package P E
2| » (C:\VEA\CityLoop'\Microsoft Native'\CityLoop\Train.cpp A v x| SystemOutput v ax
= [@watrae - 45| DBuldTme0a2 -
- s — = 1>Build file//CAVEA\CityL it e
xEE- 208 %G8 her@® don B isembarkint) 92| 15 CityLoop -0 error(s), 0 warning(s)
5 @ crn a A X
i = Buid: 1 succeeded, 0 aied,0 p-to-dat, 0 skipped
; 42 DHORD. CTrain: :Embark(int Peopleoi
o Cronenre, T, s 427 (int-Peopleot) oo B
 Create) 44 ——if(Passengers + PeopleON > Capacity) -
 Disembark(int) 45— —PeopleON = Capacity - Passengers; < v\ System £ Scrt ) Build T ¥
 Embark(int) 46
Ny 47 —if(Peopleoii > 0) Collsteck T
= P dum= 2@
o 49 ———Passengers += Peopleo; Thresd 1064
4 GelRandom(nt, int) 56 — —return PeopleOi * 205 2
& Istaton) 51—} DU
b S, CityLoop.exe! Crain.Execute, c\vea\cityloop\microsoft natve\cityloop\train.cpp:40
CTETE ) 53} CityLoop.exe! CTrainRun, ci\vea\cityloop\microsoft native\cityloop\train.cpp:110
DL 54 CityLoop.exe! CTrain.Onrrival, ci\vea\cityloop\microsoft native\ciyloop\trein.cpp:72
o st 55 DHORD CTrain: :Disenbark(int PeopleOFF)  Citjloop.exel
@ st0 s6{ & Thread 5788
X ) 57— if(Passengers - People0it > -1) K
55 — —Passengers -= PeopledFF;
55—
60 — —Passengers = 0;
g & Loaals vax
® 62— if(People0Ft > @) Variable Value Type Address
3 — —sreturn PeopleOFF * 20
z 5 PLEOFE*:20, 26 Clran Crrain 0007dtel0 =
65 —return 0 & ¢ Tobjec 0007drel0
6} o hthrea 0x00000104 void® 000708
& o mrd  0sH a5 unsigned long o007dc
65 DHORD. ~CTrain: :Onarrival( Cstation® ) vonsFTaC Chetwork 0007410
69 ( Gio07DFERD Cstation® 00074114
76 —Departing = . 0 float 0007718
71 —Location = 0;
4 o Capacit 04 (00) int 00074120
72 —Delay = (Disesbark(GetRandon()) + Enbark(GetRandon()));
o A IO SO LU o Passen 04703) int 0007124
76 —if(Delay > (int)ScheduleTine) @ Nombe 04 (1) unsigned long 000741128
e petays 50 Departi GOVDFES CStation* 000TdfR2C
76 —return ScheduleTine; B Cst Cstation 0007680
7y 2o 0007680
% ©6  OONDFEED, "Flnders wehar 0007eR98
75 DHORD. CTrain: :Run() A
. L 0460 56) unsigned nt o007enac
81— if(Network->Stations.size() < 2) .
B2 o Ooretam 23 o Locsic 60() o unsigned int oo07ai0 .
& | Memory Viewer v ax
« »
0x7dfbed Qe
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Enterprise Architect is more than a drawing tool - it also provides every feature that you might expect in an IDE.
Comprehensive debugging environments and tools for many major platforms are made available. Integrating the
debugging capability within the modeling tool allows code to be developed, built and managed by its authors. Working
and collaborating in an integrated model has made actions count and every action accountable in ways that are just not
possible using other tool chains.

Features

Speed

Debuggers in Enterprise Architect are quick! Stepping through programs will not take all day.
The Recording program can be executed without manual stepping.

Support

e (C++, C and Visual Basic

e  Microsoft NET, ASP.NET WCF

e Java, using socket transport (JDWP) or in memory model (JVMIT)

e Android on an emulator or device

e JavaScript, VBScript and JScript

e  PHP scripts on Apache web servers

e Remote Linux GDB processes using Enterprise Architect on Windows

e  Simulation - debug simulations in UML and BPMN

e Executable StateMachines - debug an executing StateMachine

Isolation

The debuggers operate out-of-process from Enterprise Architect, isolating it from side effects.

Efficiency
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Starting and stopping the debugger is quick and painless. It does not hold you back. Designed to be a responsive UI, the
main Ul thread is isolated from duties that are not its responsibility.

Productivity

Switch from modeling to requirements, from raising a change request to tracking code changes in a model shared across
an organization, to profiling recent code changes. All in the one tool.

Notes

e The debug and record features of the Visual Execution Analyzer are not available for the Java server platform
"Weblogic' from Oracle
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Run the Debugger

Enterprise Architect provides a number of ways to start and control a debug session. There is the main Debug window, as
well as a Debug toolbar and the 'Run' panel in the 'Execute’ ribbon. It is always best to display the Debug window
whenever you are running a debug session, as this is where all debug output is captured.

Access

Ribbon

Keyboard Shortcuts

Toolbar

Execute > Run > Start

Execute > Tools > Debugger > Start Debugging

Alt+8 (displays the Debug window)
F6 (begins execution of the application being debugged)

Explore > Portals > Show Toolbar > Debug

Using the Debug window

Action

Start the Debugger

Pause/Resume Debugging

Stop the Debugger

(c) Sparx Systems 2025

Detail

When an Analyzer script has been configured to support debugging, you can start
the debugger in these ways:

e  From the ribbon, select 'Execute > Run > Start > Run'

e From the ribbon, select 'Execute > Tools > Debugger > Start Debugging'

e  On the 'Debug' toolbar, click on the b button, or
e Press F6

You can also launch the debugger for any script through its context menu in the
'Analyzer Script Window', or press Shift+F12

If you have no Analyzer Script, it is still possible to debug a running application by
attaching to that process directly:

e  From the ribbon, select 'Execute > Tools > Debugger > Attach to Process', or

e  On the 'Debug' toolbar, click on the . (Attach) button and choose the
debugging platform manually

You can pause a debugging session, or resume the session after pausing, in these
ways:

e  From the ribbon, select 'Execute > Run > Pause'

e  On the 'Debug' toolbar, click on the i |button

The debugger normally ends when the current debug process terminates; however,
some applications and services (such as Java Virtual Machine) might require the
debugger to be manually stopped. To stop debugging, either:
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e On the 'Debug' toolbar, click on the (Stop) button
e Press Ctrl+AIt+F6
e Select the drop-down arrow on the 'Execute > Run > Stop' ribbon option

The ribbon option displays a short menu providing three ways to terminate
debugging the application.

Stop Open

- -

Stop
Detach
Quit Application

e  Stop - stops the Debugger and stops the process that is being debugged (the
default when you just click on the ribbon icon)

e Detach - stops the Debugger but leaves the process running

e  Quit Application - stops the Debugger and posts a WM_QUIT message to the
main window of the process, if it has one

Step Over Lines of Code To step over the next line of code:

e  From the ribbon, select 'Execute > Run > Step Over', or

E

e On the 'Debug' toolbar, click on the
e  Press Alt+F6

(Step Over) button, or

Step Into Function Calls To step into a function call:

e  From the ribbon, select 'Execute > Run > Step In', or

Q=
e On the 'Debug' toolbar, click on the (Step In) button, or
e  Press Shift+F6

If no source is available for the target function then the Debugger returns
immediately to the caller.

Step Out Of Functions To step out of a function:

e  From the ribbon, select 'Execute > Run > Step Out'

(L
e On the 'Debug' toolbar, click on the E (Step Out) button, or
e Press Ctrl+F6

If the debugger steps out into a function with no source code, it will continue to
step out until a point is found that has source code.

Show Execution Point While the Debugger is paused, to return to the source file and line of code that the
Debugger is about to execute:

e  From the ribbon, select 'Execute > Run > Start > Show Execution Point'

e  On the 'Debug' toolbar, click on the ® (Show Execution Point) button.

The appropriate line is highlighted, with a pink arrow in the left margin of the
screen.

(c) Sparx Systems 2025 Page 96 of 253 Created with Enterprise Architect



Visual Execution Analysis 2 September, 2025

Output During a debug session, messages display in the Debug window detailing:
e  Startup of session
e  Termination of session
e Exceptions
e  Errors

e Trace messages, such as those output using Java System.out or .NET
System.Diagnostics.Debug

If you double-click on a debug message, either:
e A pop-up displays with more complete message text, or

e Ifthere has been a memory leak, the file is displayed at the point at which the
error occurred

Save Output (and Clear You can save the entire contents of the Debug output to an external .txt file, or you
Output) can save selected lines from the output to the Enterprise Architect clipboard.

To save all of the output to file, click on the e (Save output to file) button.

To save selected lines to the clipboard, right-click on the selection and select the
'Copy Selected to Clipboard' option.

When you have saved the output or otherwise do not want to display it any more,
right-click on the current output and select the 'Clear Results' option.

Switch to Profiler If you are running a debug session on code, you can stop the debug session and
immediately switch to a Profiling session.

To switch from the Debugger to the Profiler:

e  From the ribbon, select 'Execute > Tools > Debugger > Switch to Profiler'
@ -
& -

The Profiler attaches to the currently-running process.

e  On the Debug window, click on the ' | Switch to Profiler' option, or

e On the Debug toolbar, click on the ' | Switch to Profiler' option

This facility is not available for the Java debuggers.
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Breakpoint and Marker Management

Breakpoints work in Enterprise Architect in the same way as in any other Debugger. Markers are similar to breakpoints,
but in Enterprise Architect they have special powers. Simply put, markers perform actions - such as recording execution
and analysis - that breakpoints do not. The action of a breakpoint is always to stop the program.

You set any marker or breakpoint in the Source Code editor, where they are visible in the left margin. Clicking in this
margin will add a breakpoint at that line. Breakpoints and markers are interchangeable - you can change a breakpoint
into a marker and vice versa, using its 'Properties' dialog. You can quickly view and edit a breakpoint or marker's
properties using Ctrl+click either on its icon in the editor margin or in the Breakpoints and Markers window.

Breakpoints are maintained in sets. There is a default set for each model and each breakpoint typically resides there, but
you can save the current breakpoint configuration as a named set, create a new set and switch between them. Breakpoint
sets are shared; that is, they are available to the model community. The exception is the Default set which is a private and
personal set allocated to each user of any model.

Access

Ribbon Execute > Windows > Breakpoints

Simulate > Dynamic Simulation > Breakpoints

Breakpoint and Marker Options

Option Detail
Delete a breakpoint or To delete a specific breakpoint:
marker e Ifthe breakpoint is enabled, click on the red breakpoint circle in the left margin

of the Source Code Editor, or

e Right-click on the breakpoint or marker in the Source Code Editor, the
Breakpoints folder or the Breakpoints & Markers window and select the
'Delete’ option, or

e Select the breakpoint in the 'Debug Breakpoints' tab and press the Delete key

Delete all breakpoints 0y
Click on the Delete all breakpoints button ( ).

Breakpoint properties In the Breakpoints window or code editor, use the marker's context menu to bring
up the properties. Here you can change the marker type, add or modify constraints
and enter trace statements. (Useful shortcut: hold the Ctrl key while clicking the
marker, to quickly show its properties.)

Disable a breakpoint Deselect the checkbox against the breakpoint or marker.
Enable a breakpoint or Select the checkbox against the breakpoint or marker.
marker

Disable all breakpoints iy
Click on the button
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Break when memory
address 1s modified

Identify or change the
marker set

Change how breakpoints
and markers are grouped
on the Breakpoints &
Events window

Breakpoint States

State
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Click on the Enable all breakpoints button ( -t ).

Click on the Data breakpoint button ( +').

Check the D#fault " field in the Breakpoints & Events window
toolbar.

If necessary, click on the drop down arrow and select a different marker set.

The Default set is normally used for debugging and is personal to your user ID;
other marker sets are shared between all users within the model.

The breakpoints and markers can be grouped by Class or by code file. To group the

items, click on the down arrow on the = - icon in the toolbar, and click on the
appropriate option. If you do not want to group the items, click on the selected
option to deselect it; the breakpoints and markers are then listed by line number.

Remarks

Debug Running: Bound
Debug Not Running: Enabled

Debug Running: Disabled
Debug Not Running: Disabled

Debug Running: Not bound - this usually means that a module is yet to be loaded.
Also, dlls are unloaded from time to time.

Debug Not Running: N/a

Debug Running: Failed - this means the debugger was unable to a match this line of
code to an instruction in any of the loaded modules. Perhaps the source is from
another project or the project configuration is out of date. Note, that if the module
date is earlier than the breakpoint's source code date you will see a notification in
the debugger window. The text is red in color so they will stand out. This is clear
sign that the project requires building.

Debug Not Running: N/a
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Setting Code Breakpoints

Normal Breakpoints are typically set on a line of source code. When the Debugger hits the indicated line during normal
execution, the Debugger halts execution and displays the local variables, call stack, threads and other run-time
information.

Set a breakpoint on a line of code

Step Action

1 Open the source code to debug in the integrated source code editor.

2 Find the appropriate code line and click in the left margin column - a solid red circle in the margin
indicates that a breakpoint has been set at that position.

12 CTest::CTlest (LPCTSTE name, TTestIype tvpe)
13 H4{

1}5 14 m Name = name;
15 m Type = Type:

16 theTeat = this;

o

If the code is currently halted at a breakpoint, that point is indicated by a blue arrow next to the marker.

& int tmain(int arge, _TCHAR* argv[])
{

-]

e

CTest Test( T ("Model™), CTest::Regression):
return Test.Run /() :;

[ T T ]

Alternatively, you can set the Breakpoint marker (or other marker) by right-clicking on the left margin on
the required line, to display the breakpoint/marker context menu; select the appropriate marker type.
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Trace Statements

A Trace Statement is a message that is output during execution of a debug session. Trace statements can be defined in
Enterprise Architect without requiring any changes to your application source code.

Tracepoint Markers are set in the code editor. Like breakpoints, they are placed on a line of code. When that line of code
executes, the debugger evaluates the statement, the result of which is logged to the Debug window (or to file if
overridden by the Analyzer script).

Access

Any existing Trace statements can be viewed and managed in the Breakpoints & Markers window. The Breakpoints &
Markers window can be displayed using either of the methods outlined here.

Ribbon Execute > Windows > Breakpoints

Add a Tracepoint Marker

Step Action

1 Open the source code to debug in the source code editor.
2 Find the appropriate code line, right-click in the left margin and select the 'Add Tracepoint Marker'
option.

If a marker is already there, press Ctrl+click to show the Breakpoint Properties window.

3 Ensure the '"Trace statement' checkbox is selected.
4 In the text field under the 'Trace statement' checkbox, type the required Trace statement.
5 Click on the OK button. A Tracepoint Marker is shown in the left margin of the code editor.

55 DWORD CTrain::Disembark({int PeopleOFF)

56 {

L 57 if(Passengers - PeopleOFF > -1)
: 58 Passengers -= PeopleOFF;

59 else

(1% Passengers = 8;

61

62 if(PeopleOFF > @)

63 return PeopleOFF * 28;

a4

65 return 8;

66 1

Specifying a Trace Statement
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A trace statement can be any freeform text. The value of any variables currently in scope can also be included in a trace
statement by prefixing the variable name with a special token.

The available tokens are:

e $ - when the variable is to be interpreted as a string

e (@ - when the variable is a primitive type (int, double, char)

Using our example in the image, we could output the number of people getting off a train by using this statement:
There were @Passengers before @PeopleOFF got off the train at $Arriving.Name Station

In addition to tracing the values of variables from your code, you can use the $stack and $frame keywords in your Trace
statement to print the current stack trace; use:

e  S$stack - to print all frames, or

e  S$frame[start](count) - print a specific number of frames from the stack starting at a given frame; for example,
$frame[0](5) will print the current frame and 4 ancestors

Notes

e Trace statements can be included on any type of breakpoint or marker.
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Break When a Variable Changes Value

Data breakpoints can be set on a pre-determined memory variable to cause the debugger to halt execution at the line of
code that has just caused the value of the variable to change. This can be useful when trying to track down the point at
which a variable is modified during program execution, especially if it is not clear how program execution is affecting a
particular object state.

Access
Ribbon Execute > Windows > Local Variables : Right-click on variable > Break When
Variable is Modified or
Execute > Windows > Watches : Right-click on variable > Break When Variable is
Modified
Other In a code editor window: Right-click on the variable of interest | Break when item
modified

Capture changes to a variable using data breakpoints

the 'Break When Variable is Modified' option.

Steps Detail
1 Set a normal breakpoint in the code so you can choose a variable. Then run the debugger (F6).
2 When the program has hit the breakpoint, select the variable of interest and from its context menu, select

Locals o ox
Yariable Value
E-§ this 0008 efd10
=g CTrain
#-¢ TObject
#-¢ h_thread 00000000
ey m_tid 2864
-4 MNetwork 0:0012F78
H-@  Ariving D008 ef9al
‘i Distance 0.000000
iy Capacity 500
g Mumbe Break When Vanable is Modified Ib
"ﬁ) Departi View Memaory at Address
% Locatio  yiew in Editor
iy Delay . .
¢ PeopleON Dump Variable Members to File
o Save Snapshot of Variable -
w|\Watches | L] Loca Compare Variable Snapshots
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3 There are no breakpoint indicators in the code, but data breakpoints are easily recognizable in the
Breakpoints & Events window, being a blue icon with a white diamond. Enterprise Architect displays the
name of the variable and its address instead of a line number.

ErEEkpUiﬂtS & Markers PP b e e b e P e P B P B

dy 4 3 % |Defautt 8-8-@
Enabled Line ource
Q D0ZEBEE4  int Passengers (D0ZEBEE4)
» [ 127 CHEANEATSDNCode Samples VEANR
4 With the data breakpoint set, you can disable any other breakpoints you might have. The program will

stop at any line of code that changes this variable's value. Now run your program.

5 When this variable is modified, the debugger halts and displays the current line of code in the editor. This
is not the line that caused the break, but the line of code following the event. The event is logged to the
Debug window.

#- 8 p n(ESECzO o H @
[1650154916] Module loaded CAWindows\SysWOWEdole32.dll no symbols

[1650154916] Module loaded C:AWindowsh\SysWOWENSHCORE.dIl no symbaols

[1650205565] Data breakpoint hit at CTrain.Disemnbark, chea\ea73 M code samples\vea\microsoft nativelcityloop'
[1650270313]  Data breakpoint hit at CTrain.Embark, c\ea\ea750\code samples\vea\microsoft native\cityloop'trai
[1650271852] Data breakpoint hit at CTrain.Disembark, c\ea\ea?30hcode samplesiveaimicrosoft native\citylooply
[1650272025] Data breakpoint hit at CTrain.Embark, c\ea\ea730\code samples\vea\microsoft nativel\cityloop'trai
[1650273270] Data breakpoint hit at CTrain.Disembark, c\ea\ea/30"code samplesivea\microsoft native\citylooply
[16530273521]  Data breakpoint hit at CTrain.Embark, c\ea\ea73 M code samplesivea\microsoft nativelcityloop'trai
[1650274759]  Data breakpoint hit at CTrain.Disemnbark, c\ea\ea730 code samplesivea\microsoft nativelcityloop'
4

W Debug | g Execution Analyzer

Now we know how and where this value (its State) has changed. For example, the statement at line 58 has
just updated the number of Passengers.

55 DWORD CTrain::Disembark(int PeopleOFF)

56 {
57 if{Passengers - PeopleOFF > -1)
58 Passengers -= PeopleOFF;
59 else
68 Passengers = @;
61
62 if{PecpleOFF > @)
63 return PeopleOFF * 28;
a4
B85 return @;
66 }
6 Having discovered this and other places where this value is being changed, be sure to get rid of the

notification before moving on. You can delete the data breakpoint quickly by selecting it in the
Breakpoints window and pressing the Delete key.

You can also use the right-click context menu to do this.
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Ereakpoints & Markers

Al @y dly 8 T Default B - H

Enabled Line Source

A — o

%)

Remove Break at Address

@ O de Sam
o D View Memory at Address de Sam
@O de Sam
0O H"_IF' _ de Sam
@0 220 CHAEANEATHINCode Sam

This feature is not presently supported by the Microsoft .NET platform
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Trace When Variable Changes Value

When your code executes, it might change the value of a variable. It is possible to capture such changes and the
variable's new value, on the Debug window. You can then double-click on the change record to display the line of code
that caused the change, in the Code Editor.

Access
Ribbon Execute > Windows > Local Variables : Right-click on variable > Trace When
Variable is Modified or
Execute > Windows > Watches : Right-click on variable > Trace When Variable is
Modified
Other In Code Editor | Right-click on variable | Trace When Variable Modified

Set up Trace

The variable you are tracing must be in scope, so to identify and select it, set a normal breakpoint on the line of code
where you know that the variable will exist. When the debugger reaches this breakpoint, locate the variable and use its
context menu to enable the trace.

To locate a variable:

e Ifyou see the variable in the source code, hover over it, right-click and select the 'Display variable' option;
Enterprise Architect will locate it

e If the variable is in scope (a local, or 'this' or a member of 'this'), look for it in the Locals Window ('Execute >
Windows > Local Variables')

e Ifthe variable is global (C, C++), display the Watches window ('Execute > Windows > Watches') and search for it
by name

e Ifthe variable is a Class static member, display the Watches window ('Execute > Windows > Watches') and enter its
fully qualified name

Once trace is enabled, you can disable all other breakpoints and let the program run. Each time the variable changes
value, it will be logged to the 'Output' tab of the debugger. Check the change in value and double-click on the line to
display the code in the Code Editor.

Notes

e  The debugger does not halt when the change event occurs, it only logs the change
e  This facility is available on the Microsoft Native and Java platforms

e  Microsoft .NET does not support breakpoints on values
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Detecting Memory Address Operations

Being able to detect where and when an area of memory is being read or written can be a great help for investigators,
even when the code base is well understood. Without this tool, a C++ developer could have a potentially daunting task of
tracking where and when a global variable is accessed, and debugging those functions. Data breakpoints allow a C++
programmer to track when a variable / memory location is read or when it is written. When the operation is detected, the
debugger will halt the execution and the line of code following the operation will be displayed in the code editor.

Access

Ribbon Execute > Windows > Breakpoints

Detect operation on memory address

Step Action

1 Click the ' button.
2 Enter the memory address to watch. You can copy an address from the Locals (Local Variables) window.
Data Eli?lakpuint x

Address: | 0x0033fdF4 |

Operation: Write Action: Break
Read [ Write Trace
0K Cancel
3 Select the operation to detect. If you select 'Write', the debugger will break when the address is written to.

If you choose 'Read / Write', the debugger will notify you when the address is read or when it is written.

4 Select the action to perform. If you choose 'Break’, the debugger will halt the program and the line of code
will be shown in the editor. If you choose 'Trace', the debugger will not halt execution, but log any
operation on the address as it occurs. This output is displayed in the Debugger Window.

5 The data breakpoint is added to the Breakpoints and Markers window.
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Lad9

Enabled

Breakpoints & Markers

MyBreakpoints - B-H-

Line Source

0033FDF4 [MN33FNF4

Remove Break at Address

Viﬁd Memory at Address

Help

(33fdf4

0x0033FDF4
0x0033FEDT
0x0033FELA
0x0033FEZD

6 You can use the context menu on the data breakpoint to check the value at the memory address.

Memory Viewer

a,
0100 00 Q0 00 0000 00 0000 Q0 00 00 00 00 00 CCCCCC
CCSBFE3300 18 104100010000 00 AB14 42 00 AB43
42 00 F9 97 04 AV B2 10 41 00 00 FO FD ¥F 00 FO 63 VB 28
204100 26 AE44 Y8 00 00 00 00 00 00 34 00 00 00 00 00

7 To delete a data breakpoint, select it in the Breakpoints and Markers window and press the Delete key.
Alternatively, deselect the checkbox next to it. Data breakpoints are deleted when they are disabled; they
do not persist as other breakpoints do.

System Requirements

Memory address breakpoints are supported in the C/C++ native debugger.
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Breakpoint Properties

Breakpoints have a number of additional properties that determine what occurs when executing the line of code that the
breakpoint applies to.

These properties define:

e  The action to be performed

e  The line of code that the breakpoint applies to

e  Constraints that determine whether or not the action is performed when the breakpoint is hit

e Trace information to be output when the breakpoint is hit

Ereakpoint Properties x
Action: Line number:
@ Break Execution - 62
+/| Constraints:

h_secClosingVolume < 0

.| Trace statemert

Clasing Volume @m_secClosingVolume is Megative 11

Cancel Help

Access

There are several ways to display the 'Breakpoint Properties' dialog:

Code Editor e Right-click on a breakpoint marker | Properties or
e  Ctrl+Click on breakpoint marker or

e Right-click on code that has a breakpoint marker | Breakpoint | Properties

Breakpoints & Markers e Right-click on breakpoint | Properties
window
Options
Field Details
Action The behavior when the breakpoint is hit.
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Line The line of source code that this breakpoint applies to.

Stack Height For Stack Capture markers, the number of caller frames to record. To record the
entire Stack, set the value to 0.

Constraints Defines the condition under which the breakpoint action will be taken. For normal
breakpoints this would be the condition that halts execution. In this example, for a
normal breakpoint, execution would stop at this line when the condition evaluates
to True. Constraints are evaluated each time the line of code is executed.

(this.m_FirstName="Joe") AND (this.m_LastName="Smith")

Trace statement A message output to the Debug window when the breakpoint is hit. Variables
currently in scope can be included in a trace statement output by prefixing the
variable name with a $ token for string variables, or an @ token for primitive types
such as int or long. For example:

Account $pAccount->m_sName has a balance of @pAccount->m_fBalance
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Failure to Bind Breakpoint

A breakpoint failure occurs if there is a problem in binding the breakpoint. Breakpoint failures are most often caused by
source files being changed without the application being rebuilt. Breakpoints can sometimes bind to a different line,
causing them to be moved. If a breakpoint cannot be bound to the binary at this line or the three lines following it, it is
displayed with a question mark.

A warning message displays in the 'Details' column of the Breakpoints & Events window, identifying the type of
problem:

e The source file for the breakpoint does not match the source file used to build the application image
e  The time date stamp on the file is greater than that of the image

A warning message is also output to the Debug window.
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Debug a Running Application

Rather than starting a process explicitly from within Enterprise Architect, you might want to debug an application
(process) that is already running on your system.

In this case you can use the debugging capability to attach to the process that is already running. Provided you have the
appropriate debug information written into the running process, and/or associated debug files (such as .PDB files), the
debugger binds to that process and initiates a debug session.

You can also 'detach’ from the process after you have completed your inspection and leave the process to run as normal.

Access
Ribbon Execute > Run > Start > Attach to Process
Debugger Window The debugger window toolbar has an Attach button
Stages
Stage Description

Show Processes When you select to debug another process, the 'Attach To Process' dialog displays.
You can limit the processes displayed using the radio buttons at the top of the
dialog; to find a service such as Apache Tomcat or ASP.NET, select the System
radio button.

Select Debugger When you select a process, you might have to choose the debugger from the
Debugger dropdown list; however, if the selected Package has already been
configured in an Analyzer Script, then the debugger listed in the script is preset on
the dialog.

Process Selection Once you double-click on a process containing debug information, and Enterprise

Architect is attached to the process:
e Any breakpoints encountered are detected by the debugger
e The process is halted when a breakpoint is encountered, and

e The information is available in the Debug window

Detach From Process
To detach from a process, click on the (Debug Stop) button.
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View the Local Variables

The Locals window displays variables of the executing system. Whether you are recording C#, debugging Java, C++ or
VBScript, debugging an Executable StateMachine, or running a simulation, this window is where the system's variables
are located. Current values are only displayed when a program is halted. This occurs when a breakpoint is encountered
during debugging, when you step over a line of code or when you step between States in a simulation.

Access
Ribbon Execute > Windows > Local Variables
Simulate > Dynamic Simulation > Local Variables
Context Menu In Code Editor | Right-click on any variable identifier > Display Variable
Icons

The value and type of any in-scope variable is displayed in a tree; each variable has a colored box icon that identifies the
type of variable:

e Blue - Object with members
e  Green - Arrays

e Pink - Elemental types

e  Yellow - Parameters

o Red - Workbench instance

Finding variables

The easiest way to find a variable is to first locate it in the code editor and use the right-click context menu on the
variable, selecting 'Display Variable'. Enterprise Architect will find and reveal any variable in scope, including deeply
nested members. If the variable is found in a different scope (global, file, module, static), it will be displayed in the
Watches window (see View Variables in Other Scopes).
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Go to Declaration

Go to Definition

synchronize Tree to Editor

+  Auto Synchronize Tree and Editor

Search for 'y 4

Search Intelli-sense +

5et Debugger to Line

Run to Cursor

Display Variable

Show in 5tring Viewer
Break when item modified
Trace when item modified
Create Use Case for 'Run’

EBreakpoint +

Persistent View

The examination of variables usually involves digging around in the tree to expose the values of interest. It can be
annoying then, having gone through that trouble, to step to the next line of code, only to have those variables buried from
sight again due to a change in context. The Locals window has a persistent view that lingers for a while after a run or
step command. When you step through a function in Enterprise Architect, the variables structure persists line after line.
This makes stepping through a function quick and easy.

What changed

As part of the persistent view, the Locals window tracks changes to values and highlights them.

Locals -
Variable Value Type Address
= § this Dx02BD0OAAD Exchange:Account™  Ox00cBfed0
= & Exchange:Account Exchange:Account Ox02bd0aal
G Exchange:lAccount Ox02bd0aal
& m_pExchange Ox0DCEFE44 Exchange:lExchange® Ox02bd0aad
& m_acctMame "Its not broken Pty Ltd" ATLaCStringT<wchar  (x02bd0aald
§ m_acctBalance 0982877 (10004599) int M02bd0aac
@ m_acctlD O (1) unsigned int Ox02bd0ab0
; sid D (2) unsigned int Ox00cBfeel
; amount Oxba (106) unsigned int Ox00cBfbed
; debitPurchaseCost Oufffffec? (-318) int OxD0cEfoed

Context Menu
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Facility

Break When Variable is
Modified

View Memory at Address
Show in String Viewer

Dump Variable Members
to File

Save Snapshot of Variable

Compare Variable
Snapshots

Copy

Add Instance Run State to
Diagram

Set Conditional Breakpoint
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Detail

Set data breakpoints on the selected memory variable to halt debugger execution at
the line of code that has just caused the value of the variable to change.

Display the raw values in memory at the selected address, in hex and ASCIL.
Display the variable string in the 'String Viewer' dialog.

Capture and store the selected variables to a separate location; a browser displays to
select the appropriate .txt file name and file path.

Capture the value of a variable at a specific point in the life of that variable.

Compare the values of a variable at different points in the life of that variable.

Copy the selected variable to the Enterprise Architect clipboard.

If you have opened a model diagram containing an Object of the Class for which
the source code is being debugged, this option updates that Object with the Run
State represented by the variable value.

Add a breakpoint at the current execution position with a constraint for this variable
matching its current value.
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View Content Of Long Strings

For efficiency, the Locals window only shows partial strings. However, you can display the entire contents of a string
variable using the 'String Viewer'.

Locals
Variable Value Type Address
@ this (2 5604E00 CContextHandler™ (0887efbd
& grammar Y AML nBMF Grammar caseSensitive(); delir - ATL:CStringT<unsigr  0n0887f0b4
B ¢ data "< Tyl version="1.0" encoding="UTF-8"7> «  ATL:CStringT<unsigi 0x0887f0ed
= & ATL:CSimpleString T« 0x0887f0ed
= § m_pszData "« Tyml version="1.0" encoding="UTF-8"?> <« wchar* 0x0887f0ed
o owehar  <hmlversion="10" encodina="UTF-8'7>< wechar %050
& macros Break When Variable is Modified ATL:CStringT<unsigr  Oe0887F0dc
G ret Trace When Variable is Modified bool (D28 T7efbf

View Memory at Address

Show in String Viewer

Dump Variable Members to File
Save Snapshot of Variable
Compare Variable Snapshots

Copy
Add Instance Run State to Diagram

Set Conditional Breakpoint

Help

This example shows the value of a variable holding the contents of an XML schema file.
String Viewer

< fusd:enumeration = -
<xsdienumeration value="204143">
<xsd:annotation >
<xsd:documentation xml:lang="en"=
<rctsiMame =Discharging chassis in overtime < focts:Mame =
< fusd:documentation =
< fusd:annotation =
< fusdienumeration =
<wsd:enumeration value="204144">
<¥sd:annotation =
<xsd:documentation xml:lang="en">
<crtsiMame =Discharging breakbulk (1 ton to 7 ton) ro+o in overtime < fccts:Mame =
< fwsdidocumentation =
< fusd:annotation =
« fusd:enumeration =
«<xsdienumeration value="204145">

Access
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From Code Editor or Right-click on string variable | Show in String Viewer
Locals window
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View Debug Variables in Code Editors

When a breakpoint occurs, you will see all the local variables in that window. You can also inspect variables in the
Source Code Editor by hovering your mouse over the reference. Here are some examples.

public woid Print ()

{
int nn = 0;
while (names[n].Length = 0)
{ names = {[4] names[0]=book, names[0]=book, names[1]=novel, names[2]=Ffilm}, ]-l
D'ocumi = [n¥¥TT -
d_Print () ;
}
}

public woid Print ()
{

int n = 0;
whi 1437-hit signed inkeger n=0} 0%
{

Document d = new Document (hames[n++]);
d.Printi();

Note: The variable does not have to be one of the local variables. It can have a file or module scope.
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Variable Snapshots

It is possible to take a 'snapshot’ of a variable when your program hits a breakpoint and use this snapshot to see how the
value of the variable changes at different points in its life. The debugger does not copy the value of the selected variable
only; for complex variables it copies the values of the selected variable and of each of its hierarchy of members until it
can no longer find any more debug information for a member or no more members can be found.

Capture Variable Snapshot

Step Action

1 In the Code Editor, set two breakpoints: one at the start of a function and another at the end of the
function.
2 At the start breakpoint, right-click on a variable in the Locals window and select the 'Save Variable

Snapshot' menu option.
3 Run the application.

4 When the end breakpoint is reached, right-click on the variable in the Locals window and select the
'Compare Variable Snapshots' option.

A dialog displays that shows the original value from the first snapshot and the current value from the
second snapshot as illustrated in this diagram taken from the EA.Example model.

CTrain® this X
Mame Address Valuel Value?2

int::Passengers Ox0003BEE4  Owxbl (177) Oxd& (214)

int::Delay 0x0003BEF4  Ox3c (B0) 0x28 (40)

Save Variable Snapshot to File

You can save the state of a variable to file using its right-click context menu.
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Break When Variable is Modified
Trace When Variable is Modified
Yiew Memory at Address
Show in String Viewer

Dump Variable Members to File

Save Snapshot of Variable

Copy

5et Conditional Breakpoint

Help

This is an excerpt of the file contents.

73 BEBREEEE | Bxe8731F08 | name | TObjectType: :Type |value|TypelsStation]|
74 BEBBEEOS5 | 8xe8731F08 | name |wchar: :Name |value|"Treasury”|

75 BEEREEES5 | Bxe8731FeC |name|unsigned::Location |value|@x4@ (64) |

76 BE0REE03 | Bxee83BEDS | name | float: :Distance |value|@|

77 BEBREEES | Bxe8B3EEER | name|int: iCapacity |value|@xlf4 (5e8) |

75 BEEREEE3 | Bxe@83BEE4L | name|int: i Passengers |value|exds (214) |

79 BEBREEES | Bxe8B3BEES | name|unsigned: iNumber  |value|@x3 (3)|

56 BEBREEES | BxeBB3EEFe | name|unsigned::Location |value|@xe (@) |

81 eERREEES | BxeBBSEEFL | name|int: :Delay |value|8x28 (48) |
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Actionpoints

Actionpoints are breakpoints that can perform actions. When a breakpoint is hit, the Actionpoint script is invoked by the
debugger, and the process continues to run. Actionpoints are sophisticated debugging tools, and provide expert
developers with an additional command suite. With them, a developer can alter the behavior of a function, capture the
point at which a behavior changes, and modify/detect an object's state. To support these features, Actionpoints can alter
the value of primitive local and member variables, can define their own 'user-defined-variables' and alter program
execution.

User-Defined Variables in Actionpoints and Breakpoints

User Defined Variables (UDVs):

e Provide the means for setting a UDV primitive or string in Actionpoint statements
e Can be used in condition statements of multiple markers/breakpoints

e (Can be seen easily in the same Local Variables window

e The final values of all UDVs are logged when debugging ends.

In the UDV syntax, the UDV name:
e Must be preceded by a # (hash) character

o [s case-insensitive

Actionpoint Statements

Actionpoint statements can contain set commands, goto commands and jmp commands.

set command

Sets variable values. An Actionpoint statement can contain multiple 'set' commands, all of which should precede any
'goto' command.

The 'set' command syntax is:
set LHS = RHS
Where:

e LHS = the name of the variable as a:
- user defined variable (UDV) such as #myval
- local or member variable such as strName or this.m_strName

e  RHS = the value to assign:
- As a literal or local variable
- If a literal, as one of: integer, boolean, floating point, char or string

set command - Variable Examples

UDV Examples Local Variable Examples
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set #mychar = 'a’' set this.m_nCount=0
set #mystr = "a string" set bSuccess=false
set #myint = 10

set #myfloat = 0.5

set #mytrue = true

goto command

This command switches execution to a different line number in a function. An Actionpoint statement can contain only
one goto command, as the final command in the statement.

The goto command syntax is:
goto L
Where L is a line number in the current function.

The goto command uses breakpoints to achieve its goal, which causes a slight delay in code execution. This can be
noticeable in regions of code that are executed very frequently, so you might prefer to use the jmp command in such
code, to achieve the same diversion of execution but with less delay.

jmp command

The jmp command is effectively the same as the goto command.
jmp 125
goto 125

Both these commands cause the execution to be changed to line 125.

However the jmp statement internally uses instrumentation to direct the program to move execution, whereas the goto
statement uses breakpoints to do that, which causes a delay in processing. The difference is, therefore, superior
performance for the jmp statement, especially where regions of code are executed very frequently.

Integer operators

Where a User Defined Variable (UDV) exists and it is of type int, it can be incremented and decremented using the ++
and -- operators. For example:

1. Create a UDV and set its value and type to a local integer variable.
API: set #myint = nTotalSoFar

2. Increment the UDV.
AP2: #myint++

3.  Decrement the UDV.
AP3: #myint--
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Timer operations

Actionpoints can report elapsed time between two points. There is only one timer available, which is reset or started with
the startTimer command. The current elapsed time can then be printed with the printTimer command. Finally, the total
elapsed time is printed and the timer ended with the endTimer command.

Example Actionpoint Conditions

With Literals and constants:
e (#mychar="a')

e (#mystr<>"")

e (#myint > 10)

e (#myfloat > 0.0)

With Local Variables:
e  (#myval == this.m_strValue)
e (#myint <> this->m_nCount)

e  (#myint != this-=>m_nCount)

Instruction Recording

Instruction recording can be useful for detecting changes to a known behavior; the point in execution (B) that diverges
from a previous execution(s) (A). The commands are:

e  recStart - starts recording or starts comparing if a previous recording exists
e recStop - ends recording

e recPause - pause recording

e recResume - resumes recording

The recStart command begins recording instructions. Executed instructions are then stored. When a recStop command
is encountered, the recording is saved. There can only be one saved recording at any one time between two Actionpoints.
When a recStart is encountered and a previous recording exists, the debugger will begin comparing each subsequent
instruction with its recording. It could perform many comparisons. If and when a difference is detected, the debugger
will break and the line of code where the behavior changed will be displayed in the code editor. The iteration of the
comparison is also printed.

The recording is stored in memory by default, but it can also be stored to a file with the command syntax:
recStart filesspec

For example:
recStart ¢:\mylogs\onclickbutton.dat

When a reeStart command is encountered that specifies a file, and that file exists, it is loaded into memory and the
debugger will immediately enter comparison mode.

Expressions

There is no implicit precedence in Breakpoint, Actionpoint and Testpoint conditional expressions. In complex
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expressions, the use of parentheses is mandatory. See these examples:

Type

Actionpoint UDV example

Local variables examples

Equality operators in
conditional expressions

Assignment operator in
Actionpoint

Arithmetic operators in
conditional expressions

Logical operators in
conditional expressions

(c) Sparx Systems 2025

Example
(#myint=1) AND (#mystr="Germany")

(this.m_nCount > 10) OR (nCount%1)
(this.m_nCount > 10) OR (bForce)

<> - Not Equal
1= - Not Equal
== - Equal
= - Equal

- Assigns RHS to LHS

/ - division
+ - plus

- minus

*

- multiplication

% - modulus

AND - both must be true
OR - one must be true
&& - both must be true

|| - one must be true

" - exclusive OR (only one must be true)
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View Variables in Other Scopes

Access

Ribbon Execute > Windows > Watches

h . . = =
Other Execution Analyzer window toolbar : 5 | Watches

Views

View Description

Watches The Watches window is most useful for native code (C, C++, VB) where it can be
used to evaluate data items that are not available as Local Variables - data items
with module or file scope and static Class member items.

You can also use the window to evaluate static Class member items in Java and
NET

To add a watch, type the name of the variable to watch in the toolbar, and press the
Enter key.

To examine a static Class member variable in C++, Java or Microsoft .NET, enter
its fully qualified name:

CMyClass::MyStaticVar
To examine a C++ data symbol with module or file scope, just enter its name.

Variables are evaluated by looking at the current scope; that is, the module of the
current stack frame (you can change the scope at a breakpoint by double-clicking
the frame in the Call Stack).

If the global variable exists in a different module, you can examine the variable by
prefixing the module name to the variable

modulename!variable name

It is quite easy to mistype data item names, so if you make or find an error,
highlight the string, press F2 and retype the text. This also speeds up the resolution
of named items in the debugger, by breaking a search when matching item are
discovered.

History The history of items entered is maintained. Previously entered names or expressions
can be selected again using the Up arrow key and Down arrow key inside the
toolbar text box. The history will also persist for the user across any instance of
Enterprise Architect or model on the same machine.
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View Elements of Array

You can use the Watches window to inspect one or more specific elements of an array.

In the field to the left of the Watches window toolbar, type the variable name of the array followed by the start element
and the number of elements to display. The start element is enclosed in square brackets and the count of elements is
enclosed in parentheses; that is:

variable[start_element](count of elements)

For example, Points[3](2) displays the fourth and fifth elements of the Points array, as illustrated.

Watches q =
Points[3](2) HE
Varable Value Type
E-4 Points CPoint[100]
=-¢ Points[3] CPoint
. ¢ tagPOINT
e X 610 long
ey 35 leng
El--u Points[4] CPoint
=@ tagPOINT
e X 45 long
ey 35 leng
1 | 1] b

] Watches | x| Locals [ Memory Viewer

If you entered Points[3] the Watches window would show the third array element only.

Access
Ribbon Execute > Windows > Watches
Other Execution Analyzer window toolbar : § - | Watches
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View the Call Stack

The Call Stack window is used to display all currently running threads in a process. It can be used to identify which
thread is operational, immediately before program failure occurs.

When a Simulation is active, the Call Stack will show the current execution context for the running simulation. This will
include a separate context stack for each concurrent simulation 'thread'.

A stack trace is displayed whenever a thread is suspended, through one of the step actions or through encountering a
breakpoint. The Call Stack window can record a history of stack changes, and enables you to generate Sequence
diagrams from this history.

Access

Ribbon Execute > Windows > Call Stack

Other Execution Analyzer window toolbar : & - | Call Stack
Use to

e  View stack history to understand the execution of a process
e View threads

e Save a call stack for later use

e Record call stack changes for Sequence diagram generation
e  Generate a Sequence diagram from the call stack

e  View the related code line in the Source Code Editor

Facilities
Facility Description
Indicators e A pink arrow highlights the current stack frame
e A blue arrow indicates a thread that is running
e A red arrow indicates a thread for which a stack trace history is being recorded
Save a Call Stack to a Not currently available.
TXT File
Record a Thread in a To record the execution of a thread and direct the recording to the Record &
Debug Session Analyze window, right-click on the thread in the Call Stack and select the

appropriate context menu option:

e 'Record' - to manually record the current thread during the debug session
Used in conjunction with the 'step' buttons of the debugger; each function that
is called due to a step command is logged to the Record & Analyze window
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e 'Auto-Record' - to perform auto-recording during a debug session
When you select this icon, the Analyzer begins recording and does not stop
until either the program ends, you stop the debugger or you click on the 'Stop'
icon

Stop Recording If you have started a manual or automatic recording of a thread you can stop it
before completion; select the thread (indicated by a red arrow) and either:

e  Click on the (Stop Recording) button in the toolbar or
e Right-click and select the 'Stop' option

Generate a Sequence To generate Sequence diagram from the Call Stack trace, either:
Diagram from the Call 2
Stack e  C(Click on the (Generate Sequence Diagram of Stack) button, or

e Right-click and select the 'Generate Sequence Diagram' option

Copy Stack to Recording To add the stack details immediately to the Record & Analyze window (for later
History generation of Sequence diagrams) either:

e  C(Click on the E& button, or

e Right-click and select the 'Copy Stack to Record History' option

Toggle Stack Depth To toggle between showing the full stack and showing only frames with source,
click on the (Toggle Stack Depth) button.

Display Related Code in Double-click on a thread/frame to display the related line of code in the Source

Source Code Editor Code Editor; local variables are also refreshed for the selected frame.
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Create Sequence Diagram of Call Stack

The Call Stack window records a history of stack changes from which you can generate Sequence diagrams.

Access

Ribbon Execute > Windows > Call Stack

Other Execution Analyzer window toolbar : § - | Call Stack
Use to

e Record Call Stack changes for Sequence diagram generation

e  Generate a Sequence diagram from the Call Stack

To generate a Sequence diagram from the current Stack, click on the B (Generate Sequence Diagram of Stack) button
on the Call Stack window toolbar.

This immediately generates a Sequence diagram in the Diagram View.
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b
b
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Inspect Process Memory

Using the Memory Viewer, you can display the raw values of memory in hex and ASCII. You can manually define the
memory address in the 'Address' field (top right), or right-click on a variable in the Locals window or Watches window
and select the 'View Memory at Address' option.

Access
Ribbon Execute > Windows > Memory Viewer
Other Execution Analyzer window toolbar : & | Memory Viewer
From Locals window or Watches window : Right-click on a variable | View
Memory at Address
Notes

e The Memory Viewer is available for debugging Microsoft Native Code Applications (C, C++, VB) running on
Windows or within WINE on Linux
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Show Loaded Modules

For .NET and native Windows applications, you can list the DLL's loaded by the debugged process, using the Modules
window. This list can also include associated symbolic files (PDB files) used by the debugger.

Access

Ribbon Execute > Windows > Modules

Modules Window display

Column Description
Path Shows the file path of the loaded module.
Load Address Shows the base memory address of the loaded module.
Modified Date Shows the local file date and the time the module was modified.
Debug Symbols Shows:

e The debug symbols type
e Whether debug information is present in the module, and

e Whether line information is present for the module (required for debugging)

Symbol File Match Indicates the validity of the symbol file; if the value is false, the symbol file is out
of date.

Symbol Path Shows the file path of the symbol file, which must be present for debugging to
work.

Modified Date Shows the local file date and time the symbol file was created.
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Process First Chance Exceptions

Access
Ribbon Execute > Tools > Debugger > Process First Chance Exceptions
Other &

Debug window toolbar : - | Process First Chance Exceptions

Processing Elements

Element Description

Debug Process When an application is being debugged and the debugger is notified of an
exception, the application is paused and the debugger responds in the way it is
configured to do; it either:

e Resumes the application and leaves the exception to the application to manage,
or

e Keeps the application suspended and passes the exception to the appropriate
routines for automatic resolution or manual intervention

Second Chance Exceptions The Enterprise Architect debugger defaults to the first listed behavior.

If the application can handle the exception, it continues to process; if it cannot
handle the exception, the debugger is notified again and this time it must suspend
the application and resolve the exception condition.

In this behavior, because the debugger has encountered the exception twice, it is
known as a second-chance exception; in this case, if the exception does not halt
execution, it is ignored and you avoid spending time on conditions that do not
impact the overall outcome of processing.

You might work this way on large or complex systems that invariably involve
exception conditions somewhere in the processing paths.

First Chance Exceptions However, if you want to examine every exception that occurs as soon as it occurs,
you can set the debugger to adopt the second behavior.

Because the debugger responds to the exception on first contact, it is known as a
first-chance exception.

You might work this way with individual functions or routines that must work
cleanly or not at all.

Selection Select the 'Process First Chance Exceptions' option to debug exceptions on first
contact.

Deselect the option to process exceptions only if the application fails when they
occur.
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Just-in-time Debugger

You can register the Enterprise Architect debugger as the operating system Just-in-time debugger, to be invoked when an
application running outside Enterprise Architect on the system either encounters an exception or crashes. When you do
s0, an application crash will cause Enterprise Architect to be opened, and the source and reason for the crash displayed.

Access

Ribbon Execute > Tools > Debugger > Set as JIT Debugger
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Services

Enterprise Architect provides two services to facilitate remote script execution and remote debugging. The services
primarily support Enterprise Architect running on Linux to allow users to run native Linux shell scripts and debug Linux
programs. The Satellite service supports Analyzer Scripts while the Agent service supports debugging.

Access

Ribbon Execute > Tools > Services

The Satellite Service

The Satellite service is responsible for executing Analyzer Scripts on the machine on which it is running. The feature can
help Linux users to execute native Linux programs and shell commands directly, bypassing Wine. The service can be
managed from the ribbon, and it can also be run independently from a terminal.

The Linux Shell

The default shell used by Enterprise Architect is 'bash'. To override the Linux Shell used by Enterprise Architect, open a
Linux terminal, run 'wine regedit ' and add a string value to this registry key:

HKEY CURRENT_USER\Software\Sparx Systems\EA400\EA\Options
where:

e key name: "LINUX"

e key value: path

and path is the Linux path to the shell program "/bin/bash", for example.

Permissions

Under Linux you must check that the service programs have the appropriate permissions. The programs are located under
the Enterprise Architect installation folder, in the sub directory "VEA/x86/linux'. Check that each of the programs in this
directory has the execute permission set for the owner.

Notes

e The Satellite services are enabled in the Unified and Ultimate Editions of Enterprise Architect

The Agent Service

The Agent service is responsible for managing debugging sessions for Enterprise Architect's GDB debugger. The service
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allows Enterprise Architect users to debug Linux programs. The service can be managed from the ribbon. It can also be
run independently from a terminal.

The Services Menu

Option

Description

View Status of all
Service(s)

Displays a View that lists the status of each Enterprise Architect service named in
the config file, and its state.

Satellite Service

Start Starts the service. The service listens on the Satellite Port configured in any
Analyzer Script Services Page.

Stop Stops the service.

Test Tests the status of the Satellite Service, whether it is running or not.

Agent Service

Start Starts the service. The service listens on the Agent Port configured in an Analyzer
Script Services Page.

Stop Stops the service.

Test Tests the status of the Agent Service, whether it is running or not.

Code Miner Service

Start

This option reads the current Service Configuration file and starts services that are
configured to run, and stops running services that are not configured to run. A
service is configured if:

1. It is named in the config file.
2. It has the attribute status:ON.
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ON:EA port:9910, (Running)

Apply Close
Stop All This option stops any services that are currently running.
Edit Configuration File This option prompts for the Service Configuration file to use, then opens that file in
an Enterprise Architect text editor. The system remembers where the file is held.
31# <number> - digits
32# ---memree e e r e r e m e m e — - -
33#
34 {
35 name=projectil,
36 status=0N,
37 lazyload=true,
38 port=99510,
39 allow=localhost,
40 network=local,
41 autoupdate=true,
42 show=true,
43 logoutput=c:\My Documents\projectl.txt,
44 loglevel=information|warning|error,
45 database=c:\My Documentsiprojectl\projectl.cdb
46}
47
Auto Start with EA This option automatically starts services having the 'status:ON' attribute when the

model opens.

System Output
Systern  Debug Auditlog Broadcast VClog  Job History  Script HE]

Full load on demand package: 1

EAD0-0000-2F00

Auto Start Services Enabled

Service Configuration: C:\ea\intelservice\SparxServices.config
Service EA is running

The messages logged to the System Output window here when the model is opened
indicate that the service was already running.
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Auto Stop on Close This option automatically stops running services when Enterprise Architect is
closed down.
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Analyzer Services Window

The Analyzer Services window displays the status of each of:

e The services being managed by the active Analyzer Script (maintained through the 'Execute > Tools > Analyzer'
ribbon option)

e Any local services managed separately using the service configuration file (available from the 'Execute > Tools >
Services > Code Miner Service > Edit Configuration File' ribbon option)

» r X

@Start Page EAna\\.’zer Services X q b

Computer: SMEAGHER-2111 System: Linux Mint, 20.3 (Una)

EA: 16.0 Build 1602 Model: regression
Type 0/S Name Source Status
Sparx Linux Linux Satellite Service Analyzer Running Edit

Sparx Windows Windows Satellite Service Analyzer Running Edit

Remote Intel Service Analyzer Running Edit

Personal Linux Config Edit

The window lets you see at a glance which intel service you are using, for example, or that the Windows service you use
to work in Enterprise Architect is running.

All of the data in the window is read-only, but you can edit the service by clicking on the Edit button. This displays the
'"Private Options - Services' page of the Analyzer Scripts Editor window, which you can update as required.

Access
Ribbon Execute > Tools > Services > View Status of All Services
Start > All Windows > Execute > Analyze | Analyzer Services
Keyboard Shortcuts Alt+4 | Analyze | Analyzer Services

Analyzer Services Window Fields

Field Description

Computer The work station on which the services are running.
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System The operating system under which the work station is running.

EA The release number and build number of the version of Enterprise Architect you are
using.

Model The name of the model in which you are currently working.

Type The type of service. The services listed as type 'Sparx' are Enterprise Architect
Services.

0O/S The operating system under which the service runs.

Name The name and description of the service.

e The Linux Satellite Service is managed automatically by Enterprise Architect
when the application is running on Linux under WINE

e The Windows Satellite Service is an optional service that is typically used in
WINE installations to help build Visual Studio Projects on a remote Windows
machine such as a VM (Virtual Machine); the service only runs on Windows
and is managed locally using Windows Services on the machine itself

Source The script group or configuration file defining the service.
Status The status of the service.
When you first open the window, each service initially has the Status 'Test' as the

system assesses the service. The Status then changes to the appropriate value, such
as "Running' or 'Stopped'.

Edit Click on this button to view or edit the service definition.
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Recording
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Sequence diagrams are a superb aid to understanding behavior. Class Collaboration diagrams also can be helpful. In
addition to these, sometimes a Call Graph is just what we need. Then again, if you have this information available, you
could use it to document a Use Case, and why not build a Test domain while you are at it? The Enterprise Architect
Analyzer can generate all of these for you and from a single recording. It does this by recording a running program, and
it works on all of the most popular platforms.

Access

Ribbon Execute > Tools > Recorder

Overview

At its simplest, a Sequence diagram can be produced in very few steps, using even a brand new model. You do not even
have to configure an Analyzer Script. Open the Enterprise Architect code editor (Ctrl+Shift+0O), place a recording
marker in a function of your choice, and then attach the Enterprise Architect Debugger to a program running that code.
Any time that function is called, its behavior will be captured to form a recording history. From this history these
diagrams can be easily created.
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Sequence diagram generatedin
Enterprise Architect using
recording marker ina Use Case

The Sequence diagram from the Example Model recording.

[ ] | |

Transaction
+  BeginDay(int): void +  Broker() +  GetAmount(): INT
+  EndDay(): int +  “Broker() +  GetStock(): TStockiD
+  Move(int): void - GetNext{Exchange::TAccountiD): Exchang +  Transaction(TAccountiD, TStockiD, INT)
+  Sector(ESector) + Trade(Exchange::Exchange™): void . '

-m_exchSectors

Stock
+  Create(IExchange®, LPCTSTR, FLOAT, UINT, ESector): IStock™
+  GetName(): LPCTSTR
+  GetSector{): ESector
Exchange +  GetStockCost(): FLOAT
+  GetstockiD(): TStockiD
+  Buy(TAccountiD, TStockiD, UINT): bool + GetStockVolume(): UINT
+  Close(): void +  Stock(LPCTSTR, FLOAT, UINT, ESector)
+  Exchange(LPCTSTR)
+  ~Exchange()
- FindAccount(CString): Account*
- Findstock{cstring): Stock*
- FreeAccounts(): void
- Freesectors(): void Account
reeStocke!) okl . - Account(LPCTSTR, UINT)
* GEM“”“"E(TA“D“””D)'Afm“"E + Create(lExchange*, LPCTSTR, UINT): IAccount®
GetSector(ESector): Sector +  Credit{TStockiD, UINT, INT): void
S Cetsioek (TS ioekiD) Stock +  Credit(Stock®, UINT, INT): void
+  Open(): bool +  Debit(TStockiD, UINT, INT): void
+  RegisterAccount{Account®): TAccountiD e e I ey
+  Registerstock(Stock*): TstockiD +  GetAccountiD): TAccountin
+  Sell{TAccountID, TStockiD, UINT): bool e e,
+  Transmitstock(IStock®): TStockiD +  GetName(): LPCTSTR
UpdateSector(ESector, INT): void ~ Register{IExchange*): void

The Class Collaboration diagram from the same recording.
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The Test Domain diagram from the same recording.

Of course, an Analyzer Script is still the best idea, and opens up an incredibly rich development environment, but it is
worth noting that significant results can be obtained without one. This is also true of the Enterprise Architect Debugger
and Profiler tools.

A point of interest: you can view a thread's behavior while it is recorded. Showing the Call Stack during a recording will
show updates to a thread's stack in real-time, much like an animation. It is a good feedback tool and in some
circumstances it might be all that is required.

| = [ | OO N RN RS RN AR AR AR AR AR RN AR AR AA RSN AR AR AR AR RN AR R RN AN RN RN S RN RN R RN
HE®R" 0@
o Thread 4184

Broker.exe! wmain, chea\wea\projects\c++\stockexchange\brok

Broker.exe! Trade, chea\wea\projectsc++\stockexchange\broke
Broker.exe! GetMext, ciea\wea\projects\c++\stockexchange\bro
Broker.exe! CArray<Exchange Transaction *,Exchange. Transactio
Eroker.exe! CArray<Exchange Transaction *,Exchange Transactio
g+ Broker.exe! CArray<ExchangeTransaction * Exchange. Transactio

Features at a glance

Diagram Generation

e Sequence diagram

e (Class Collaboration diagram
e Test Domain diagram

e  State Transition capture

e Call Graph

Control

e  Support multi-threaded and single-threaded models

-
-

e  Support stack depth control
e  Support filters to restrict capture

e  Filter wildcard support
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e  Real-time stack update
Integration

e (Class Model

e  Test Domain

e  StateMachine

e  Executable StateMachines

o  Unit Tests

Platforms

e  Microsoft NET

e  Microsoft Native

e Java

e PHP

e GDB

o  Android
Requirements

e Recording is available to users of all editions of Enterprise Architect

Notes

e The debug and record features of the Visual Execution Analyzer are not supported for the Java server platform
"Weblogic' from Oracle
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How it Works

This topic explains how the Visual Execution Analyzer generates Sequence diagrams.

Explanation

Points Detail

Usage The Visual Execution Analyzer enables you to generate a Sequence diagram from
recordings of the live execution of an application. As the application runs, the
history of each thread is recorded. This history can be used to generate the
Sequence diagram.

This is a Sequence diagram generated from a program that calculates the price of
books:
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How does the recorder know what to record?

e The recorder works from recording markers; these are placed by you in the
functions of interest

Call Stacks in Java can stretch further than the eye can see. How can we restrict the
recording to just ten frames?

e The recorder is controlled by the depth either set on the recorder toolbar or
associated with a Marker Set stored in the model

Its the real thing In recording, the target application is not modified; no instrumentation of any
image or module occurs at all. A recording produced using a 'Release' build of a
program is a trustworthy document of what a program did.

Where do you start We have a very large server application; so where do we start? If you have little or
no understanding of the program you intend to record and little or no model to
speak off, you might be best starting with the Profiler. Running the Profiler whilst
using a program in a specific manner can quickly identify Use Cases from the entry
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points and Call Graphs presented. Having that knowledge can enable you to focus
on areas that are uncovered and record those functions.

If you have the source code, all you need to do is place a recording marker in a
function that interests you. We recommend against placing multiple recording
markers in multiple functions at the same time. In practice this has shown to be less
helpful. Where do you place a recording marker? For windows UI programs, and in
relation to some business use case, you might start by placing one in the event
handlers for a message that seems most pertinent. If you are investigating a utility
function, just set a method recording marker at or somewhere near the start.

For services, daemons and batch processes you might want to profile the program
once for each behavior of interest and use the report to explore those areas

uncovered.

Tip It's a good idea to have a quick glance at the Breakpoints and Markers window
before debugging, and check that the markers listed here are what you are
expecting.

Scenarios e  Microsoft Native C and C++, VB

(Windows programs, Window Services, Console programs, COM servers, IS
ISAPI modules, Legacy)

e  Microsoft NET
(ASP.NET, Windows Presentation Foundation (WPF), Windows Forms,
Workflow Services, devices, emulators)

e Java
(Apps, Applets, Servlets, Beans)
e Android
(using Android debug bridge for devices and emulators)
e PHP
(Web site scripts)
e GDB

(Windows / Linux interopability)
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The Recording History

When the execution analysis of an application encounters user-defined recording markers, all information recorded is
held in the Record & Analyze window.

Access

Ribbon Execute > Tools > Recorder > Open Recorder

Facilities

Facility Information/Options

Information Display The columns in the Record & Analyze window are:
e Sequence - The unique sequence number
e Threads - The operating system thread ID
e Delta - The elapsed thread CPU time since the start of the sequence

®  Method - There are two Method columns: the first shows the caller for a call or
for a current frame if a return; the second shows the function called or the
function it is returning to

e Direction - Stack Frame Movement, can be Call, Return, State, Breakpoint or
Escape (Escape is used internally when producing a Sequence diagram, to
mark the end of an iteration)

e Depth - The stack depth at the time of a call; used in the generation of
Sequence diagrams

e  State - The state between sequences

e Source - There are two Source columns: the first shows the source filename
and line number of the caller for a call or, if a return, for a current frame; the
second shows the source filename and line number of the function called or
function returning

e Instance - There are two Instance columns, which only have values when the
Sequence diagram produced contains State Transitions; the values consist of
two items separated by a comma - the first item is a unique number for the
instance of the Class that was captured, and the second is the actual instance of
the Class

For example: supposing a Class 'CName' has an internal value of 4567 and the
program created two instances of that Class; the values might be:

- 4567,1

- 4567,2
The first entry shows the first instance of the Class and the second entry shows
the second instance

Operations on Information The Record & Analyze window toolbar provides a range of facilities for controlling

the recording of the execution of an Analyzer script.

You can perform a number of operations on the results of a recording, using the
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Record & Analyze window context menu, once the recording is complete.

Notes

e  The checkbox against each operation is used to control whether or not this call can be used to create a Sequence,
Test Domain Class or Collaborative Class diagram from this history

e In addition to enabling or disabling the call using the checkbox, you can use context menu options to enable or
disable an entire call, all calls to a given method, or all calls to a given Class
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Diagram Features

When you generate a Sequence diagram, it includes these features:

Features
Feature Detail

References When the Visual Execution Analyzer cannot match a function call to an operation
within the model, it still creates the Sequence but also creates a reference for any
Class that it cannot locate.
It does this for all languages.

Fragments Fragments displayed in the Sequence diagram represent loops or iterations of a
section(s) of code.
The Visual Execution Analyzer attempts to match function scope with method calls
to as accurately as possible represent the execution visually.

States If a StateMachine has been used during the recording process, any transitions in

State are presented after the method call that caused the transition to occur.

States are calculated on the return of every method to its caller.
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Setup for Recording

This section explains how to prepare to record execution of the application.

Steps

Step

Prerequisites - To set up the environment for recording Sequence diagrams you must:
e Have completed the basic set up for Build & Debug and created Execution Analysis scripts for the Package
e Be able to successfully debug the application

Narrow the focus of a recording by applying filters.

Control the detail of a recording by adjusting the stack depth.
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Control Stack Depth

When recording particularly high-level points in an application, the Stack Frame count can result in a lot of information
being collected; to achieve a quicker and clearer picture, it is better to limit the stack depth on the toolbar of either:

e The Breakpoint and Markers window or

e The Record & Analyze window

Access

Ribbon Execute > Tools > Recorder > Open Recorder

Set the recording stack depth

You set the recording stack depth in the numerical field on the toolbar of the Breakpoints & Markers window or the
Record & Analyze window:

E

By default, the stack depth is set to three frames. The maximum depth that can be entered is 30 frames.

The depth is relative to the stack frame where a recording marker is encountered; so, when recording begins, if the stack
frame is 6 and the stack depth is set to 3, the Debugger records the frames 6 through 8.

For situations where the stack is very large, it is recommended that you first use a low stack depth of 2 or 3. From there
you can gradually increase the stack recording depth and insert additional recording markers to expand the picture until
all the necessary information is displayed.
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Place Recording Markers

This section explains how to place recording markers, which enable you to silently record code execution between two
points. The recording can be used to generate a Sequence diagram.

As this process records the execution of multiple threads, it can be particularly useful in capturing event driven
sequences (such as mouse and timer events).

Access

Ribbon Execute > Windows > Breakpoints

Actions

Action

Different recording markers can be used for recording the execution flow; see the related links for information on
the properties and usage of these markers.

Manage breakpoints in the Breakpoint & Markers window.
Activate and deactivate markers.

Working with Marker Sets - when you create a breakpoint or marker, it is automatically added to a marker set, either
the Default set or a set that you create for a specific purpose.

Notes

e  The Breakpoint and Marker Management topic (Software Engineering) describes a different perspective
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Set Record Markers

Markers are set in the source code editor. They are placed on a line of code; when that line of code executes, the
Execution Analyzer performs the recording action appropriate to the marker.

Access

Use one of the methods outlined here, to display the Code Editor window and load the source code associated with the
selected Class or Class element.

Ribbon Execute > Source > Edit > Edit Element Source

Execute > Source > Edit > Open Source File

Keyboard Shortcuts On an element press Ctrl+E or F12
To bring up the 'Open Source File' browser press Ctrl+Alt+O

Set a recording marker

Step Action

1 Open the source code to debug, in the integrated source code editor.
2 Find the appropriate code line and right-click in the left (Breakpoint) margin to bring up the
breakpoint/marker context menu; select the required marker type:
12 F‘a:ssengiers = GetRandom(@,288);
13 Humber = number;
A Y P T LY
@® AddBreakpoint
@ Add Start Recording Marker tation(Station);
@ ~dd End Recording Marker
& Add Stack Auto Capture Marker
& Add Method Auto Record Marker
& Add Tracepoint Marker
Help
)s
3 If a Start Recording Marker has been set, you must also set an End Recording Marker.
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Markers are really fantastic. Unusual by their very light footprint when used with care, their impact on the performance
of the programs being recorded can be negligible. Markers come in several flavors (well colors actually) and more are
always being added. They are placed and are visible in the left margin of the editor, so you will need to have some source

code.

Use to

e Record a single function

e Record parts of a function

e  Use Cases spanning multiple functions

e Record call stacks

e  Generate Sequence diagrams

e  Generate Test Domain diagrams

e  Generate Class Collaboration diagrams

Reference

Marker

Start / End Recording
markers

Method Auto Record

(c) Sparx Systems 2025

Detail

Place the markers at the start and end lines of the code to record. These need not be
within the same function.

o 17 private int m delivery:
12 public ClassLibi(){
20
21 71
22
23 FEE
24 *
25 # @Eexception Throwable
26 [ *
9 27 public vold finalize()

When the program encounters a start recording marker, a new recording is initiated
(the camera starts rolling!). When an end marker is encountered, the current
recording ends (it's a take). How you use these markers is up to you and your
knowledge of the system under your care.

Advanced Stuff (nested markers):

If a Start recording marker is encountered while a recording is in progress, but
where capture is inhibited by the Stack depth value in use, a separate recording will
be initiated. Each recording is kept on a stack. When one ends, it is removed. This
technique can be used in Enterprise Architect to record and render scenes in very
complex systems. It resembles splicing short scenes from a video to create a trailer.
If you only want to record a single function, you should use an Auto record marker.

A Method Auto Record marker enables you to record a particular function. The
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Stack Auto-Capture marker

Limiting the recording
depth
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debugger will automatically end the recording when the function completes. This is
good because recording is an intensive operation.

The function marker combines a Start Recording marker and an End Recording
marker in one, so recording is executed after the marker point, and always stops

when this function exits

=K1

O owom

UINT nMask =

Z
4
3
8

CBCGPDateTimeCrrl:
CBCGPDateTimeCtrl:
CBCGPDateTimeCtrl:
CBCGPDateTimeCrrl:
CBCGPDateTimeCtrl:
CBCGPDateTimeCtrl:

BCCOL CRecurrenceDlg::CnInitDialog()

CBCGPDialog: :OnInitDialog():

:DTM SPIN |
:DTM DATE |
:DTM TIME |
:DTM CHECKBOX |
:DTM DROPCALENDRE |
:DTHM CHECEED:

UINT nFlags = CBCGPDateTimeCtrl::DTM CHECKED | CBCGPDateTimeCtrl::DI

Recording markers can be nested. When a new Method Auto Record marker is hit
while recording, the stack depth to record to will be extended to include the current
method and the required depth from that function.

76 f*

& T

=]

wom -

for Part=s and Ports #*/
in - EA generated code for Activities and In
¢ vold ClassLib ActivityGraphWithfictionPin()

Stack markers enable you to capture any unique stack traces that occur at a point in
an application; they provide a quick and useful picture of where a point in an

application is being called from.

To insert a marker at the required point in code, right-click on the line and select
the 'Add Stack Auto Capture Marker' option.

Each time the debugger encounters the marker it performs a stack trace; if the stack
trace is not in the recording history, it is copied, and the application continues

running.

You can limit the depth of frames in any recording using the stack depth control on
either the recorder and breakpoints toolbars.
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The Breakpoints and Markers Window

Using the Breakpoints & Markers window, you can apply control to Visual Execution Analysis when recording
execution to generate Sequence diagrams; for example, you can:

e Enable, disable and delete markers
e  Manage markers as sets

e Organize how markers are displayed, either in list view or grouped by file or Class

Access

Ribbon Execute > Windows > Breakpoints
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Working with Marker Sets

Marker sets enable you to create markers as a named group, which you can reapply to a code file for specific purposes.

You can perform certain operations from the Breakpoints & Markers window alone, but to understand and use markers
and marker sets you should also display the appropriate code file in the 'Source Code Viewer' (click on the Class element
and press F12).

Access

Ribbon 3

Execute > Windows > Breakpoints : —  toolbar icon

Using Marker Sets

Action Details

Example of Use You might create a set of Method Auto Record markers to record the action of
various functions in the code, and a set of Stack Capture markers to record the
sequence of calls that cause those functions to be called.

You could then create Sequence diagrams from the recordings under each set.

Create a Marker Set To create a marker set from the Breakpoints & Markers window, click on the
I_] -

drop-down arrow on the icon and select the 'New Set' option.

The 'New Breakpoint Marker Set' dialog displays; in the 'Enter New Set Name'
field, type a name for the set, and click on the Save button.

The set name displays in the text field to the left of the 'Set Options' icon.

Alternatively, you can select the 'Save as Set' option from the 'Set Options'
drop-down to make an exact copy of the currently-selected set, which you can then
edit.

Accessing Sets To access a marker set, click on the drop-down arrow on the text field to the left of
the 'Set Options' icon, and select the required set from the list.

The markers in the set are listed in the Breakpoints & Markers window.

You would normally load a marker set prior to the point at which an action is to be
captured.

For example, to record a sequence involving a particular dialog, when you begin
debugging you would load the set prior to invoking the dialog; once you bring up
the dialog in the application, the operations you have marked are recorded.

Add Markers to Set To add markers to a marker set, add each required marker to the appropriate line of
code in the 'Source Code Viewer'.

The marker is immediately added to whichever set is currently listed in the
Breakpoints & Markers window.

Each marker listed on the dialog has a checkbox in the 'Enabled' column;
newly-added markers are automatically enabled, but you can disable and re-enable
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the markers quickly as you check the code.

Storage of Sets When you create a marker set it is immediately saved within the model; any user
using the model has access to that set.

However, the Default set, which always exists for a model, is a personal workspace,
is not shared and is stored external to the model.

Delete a Marker from a Set Right-click on the marker and select the 'Delete Breakpoint' option.

Delete a Set If you no longer require a marker set, access it on the Breakpoints & Markers
window and select the 'Delete Selected Set' option from the 'Set Options'
drop-down list.

You can also clear all user-defined marker sets by selecting the 'Delete all sets'
option; a prompt displays to confirm the deletion.

Notes

e Marker Sets are very simple and flexible but, as they are available for use by any user of the model, they can be
easily corrupted; consider these guidelines:

- When naming a set, use your initials in the name and try to indicate its use, so that other model
users can recognize its owner and purpose

- When using a set other than Default, avoid excessive experimentation so that you don't add
lots of ad-hoc markers to the set

- Make sure you are aware of which marker set is exposed in the Breakpoints & Markers window
as you can easily inadvertently add markers to the set that are not relevant to the code file the
set was created for

- In any set, if you have added markers that don't have to be kept, delete them to maintain the
purpose of the set; this is especially true of the Default set, which can quickly accumulate
redundant ad-hoc markers
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Control the Recording Session

The Record & Analyze window enables you to control a recording session. The control has a toolbar, and a history
window that displays the recording history as it is captured. Each entry in this window represents a call sequence made
up of one or more function calls.

Access
Open the Record & Analyze window using one of the methods outlined here.
You must also open the Execution Analyzer window ('Execute > Analyzer | Analyzer Scripts'), which lists all the scripts

in the model; you must select and activate the appropriate script for the recording.

Ribbon Execute > Tools > Recorder > Open Recorder
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Recorder Toolbar

You can access facilities for starting, stopping and moderating an execution analysis recording session through the
Record & Analyze toolbar.

Access
Ribbon Execute > Tools > Recorder > Open Recorder
Explore > Portals > Show Toolbar > Record
Buttons
Button Description

] - Display a menu of options for defining what the recording session operates on.

e  Attach to Process - enabled even if no Analyzer Script exists, this option
displays a dialog through which you select a process to record and a debugging
platform to use; you can also optionally select a record marker set and/or a
StateMachine to use during the recording

e  Generate Sequence Diagram from Recording - generate a Sequence/State
diagram from the Execution Analyzer trace

e  Generate Testpoint Diagram from History - generate a Test Domain diagram
from the Execution Analyzer trace, that can be used with the Testpoint facility

e  Generate Class Diagram from History - generate a Collaboration Class diagram
from the Execution Analyzer trace, depicting only those Classes and operations
involved in the recorded action (Use Case)

e  Generate Call Graph from History - generate a dynamic Call Graph from the
recording history, as you might see in the VEA Profile workspace execution
analysis layout; this can be more useful than the Sequence diagram in
identifying the unique call stacks involved

e  Generate All - generate the Sequence, Testpoint and Collaboration Class
diagrams together from the Execution Analyzer trace

e Save as Artifact - create an Artifact element that contains the current recording
history, under the currently-selected Package in the Browser window; if you
subsequently drag this Artifact element onto a Class diagram and double-click
on it, the history recorded in the Artifact is copied back into the Record &
Analyze window

e Load Sequence History from file - select an XML file from which to restore a
previously-saved recording history

e Save Sequence History to file - save the recording history to an XML file

7 - Select the recording stack depth for the marker set; that is, the number of frames
from the point at which recording began.

I Launch and record the application described in the script; you can optionally select
a record marker set and/or a StateMachine to use during the recording.

(c) Sparx Systems 2025 Page 160 of 253 Created with Enterprise Architect



Visual Execution Analysis 2 September, 2025

The icon is enabled when the active Analyzer Script is configured for debugging.

| Perform ad-hoc manual recording of the current thread during a debug session.

—p
Use this function with the 'step' buttons of the debugger; each function that is called
due to a step command is logged to the history window.
The icon is enabled if no recording is taking place and you are currently at a
breakpoint (that is, debugging).

] Perform ad-hoc auto-recording during a debug session.
When you click on this icon, the Analyzer begins recording and does not stop until
either the program ends, you stop the debugger or you click on the Stop icon.
This icon is enabled if no recording is taking place and you are currently at a
breakpoint (that is, debugging).

7 Step into a function, record the function call in the History window, and step back
out.
Enabled for manual recording only.

Stop recording the execution trace.

3 Display the 'Synchronize Model' dialog through which you can synchronize the

model with the code files generated during a Record Profile operation.
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Working With Recording History

You can perform a number of operations on or from the results of a recording session, using the Record & Analyze
window context menu.

Options
Option Action

Show Source for Caller Display the source code, in the Source Code Viewer, for the method calling the
sequence.

Show Source for Callee Display the source code, in the Source Code Viewer, for the method being called by
the sequence.

Generate Diagram for Generate a Sequence diagram for a single sequence selected in the recording

Selected Sequence history.

Generate Sequence Generate a Sequence diagram including all sequences in the recording history.

Diagram

Clear Clear the recording history currently displayed in the Record & Analyze window.

Save Recording History to Save the recording history to an XML file.

File A browser window displays, on which you specify the file path and name for the
XML file.

Load Recording History Load a previously saved recording history from an XML file.

From File A browser window displays, on which you specify the file path and name for the
XML file to load.

Disable All Calls Disable every call listed in the Record & Analyze window.

Disable This Call Disable the selected call.

Disable This Method Disable the selected method.

Disable This Class Disable the selected Class.

Disable All Calls Outside Disable every call listed in the Record & Analyze window except for the selected

This Call call.

Enable All Calls Enable every call listed in the Record & Analyze window.

Enable This Call Enable the selected call.

Enable This Method Enable the selected method.

Enable This Class Enable the selected Class.
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Help Display the Help topic for the Record & Analyze window.
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When you are recording execution flow as a Sequence diagram, you start the recording by selecting the 'Recording' icon
on the Record & Analyze window toolbar. The 'Record' dialog displays with the recording options set to the defaults;
that is, the current Breakpoint and Markers Set, the filters defined in the current Analyzer Script and the recording mode

as basic.

Access

Ribbon

Record Dialog Options

Field/Button

Recording Set

Additional Filters

Basic Recording Mode

Track Instances of Named
Classes

Track State Transitions

OK

(c) Sparx Systems 2025

Execute > Tools > Recorder > Open Recorder :

Detail

Recording markers determine what is recorded.

If you have a recording set to use, click on the drop-down arrow and select it.

Filters are used by the debugger to exclude matching function calls from the
recording history. Recording filters are defined in the Analyzer Script.

In the 'Additional Filters' field you can add other filters for this specific run. if you
specify more than one filter, separate them with a semi-colon.

In basic mode the debugger records a history of the function calls made by the
program whenever it encounters an appropriate recording marker.

In Track Instances mode the debugger also captures the creation of instances of the
Classes you specify. It then includes that information in the history. The resulting
Sequence diagram can then show lifelines for each instance of that Class with,
where appropriate, function calls linked to the lifeline.

The recording can also capture changes in State using a specified StateMachine
diagram. The StateMachine diagram must exist as a child of a Class.
The Execution Analyzer captures instances of that Class and calculates the State of

each instance whenever a function in the current recording sequence returns.

Click on this button to start the debugger.
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Step Through Function Calls

The 'Step Through' command can be executed by clicking on the Step Through button on the Record & Analyze window
toolbar.

Alternatively, press Shift+F6 or select the 'Execute > Run > Step In' ribbon option.

The 'Step Through' command causes a 'Step Into' command to be executed; if any function is detected, then that function
call is recorded in the History window.

The Debugger then steps out, and the process can be repeated.

This button enables you to record a call without having to actually step into a function; the button is only enabled when
at a breakpoint and in manual recording mode.
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Nested Recording Markers

When a recording marker is first encountered, recording starts at the current stack frame and continues until the frame
pops, recording additional frames up to the depth defined on the Recording toolbar. Consider this call sequence:

A>B>C>D->E>F>G->H->]>]J]>K->L>M->N->0->P>Q->R->S>T>U->V->W->X
>Y>7Z

If you set a recording marker at K and set the recording depth to 3, this would record the call sequence:
K->L->M

If you also wanted to record the calls X, Y and Z as part of the Sequence diagram, you would place another recording
marker at X and the analyzer would record:

K>L>M->X->Y->Z

However, when recording ends for the X-Y-Z component (frame X is popped), recording will resume when frame M of
the K-L-M sequence is re-entered. Using this technique can help where information from the recorded diagram would be
excluded due to the stack depth, and it lets you focus on the particular areas to be captured.
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Generating Sequence Diagrams

This topic describes what you might do with the recording of an execution analysis session.

Access

Ribbon

Reference

Action

Generate a diagram

Save a recorded sequence
to an XML file

Access an existing
sequence XML file

Use to

Execute > Tools > Recorder > Open Recorder

Detail

Select the appropriate Package in the Browser window, in which to store the
Sequence diagram.

To create the diagram from all recorded sequences, either:

e  Click on the 'Recorder Menu' icon ( B ) in the Record & Analyze window
toolbar, and select the 'Generate Sequence Diagram from Recording' option, or

e Right-click on the body of the window and select the 'Generate Sequence
Diagram' option

To create the diagram from a single sequence, either:

e  C(lick on the 'Recorder Menu' icon ( B ) in the Record & Analyze window
toolbar, and select the 'Generate Sequence Diagram from Recording' option, or

e Right-click on the sequence and select the 'Generate Diagram from Selected
Sequence' option

Click on the sequence, click on the 'Recorder Menu' icon ( e ) in the Record &
Analyze window toolbar, and select the 'Save Sequence History to File' option.

Either:

e  (Click on the R in the Record & Analyze window toolbar, and select the
'Load Sequence History from File' option, or

e Right-click on a blank area of the screen and click on the 'Load Sequence From
File' option

The 'Windows Open' dialog displays, from which you select the file to open.

e Generate a Sequence diagram from a recorded execution analysis session, for:

e all recorded sequences or
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e asingle sequence in the session
e Save the recorded sequence to file

e Retrieve the saved recording and load it into the Record & Analyze window
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Reporting State Transitions

This section describes how you can generate Sequence diagrams that show transitions in state as a program executes.

Use to

Generate Sequence diagrams that report user-defined transitions in state as a program executes (as shown in the example
generated diagram)

Topic

Create a StateMachine under the Class to be reported.

Set the constraints against each State to define the change in state to be reported.
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Reporting a StateMachine

The Execution Analyzer can record a Sequence diagram, we know that. What you might not know is that it can use a
StateMachine at the same time to detect State transitions that might occur along the way. These States are represented at
the point in time on the lifeline of the object. The transitions also are apparent from the lifelines. Any invalid or illegal
transition will be highlighted with a red border. Have a look.

Process

Firstly you model a StateMachine for the appropriate Class element.
You then compose the expressions that define each State using the 'Constraints' tab of each State.

These simple expressions are formed using attribute names from Class model and actual code base. They are not OCL
statements. Each expression should appear on a separate line.

m_strColor == "Blue"
You then use the Recorder window to launch the debugger.
The Recorder window Run button is different from the button on other debugger toolbars.

The Recorder window will allow you to browse for a StateMachine if you do not know the StateMachine name. The
'State Transition' dialog presents a list of StateMachines for the entire model, in which you locate and select the
appropriate diagram (see the example).

When you generate the Sequence diagram, it depicts not only the sequence but changes in State at the various points in
the sequence; each Class instance participating in the detection process is displayed with its own lifeline.

Example

The Stations StateMachine shows the different States within the Melbourne Underground Loop subway system.
A train traveling on the subway network can be stopped at any of the stations represented on the StateMachine.

The Stations StateMachine is a child of the CTrain Class.

L3 4 B crrain

=% Create()

=¥ ~(Train()

=% CTrain(CNetwork*, TTrainID, int, CStation*)
% Disembark(int)

&% Embark(int)

B9 Execute(CTrain®)

=W Exit()

=% GetRandomint, int)

Parliament ™\ 4 Treasury
\ ( \

constraints = constraints
{Location=0} {Location=0}
[Departing.Name=Parliament} | [Departing.Name=Treasury}

=¥ InStation()

% OnArrival(CStation*)
F% Runp

=% Start{)

=9 Stop()

Central

Flinders

Stations

constraints
{Location=0}
{Departing.Name=Central}

[Departing Name=Flinders] < Central

—— O Flinders
© Lonsdale
& Parliament

Lonsdale ™ 4 Spencer

O spencer
< Treasury
I B Tobject
B «typedefs TstationD
B «typedefs TTrainip
Bl TobjectType
1 Rl 2 T b

[Departing Name=Lonsdale] {Departing Name=Spencer]

When you browse for the diagram in the 'State Transition Recorder' dialog, the hierarchy shows only the root Package,
parent Class and child SubMachine and diagram; no other model components are listed.
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P

5 | State Transition Recorder 3|

[[] C++.Software.Implementation Model. Systems Engine «
= 10
- @ SearchExternalMedia
b %g SearchExternalMedia
[ Java.Software. Implementation Model, Systems Engine
= 10
- @ SearchExternalMedia
b %g SearchExternalMedia
D VBMet. Software. Implementation Model. Systems Engir
= 10
- @ SearchExternalMedia
b %g SearchExternalMedia
[ Source.C++Mative,Execution Analysis

EI CTrain =
- @ Stations
-3 E =
< | Il | b

Record state transitions for Stations

[ sekct |[ concel |[ Hep |
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Recording and Mapping State Changes

This topic discusses how to set constraints against each State in the StateMachine under a Class, to define the change in
state to be recorded.

Example

This example of a State 'Properties' dialog is for the State called Parliament; the 'Constraints' tab is open to show how the
State is linked to the Class CXTrain.

A State can be defined by a single constraint or by many; in the example, the Parliament State has two constraints:

Defined Constraints Sav

11}
Il
I
m
i

Constraint Type Status
Location=0 Imvariant Approved
Departing. Mame=Padiament Invarart Approved

The values of constraints can only be compared for elemental, enum and string types

The CXTrain Class has a member called Location of type int, and a member called Departing.Name of type CString;
what this constraint means is that this State is evaluated to True when:

e an instance of the CXTrain Class exists and
e its member variable Location has the value 0 and

e the member variable Departing.Name has the value Parliament

Operators in Constraints

There are two types of operator you can use on constraints to define a State:
e Logical operators AND and OR can be used to combine constraints
e  Equivalence operators {= and !=} can be used to define the conditions of a constraint

All the constraints for a State are subject to an AND operation unless otherwise specified; you can use the OR operation
on them instead, so you could rewrite the constraints in the example as:

Location=0 OR
Location=1 AND
Departing.Name!=Central
Here are some examples of using the equivalence operators:
Departing.Name!=Central AND

Location!=1

Notes

®  Quotes around strings are optional; the comparison for strings is always case-sensitive in determining the truth of a
constraint
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State Analyzer

The State Analyzer is a feature that can analyze, detect and record states for instances of a Class. The feature works by
combining a state definition (defined on a Class as a constraint) and markers called State points. It is available for any
languages supported by the Execution Analyzer, including Microsoft. NET, Mono, Java and native C++.

We begin by selecting a Class and composing our state definition.

Responsibilities v o X
B X

Overview Requirements Scenarios Constraints

Constraint:
StateDefinition.Location

-
Property
Type Invariant -
Status Approved

B /7 U&- =i %@ [

statedef
{
Location=0;
Departing.Mame;
1
name=Departing. Mame;
default=Maving;

We can get a picture of all the state definitions we've defined by placing the Class on a diagram and linking to the Class
notes that themselves link to a particular state definition constraint. We explain how to do that in a later section.
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Tobjact
+
+
+
+
+
+
+
+
e T o
- 1 -

Y [ [N
alinwvariants alinwvariants ainvariants
{stateDiefinition dle : statedef IstateDefintion. Busy : statedef {stateDefinition Location : statedef
1 1 {

Location=(; Passengers »100; Location-0;
} } De=parting Hame;
namie="idke"; namie="Busy’; }
default="active’;} default="Couiet’; name=Departing Hame;
default=rioving;
1
I
1
b

State points are set by placing one or more markers in relevant source code.

72 DWOERD CTraln::0OnArrival| C3tation* 3)

_.'4{
75 Departing = 5;
76 Location = 0;
5] 77 Delay = (Disembark(GetRandom()) + Embkark(GestRandem()));
78 DWOED ScheduleTime = Network->TimeAtStation(Departing);
79 if(Delay > (int)ScheduleTims)
a0 return Delay;
21 return ScheduleTime;
52 )

The program to be analyzed is run using the State Analyzer control. When the Execution Analyzer encounters any State
point, the current instance of the Class is analyzed. Where the value domain of the instance matches the state definition,
a state is recorded. Each time the instance varies, new states are thus detected. The control lists each state as it is

discovered. Under each state the control lists the discrete set of transitions to other states made by instances of the class.
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Record & Analyze

Sequence Recorder State Analyzer

CTrain

States
@ Moving
@D Lonsdale

g
O Flinders

O Spencer

~

O Central

~

D Parliament

~

@ Treasury

Vd
4

Record & Analyze System Output

The information can be used to create a StateMachine.

Location

Transitions

Central O
Spencer O
Lonsdale ©
Parliament O
Treasury &

Flinders &

> @ CityLoop Stations. StateMachine Diagram

2 September, 2025

stm Cityloop Stations

Using the same information we can easily produce a Heat Map. This example shows a 'Train' Class, its 'Bulletin' State
Definition (as a linked note), and the Heat Map it produced. The Figures in the map are percentages. From the map we

can observe that trains were in the 'In Transit' state 46% of the time.
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[
ainvariants
= {statenefinition Suletin - statedef Bulletin

Distance < 0.0

Source-CTrain 1

o IR W BCTE

stateded |
Distance < 2.0
1
name-'Boanding’;
statedet |
Distance < 3.0
; Arriving
name=Approaching:
Distance < 8.3
1
nameATiving;
statedet | Approaching
Distance = 8.5
1 —
name-in Transit;

This is the analysis for the 'Bulletin' State Definition that produced our Heat Map.

Record & Analyze O X
Sequence Recorder 5State Analyzer
Bulletin H @
States Transitions Count
2 In Transit 161
iy Arriving & 1
iy Approaching OO 1
O Approaching 26
& Boarding & 2
O Arriving 32
e In Transit & 2
O Boarding 40
d Bad @ 2
2 Bad 86
1 »
Access
Ribbon Execute > Tools > Recorder > Open Recorder > State Analyzer

Design > Element > Editors > Constraints

State Definitions

State Definitions are composed in the Constraints properties of a Class element. The constraint type should be named
StateDefinition.name, where 'name' is your choice of title for the definition. These titles are listed in the combo box of
the State Analyzer whenever a Class is selected. You select a single definition from this combo box prior to running the
program. The State Definition in our example is named 'StateDefinition.Location'. It defines states based on the location
of instances of the CTrain Class.

State Definitions are composed of one or more specifications. Each state specification begins with the keyword 'statedef’
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which is then followed by one or more statements. Statements define the constraints that describe the state, and
optionally a variable whose value can be used to name the state. Statements are enclosed in curly brackets and are
terminated with a semi colon as shown:

statedef {
Location=0;
Departing.Name;
H

Naming states using variables

In this example, 'Location' is a constant and 'Departing.name' is a variable. An additional statement follows the
constraints and instructs the name of the State to be assigned from the variable value. Here is the definition with the
naming directive.

statedef {
Location=0;
Departing.Name;
H

name=Departing.Name;

Naming states using literals

In this example the State Definition only contains constants and the state is named using a literal.

statedef {
Location=100;

}

name='Central';

A single State Definition defining multiple State specifications.

statedef {
Passengers > 100;

H

name=Busy;

statedef {
Passengers >= 50;

H

name=Quiet;

statedef {
Passengers < 50;

H

name=Very Quiet;

statedef {

Passengers = 0;
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H

name=Idle;

Default State

A State definition can specify a default 'catch all' state that will describe the state of an instance when no other state holds
true. You define a default state for the definition with a statement resembling this:

statedef {
Location=0;
Departing.Name;
H

name=Departing.Name;

default=Moving;

In this example, while execution is in progress any instance detected having a non-zero 'Location' attribute will be
recorded as being in the 'Moving' state.

You can choose to exclude the recording of the default state by disabling the 'Include default state' option on the drop
down menu of the State Analyzer toolbar. This would exclude transitions to any 'default' state being recorded.

Creating Notes on a Class element that display State Definitions

This section describes how to create the Class diagram that shows all the State Definitions defined for the Class.

Actions
Display a Class diagram Open an existing Class diagram or create a new one.
Create a link to the Class Drag the Class of interest on to the diagram as a link.
element
Create a note element Create a note element on the diagram and link it to the class.
Link the note to the State Select the link between the Note and the Class and, using its context menu, select
Definition the 'Link Note to Element Feature' option.
Choose the definition to From the element dialog, choose 'Constraints' from the drop combo. Any defined
display on the Note State Definitions will be listed for you to choose from.
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Target CTrain
Feature Type:  Constraint -
Feature: Feature Descriptior
StateDefinition.Idle Invariant
StateDefinition Location Invariant
StateDefintion.Busy Invariant
4 »
oK ‘ ‘ Cancel H Help
Repeat Repeat the procedure for any other State Definitions on the class.
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Synchronization

The recording produces a number of assets, the recording history being the main one. Recording also identifies a set of
source code files. This set can be used to produce Class and Test Domain diagrams, but can also be used to synchronize
your model.

A synchronized model provides quick and accurate navigation between diagram elements and the Class model.

Access
Ribbon =
Execute > Tools > Recorder > Open Recorder > Toolbar ﬂ% button
Context Menu Right-click on the Record & Analyze window | Synchronize Model with Source
Code

Synchronize Model

r ™
oo e

Synchronize Package from selected source code files below:

Package; |Source o Select

Files Action
2

chea‘weamicrosoft net‘delegates‘delegates 1"bookstore.cs Synch

1|

Select Al | Selectbone:|

Field/Button Action

Package Click on the Select button and select the target Package into which to
reverse-engineer the code files.

Files/Action Lists the files identified during one or more recording(s). The appropriate action is
listed next to each file.

Select All Click on this button to select the checkbox against every file in the 'Files' list.
Select None Click on this button to clear the checkbox against every file in the 'Files' list.
OK Click on this button to start the operation. The progress of the synchronization will
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be displayed.

Cancel Click on this button to abort synchronization and close the dialog.
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Visualize Run State

You can record the state transitions of a single object by taking multiple snapshots of the object's run state at key points
in its lifetime. To do this simply drag the local or member variable on to an Object diagram.
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Object Workbench

The Object Workbench is an Enterprise Architect debugging tool that helps you create objects from your Class model.
The Workbench allows multiple instances of any Class to coexist in the same session. Each Object can serve as the target
of a method you want to invoke. They can also participate as parameters in methods you invoke. The Object Workbench
is supported for the Java and Microsoft .NET platforms.

Workbench Tasks

Task

Provides a guide and the requirements for using the Object Workbench.

Explains what Workbench objects are, and how to create them.

Explains how to execute methods on a Workbench Object and provides information on passing arguments.
Explains stepping through a method's execution using the Debugger.

Explains how to record a method and produce a Sequence diagram.

Explains how to delete a Workbench Object once you are finished with it.

Explains how to shut down the Debugger and close the Workbench once you have finished with it.
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Using the Workbench

Using the Object Workbench is straightforward. From your Class model, select the Classes to workbench and drag them
individually on to the Workbench window. You might have to choose a constructor if more than one exists, then simply
give the variable a name. The Object workbench prepares the required runtime, loads any required modules and
instantiates the objects for you. Executing a method is a matter of selecting from a list. Parameters can be entered where
required. Workbench objects themselves can be used as parameters either singly or as object arrays.

Access

Ribbon Execute > Tools > Tester > Open Object Workbench

Analyzer Script Requirements

An Analyzer Script that has been configured for debugging is required. It should specify this information:
e  The debugger to match your project
e  For Microsoft .NET, the location of the assembly that will be hosted by the Object Workbench

e For Java, the location of the JDK and additional class paths to use

Checklist

e Select the intended Workbench Class and press F12; the source code should be displayed in a code editor
e Press Shift+F12 to build the project; the output from the build should show successful compilation
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Creating Objects

This topic explains how to create a workbench instance for a Class from your model.

Access
Ribbon Execute > Tools > Tester > Open Object Workbench
Keyboard Shorcuts Ctrl+Shift+J
Other Drag a Class directly from the Browser window onto the Workbench window
Tasks
Task Detail
Creating an Object on the Select the Class in the Browser window and drag it on to the Workbench window.
Workbench The 'Workbench' dialog displays.
MName
Value
MyClassLibrary. CPerson
Create | [ Help ” Cancel
Type in a name for the new instance. The name should be unique for the
Workbench.
Click on the Create button.
Choosing a Constructor The 'Constructor' dialog is displayed where a choice of constructor exists.
Employee(MyClassLibrary: CPerson) b4
[
i
CPerson{CPerson)
CPerson(String, String,int)
Select the constructor from the drop-down list.
Enter Parameters Provide values for the selected constructor's parameters:
e  Strings as arguments - Surround values with quotes where appropriate, or
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where the value would conflict with the name of a Workbench object
e  Objects as arguments - Enter the name of the Workbench object

e  String array arguments take text values separated by commas:

one,two,three,"a book","a bigger book"

e  Object arrays as arguments take object names separated by commas; supply the
named Workbench objects separated by commas, for example:

Tom,Dick,Harry

Invoke Constructor Click on the Invoke button to create the instance. The object can be recognized by
its name in the Workbench window.
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Invoking Methods

Access

On the Workbench window, right-click on the instance on which to execute a method, and select 'Invoke'.

Ribbon Execute > Tools > Tester > Open Object Workbench
Actions
Action Details
Choose Method Select a method from the list and click on the Invoke button.

Note that all methods listed are public; private methods are not available.

Rob{MyClassLibrary:Person) x
nt AddFriends{MyClassLibrary.Person] -

int AddFriends(MyClassLibrary.Person]

Person Find(string)

int FriendCount()

bool IsFriend({string)
void main(string[])
string Name()

string Occupation()
void Run(string[])

int SetAge(int)

String Sethame(string)
String SetTown(string)
bool Test{string)

Provide Arguments In this image, the method to be invoked takes an array of objects as its only
argument. You construct this argument by naming the other instances on your
Workbench that you want to pass to the method.

Waorkbench

Variable Value Type
$ John MyClassLibrary.CPerson
§ Robert MyClassLibrary.CPerson
MyClassLibrary.CPerson
% mnt 0 Sheila(MyClassLibrary:: CPerson)
Float 1234
g E:D::Zble 1734 int AddFriénds{MyCIassLibrary.CPersun[I}
& AverageAge o.00l MyClassLibrary. CPerson(] John,Robert
& FriendCount 0
& Age 0
& Friends
Argument Types These are the parameter types supported by the Workbench:
e  Strings
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Argument Syntax

Invoke

(c) Sparx Systems 2025

e  Numbers
e Objects

2 September, 2025

e  String Arrays

e  Object Arrays

e  Strings as arguments - Surround strings with quotes where necessary; for
example, to avoid conflict with Workbench object names

e  String Arrays as arguments - Enter the elements that compose the array,
separated by commas; for example:

"A maths book","A geography book","A computer book"

e Objects as arguments - Type the Workbench object name as the argument; the
debugger checks any name entered in an argument against its list of
Workbench instances, and will substitute that instance in the actual call to the

method

e Object Arrays as arguments - Enter the Workbench objects' names to satisfy
the argument, separated by commas:

Tom,John,Peter

Click on the Invoke button to execute the method.

Output confirming this action is displayed in the Debug window.

@
[437449575]
[437449717]
[437449719]
[437449720]
[437449720]
[437449720]
[437449720]
[437449720]
[437449721]
[437460456]
[437460478]

EE Loy Il; ¥ ] H (@l

Stack recording threshold set to 7 frames

created new instance counter of Counter

Default Directory is Ch\Object Workbench\Microsoft MET\Utilities

Default Directory is C:\Object Workbench\Microsoft MET\Utilities

ChProgram Files (x86)\Sparx Systemsh\EA\wea b\ 55Workbenchbd.exe targets N
Process created \Device\HarddiskVelurme2iProgram Files (x86)\5pan: SystemshE£
Debug process in demain DefaultDomain

Debug process in demain DefaultDomain

Debug Session Started

Invoking method NumberQfDigits on instance counter of type Counter
MurmberQfDigits returned 3
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Setting Properties

For languages that support properties, we can set the value of an Object's property in the same manner in which we
invoke a method. Select the instance in the Workbench, and use its context menu to select the 'Invoke' option. You will
find the properties exposed by the Class listed alphabetically, along with its methods. You will be prompted to provide
the new value of the property. Type the value as you would have entered it for the parameter in a method call. This
image demonstrates changing the Occupation property of a Person called Bertie; Bertie being a type of Person.

Waorkbench

Variable Walue Tune

¢ Rob Bertie(MyClassLibrary:Flumber) =
[ string Occupation() =

string Schoolteacher
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Debugging and the Workbench

While you are working in the Workbench, you might want to debug one or more methods you are developing or
investigating. This can easily be accomplished. The same features of Enterprise Architect's Execution Analyzer are
available to users of the Object Workbench. Debugging can be performed during object construction and destruction as
well as during the execution of a method. To gain access to the debugger, simply place a breakpoint at the points at
which to step through the code. You could also set the condition on these breakpoints to only break under certain
conditions.

28 // The NumberOfDigits static method calculates the number of o
21 public int NumberOfDigits(string theString)
22 {
23 int count = @;
24 for { int i = 85 1 < theString.Length; i++ )
25 f
2B if ( Char.IsDigit(theString[i]) )
27 {
t.‘» 28 count++;
29 }
38 }
31 m_nResult = count;
32 return m_nResult;
33 }
34 }
35}

When debugging, the states of objects are inspected using the debugger controls. Here we use the Locals window to
examine the state of our object while execution is halted.

LI:I d I K% o EeR e o o e o B B B e o B S B b o BB e o B e B e e BB e P B BB P o B e P R B PR e BB e kRS
Variable Value Type
B § this Utilities.Counter
@ m_nResult 3 int
s theString "123" String

$ i 0 int

& C55150000 0 int

g 0 Boolean

o

When the program resumes, the Object on the Workbench will reflect any changes in state.
TR G958055000500050005090500050900090009000050 00500000 00000000000000500050005

Variable Value Type

counter Litilities. Counter

@ m_nResult g int
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Recording and the Workbench

While you are working in the Workbench, you might want to produce a Sequence diagram for one or more methods you
are developing or investigating. This can easily be accomplished. The same features of Enterprise Architect's Execution
Analyzer are available in the Object Workbench. You might even begin a Workbench session by recording a Sequence
diagram first off, as a means of visualizing what you plan to work on.

Set the Recording Marker

154
135 public beool Test(string name)
136 {

@ 137 Person px = Find(name};
138 if(px !'= null)
139 {
148 return true;
141 }
142 return IsFriend(name};
143 }

Invoke the Method

Waorkbench

Variable Value Type
§ John My{ClassLibrary.CPerson
§ FRobert MyClassLibrary.CPerson
My ClassLibrary.CPerson
¢ mInt 0 sheila(MyClassLibrary::CPerson)
2 E:Blzztlle Ei int AddFriends{MyClassLibrary.CPerson[])
& Averagefge 0.00 MyClassLibrary.CPersaon(] John,Robert
@ FriendCount i
& Age 0
& Friends

View the Recording History

Record & Analyze

(=~ b GG Ea

Sequence Instance Method Direction Method

- 0ooooDo System.Reflection. RurtimeMethodIn...  Call MyClassLibrary. Person. Test
0oooDoo2 MyClassLibrary. Person. Test Call MyClassLibrary. Person.Find
00000003 MyClassLibrary.Person. Test Call MyClassLibrary. Person.Find
00000004 Retum MyClassLibrary . Person. Test
00000005 MyClassLibrary.Person. Test Call MyClassLibrary . Person. IsFriend
00000006 Retum MyClassLibrary . Person. Test
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Generate the Sequence Diagram
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Deleting Objects

You can easily delete an object by selecting it in the Workbench, right-clicking on it and selecting the 'Delete' option.
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Closing the Workbench

To shut down the Workbench perform any of these actions:

e Choose 'Reset' from the Object Workbench context menu
e Press the Stop button on any debugger toolbar

e Delete all objects on the Workbench
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Profiling
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During the lifetime of software applications, it is not uncommon to investigate application tasks that are determined to be
performing slower than expected. You might also simply want to know what is going on when you 'press this button'!
You can work this out quite quickly in Enterprise Architect by using its Profiler. Results can usually be produced in a
few seconds and you will quickly be able to see the actions that are consuming the application and the functions
involved. In the Execution Analyzer, the feature employs two separate strategies; Process Sampling and Process
Hooking. In one, samples are taken at regular intervals to identify CPU-intensive patterns, while in the other, the process
is hooked to record demands made on memory. Data is analyzed to produce a weighted Call Graph. Behaviors are
usually identifiable as root nodes (entrypoints) in the graph, or branches near these points. All reports can be reviewed on
demand. They can be saved to file within the model, both as Artifact elements and as Model Library posts.

Access

Ribbon Execute > Tools > Profiler

Other Execution Analyzer toolbar : Analyzer Windows | Profiler
Call Sampling
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Profiler
R Call Graph . @
Fath: CWwindowshzpstern 32 dpelip exe
Target Interval [mz]: 5 :
Procezs Time [estimated): Frocess (D 1908
S ample Count; Fragments:
Entrypoints Zampled Processed Tirne

The Profiler is controlled using its toolbar buttons. Here you can attach the Profiler to an existing process (or JVM), or
launch the application for the active Analyzer Script. The Profiler window displays the details of the target process as it
is profiled. These details provide feedback, letting you see the number of samples taken. You also have options for
pausing and resuming capture, clearing captured data and generating reports. You can gain access to the reporting feature
by pausing the capture - the reporting feature is disabled whilst data capture is in progress.

Weighted Call Graph
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H.J-E|\.--V|,-'-? ;’||: B |.§|@

Call Stack Inclusive Hits  Hits
= xercesc_3_1uSAK2ZKMLReaderlmpl:parse 16051
= xercesc_3_luXMLScanner:scanDocument 16031
=1 wercesc_3_l1:1GXMLScanneriscanDocument 160351
= wercesc_3_l1:1GXMLScanner:scanContent 160351
= xercesc_3_1:IGXMLScanner:scanStartTaghs 160351
= xercesc_3_l1:1GXMLScanner:resolveSchemaGrammar 160351
= xercesc_3_l:uSchemaValidator:preContentValidation 16049
= xercesc_3_T:ComplexTypelnfoicheckUniqueParticleAttribution 16049
= xercesc_3_l1uComplexTypelnfoimakeContentModel 16049
= xercesc_3_1:DFAContentModel:DFAContentModel 16047
= xercesc_3 1:DFAContentModel:buildDFL 13998 515
= xercesc_3_1uCMStateSet:ioperator|= 2174 2093
memecpy 32 32
xercesc_3_TuCMStateSetiallocateChunk 27 1
__security_check_cockie 21 21
TraillpVec 1 1
wercesc_3_TuCMStateSet::~ CM5StateSet 3573 4
wercesc_3_lukMemoryioperator delete 24 2
xerces-c_3_10 4416 2
xercesc_3_1uCM5StateSet::getBit 1036 1036
xercesc_3_1uDFAContentModel:buildSyntaxTree 528 3
xercesc_3_1nCMStateSet:: CMStateSet 373 3
xercesc_3_1:CMStateSet:getBitCountlnRange 285 285

xercesc_3_luXMemony:operator new 21 2
xercesc_3_1uCMStateSet::zeroBits 154

xercesc_3_ 1uCMStateSetEnumerator:nextElement 133 136
xercesc_3_luRefHashTableOf<xercesc_3_1:XMLinteger,» 59 2
xercesc_3_1uRefHashTableOf <xercesc_3_Tu¥MLinteger,: 28 2
xercesc_3_luRefHashTableOf <xercesc_3_TuXMLinteger,: 23
xercesc_3_1uDFAContentModel:makeDefStatelist 25 2

[E2 I E3 I c e e R e

This detailed report shows the unique set of Call Stacks/behaviors as a weighted Call Graph. The weight of each branch
is depicted by a hit count, which is the total hits of that branch plus all branches from this point. By following the hit
trail, you can quickly identify the areas of code that occupied the program the most during the capture period.

Stack Profile
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@StartPagE W% Sampler Report >

Stack Profile Summary Report

Call Stack
' Stack Profile: E\Apache\xalan-builds\xerces-sre-31\Build\Win32\W Cdebuglsax2print. exe
4 @ xerces-C_3 1Dxercesc_3_1:RefHashTableOf<xercesc_3 1. XMLStringPool::PoolElem,xercesc_3 1::5tri
rl @ werces-¢_3 1Dxercesc 3 1:RefHashTableOf<xercesc_3 1:XMLStringPool::PoolElem,xercesc_3 1:
rl @ ¥erces-C_3 1Dxercesc 31 XMLStringPool: XMLStringPool
4 @ xerces-C_3 1Dxercesc_3 1:DOMDocumentImpl:DOMDocumentImpl
3 FEEI xerces-C_3 1Dxercesc_3_1:DOMImplementationImpl:createDocument
3 @ xerces-c_3 1Dxercesc_ 3 1:XMLGrammarPool Impl: XMLGrammarPool Impl
3 @ xerces-C_3 1Dxercesc_3 1:ElemStack:ElemStack
3 @ xerces-c_3 1Dxercesc_ 3 1:SAXZXMLReaderImpl:initialize
3 @ xerces-C_3 1Dxercesc_3 1-RangeTokenMap:RangeTokenMap

Stack Profiles are taken to discover the different ways (stacks) and the count of ways that a particular function is invoked
during the running of the program. Unlike the other profiler modes, this profile is activated through the use of a Profile
Point, which is a special kind of breakpoint marker. The marker is set in the source code like any other breakpoint. When
the breakpoint is encountered by the program, the stack is captured. When you later produce the report, the stacks are
analyzed and a weighted call graph produced. The graph shows the unique stacks that were involved in that function
during the time the profiler was running, The 'Hit Count' column indicates the count of times that same stack occurred.

106

107 template <class TVal, class THashers>

108 void RefHashTableOf<TVal, THaszher>::initialize(const XMLSize_t modulus)

109 {
@ 110 if (modulus == 0)
111 ThrowKMLwithMemMgr(IllegalArgqumentEzception, XEMLExzcepts::HshTbhl_ ZeroMo
112
113 /f RBllocate the bucket list and zero them
114 fBucketlList = (RefHashTableBucketElem<TVal>*#*) fMemoryManager—-=allocate
115 |
116 fHazhModulus * sizeof(RefHazhTableBucketElem<TVal>*)
117 V;:
118 for (EMLSize_t index = 0; indexz <« fHaszhModulus; indsz++)
119 fBucketlist[index] = 0;
120 }
121

Memory Profiles
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Profiler v b X
O~Db & Memory Profile v
Program: Using Analyzer Script ol

C:\Code Samples\VEA\Microsoft Native\CityLoop\debuc

Frames (4-64): 16 . N Elapsed 3.3 secs
Heap Virtual

Allocations: 4377 2

Frees: 0 0

Frees not 0 0

Stack holdings: 4375 2

Memory holdings 1 o
Module loaded:api-ms-win-core-datetime-11-1-1, base:7e3d0000 -

Module loaded:api-ms-win-core-localization-obsolete-11-2-0, base: 7e71
Build version: 3.6, status:0w0003, process heap:0x00110000

Auditor installed.

Module loaded:api-ms-win-appmodel-runtime-11-1-2, base: 7e6b0000
Target process ended.

Audit ended.

The Memory Profile tracks allocations, ignoring when memory is freed. It uses this information to rate the executing
code's demands for memory, in terms not of the amount of memory but of the frequency of demands. The Allocations
figure is the total number of memory allocations requested. The Stack Holdings is the number of stack traces taken at
those times, and the Heap Holding figure is the total amount of memory obtained by these calls. Note that profiling can
be turned on and off on demand. There is also no need to rebuild your program to get it to work as there is no linkage
involved.

Memory Graph
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» profile .

@Star‘t Page .+ *leaks | s, *profile x 4

Call Stack Instances Bytes

P E\Apache\xalan-builds\xerces-src-31\Build\Win32\WCH debughDOMPrint.exe Chtest\materials\portrait.ml 0 o

4 ntdll:RtlAllocateHeap 7,068 4,830,947
4 ntdIl:RtlphitSetValueKey 7,068 4,830,847
4 ntdll:RtIDestroyMemoryBlockLookaside 7,068 4,830,947
4 ntdll:RtlAllocateHeap 7,068 4,830,947
Pl ntdll 7,068 4,830,947
A msverdld:malloc_base 4,813 3,985,885
rl msver@id:malloc_dbg 4,813 3,985,885
4 msver®ld:malloc_dbg 4,813 3,085,285
4 msver3ld:malloc_dbg 4,813 3,985,885
Fl msverd0d:malloc 4,812 3,085,734
4 msverdd:operator new 4812 3,985,734
4 |21 xerces-c_3_1dixercesc_3_1:MemoryManagerimpl::allocate 4,807 3,985,526

» @ xerces-c_3_ldixercesc_3_1uRangeToken:expand 203 396,984
b [ xerces-c_3 1dixercesc 3 1:ValueHashTableOf<bool xercesc 3 1::StringHasher=:put 791 37,968
» @ xerces-c_3_ldxercesc_3_1uXMemory:operator new 753 239,048
b [ xerces-c_3_ldiercesc_3_1uXMemory:operator new 333 21,652
b [ xerces-c_3_1dixercesc_3_1:RangeToken:doCreateMap 291 19,788
» @ xerces-c_3_ldixercesc_3_1:RangeToken:addRange 287 28,700
b [ xerces-c_3 ldixercesc_3_1uXMLString:replicate 218 12,914
b [ xerces-c_3_1d:xercesc_3_1=RefHashTableOf <xercesc_3_1:RangeTokenElemMap,xercesc_3_1 146 7,008
b [ xerces-c_3_ldiercesc_3_1uRefHashTableOf <xercesc_3_1:CPMapEntry,xercesc_3_1:StringH: 144 6,912
b [ xerces-c_3_1dixercesc_3_1:Win32TransServicex Win32TransService 112 6,612
» @ xerces-c_3_Tdixercesc_3_1:Win32TransService:Win32TransService 106 6,258

This example is of a report produced from Profiling a demonstration program in the Xerces project from Apache. The
program iterates over the Document Object Model (DOM) for a provided XML file.

Function Summary Report

Mame Inclusive Hits
o o

profiler/Example.Run 156
profiler/Example.main 156
java/io/FileCutputStream.write 154
java/lio/Printstream.println 154
profiler/Example.Print 154
profiler/Example.MakeltalianCars 2
profiler/Example. NewCar 2

This summary report lists the functions and only those functions executed during the sample period. Functions are listed
by total invocations, with a function that presents twice in separate Call Stacks appearing before a function that appears
just the once.

Function Line Report

(c) Sparx Systems 2025 Page 200 of 253 Created with Enterprise Architect



Visual Execution Analysis

LineMo

54
55
56
57
58
59
&0
&1
R?

Hits

1408

1408

938

938000

Code
forfint n = 0; n < 10000; n++)
i
m_icars = new Collection=Car>[};
if([in % 3)>0)
i

forfinti =0 i< 1000 i=+)
i

MakeltalianCars();:
il

2 September, 2025

This detailed report shows the source code for a function line by line displaying beside it the total times each was
executed. We uncovered code using this report, that exposed case statements in code that never appeared to be executed.

Support

The Profiler is supported for programs written in C, C++, Visual Basic, Java and the Microsoft .NET languages. Memory
profiling is currently available for native C and C++ programs.

Notes

(c) Sparx Systems 2025

The Profiler is available in the Enterprise Architect Professional Edition and above
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The Profiler can also be used under WINE (Linux and Mac) for Profiling standard Windows applications deployed
in a WINE environment

Created with Enterprise Architect



Visual Execution Analysis 2 September, 2025

System Requirements

Using the Profiler, you can analyze applications built for these platforms:
e Microsoft ™ Native (C++, C, Visual basic)
e Microsoft .NET (supporting a mix of managed and unmanaged code)

e Java

Microsoft Native applications

For C, C++ or Visual Basic applications, the Profiler requires that the applications are compiled with the Microsoft ™
Native compiler and that for each application or module of interest, a PDB file is available. The Profiler can sample both
debug and release configurations of an application, provided that the PDB file for each executable exists and is up to
date.

Microsoft .NET applications

For Microsoft .NET applications, the Profiler requires that the appropriate Microsoft NET framework is installed, and
that for each application or module to be analyzed, a PDB file is available.

Java

For Java, the Profiler requires that the appropriate JDK from Oracle is installed.
The classes of interest should also have been compiled with debug information. For example: "java -g * java"
e New instance of application VM is launched from Enterprise Architect - no other action is required

e  Existing application VM is attached to from within Enterprise Architect - the target Java Virtual Machine has to
have been launched with the Enterprise Architect profiling agent

These are examples of command lines to create a Java VM with a specific JVMTI agent:

1. java.exe -cp "%classpath%;.\" -agentpath:"C:\Program Files (x86)\Sparx Systems\EA\vea\x86\ssamplerlib32"
myapp

2. java.exe -cp "%classpath%;.\" -agentpath:"C:\Program Files (x86)\Sparx Systems\EA\vea\x64\ssamplerlib64"
myapp

(Refer to the JDK documentation for details of the -agentpath VM startup option.)
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Getting Started

The Profiler can be used to investigate performance issues, providing four separate tools for you to choose from, namely:
e (Call Graph

e  Stack Profile

e  Memory Profile

e Memory Leaks

You select these tools from the Profiler toolbar.

Access

Ribbon Execute > Tools > Profiler

Tools

Tool Description

Call Graph Analyzes performance by taking samples during an activity in a program. Each
sample represents a stack. The samples are taken at intervals controlled using the
toolbar. In this scenario, poor performance is rated by the patterns of behavior that
repeat the most during the sample time period. This figure is used to weight the Call
Graph produced.

Memory Profile Analyzes performance by hooking the memory allocations made by a program. In
this scenario, poor performance is rated by the activities making the most requests
for memory. This figure is used to weight the Call Graph produced.

Stack Profile The Stack Profiler enables you to set a marker in your source code so that whenever
execution hits that marker, a full stack trace is captured. As the application
continues executing and the marked position is accessed from a variety of places
within the running executable, a very detailed and useful picture is built up showing
hot spots and usage scenarios for a particular point in code.

The Stack Profile report, like the Memory Profile report, is displayed in 'reverse
stack' order. This means that the root of the report is always a single node (in this
case the marker) and the tree then fans out to show all the various places the
marked position has been accessed from.

Memory Leaks Analyzes memory leaks by hooking the memory operations performed by a
program. What is produced is a Call Graph presenting the Call Stacks that allocated
memory for which a free operation was not detected.

Toolbar Buttons
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Button Action
- Displays a menu of options for managing your Profiling session.
b Launches the configured application to be profiled. By default, this is the

application configured in the active Analyzer Script.

" Indicates the state of the sampler. When green, sampling is enabled; when red,
sampling is disabled.
Stops the Profiler process; if any samples have been collected, the Report button

and Discard Data button are active.

Generates a report from the current data collection.

Displays the Profiling tool in use, which determines the fields shown in the Profiler
window. Click on the drop-down arrow and select a different tool, which changes
the window fields.

Discards the collected data. You are prompted to confirm the discard.

Displays the Help topic for this window.
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Call Graph

Profiler o x
a -~ e O Call Graph @
Path:
Target Interval {ms): 5
Process Time (estimated): 46:28.78 Process 1D:
Sample Count: 2230 Fragments: 577
Entrypoints Sampled Processed Time
1 wWinMainCRTStartup 2229 2228 00:02:16.08

2 _DIIMainCRTStartup

®  Quickly discover what a program is doing at any point in time
e  FEasily identify performance issues

e Be surprised how quickly you can realize improvements

e  See your improvements at work and have the evidence

e Support for C/C++, NET and Java platforms

Usage

The 'Call Graph' option is typically used in situations where an activity is performing slower than expected, but it can
also be used simply to better understand the patterns of behavior at play during an activity.

Operation

The Profiler operates by taking samples - or Call Stacks - at regular intervals over a period of time; the interval is set
using the Profiler toolbar. You use the Profiler to run a particular program, or you can attach to an existing process. The
Profiler capture is controlled, and you can pause and resume capture at any time. You can also elect to have capture
initiated immediately when the Profiler is started. If necessary, you can discard any captured samples and start again
during the same session. If you cannot continue with the same session, restarting the Profiler is quick and easy.

Note that the 'Process Time (estimated)' field shows an estimate of how long the process being profiled has been running,
taking into account the interruptions to the process by the Profiler in collecting samples.

Results

Results can be produced at any time during the session; however, capture must be disabled in order for the Report button
to become active. It is up to you to decide how long you let the Profiler run. You might know when an activity is
finished, or it might be apparent for other reasons. The reason you are here might be that an activity is not completing at
all.

The Report button will be enabled by either pausing capture or stopping the Profiler altogether.

Results are displayed in a Report view. The report opens with three tabs initially visible: the Call Graph, the Summary
Report (Function Summary) and the Hit Analysis tabs. The reports can be saved to file, stored in the model as Artifacts
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or posted in the Model Library.

The Call Graph Tab
Sampler Report o x
Call Graph Summary Report  Hit Analysis
Inclusive Hits UFP Hits | Inclusive Hits% Hits%
4 & EACNIEMScheralmporterDlg:OnBnClickedimport 1,283 1 54% -
4 [ EA:CMIEMSchemalmporter:importSchemas 362 1 36%
4 [ EA:CMIEMNamespaceCreator:CreateNIEMNamespace 398 1 17%
4 [8 EA:CMIEMNamespaceCreator:CreateSchemaTypeProperties 259 1 1%
4 [ EACNIEMNamespaceCreator: CreateComplexTypeProperties 147 1 6%
4 [ EA:CNIEMMamespaceCreator: CreateMIEMAttribute 109 35 5%
4 [ BEA:CDacDataMan:Updatebx 109 43 5%
4 [2 EA:CDaoDataMan:UpdatefutoCounter 76 32 3%
4 [ EA:CSSRecordset:Update 76 46 3%
4 [ EA:CSSSARecordset:Update 15 7 1%
4 [ EASACommand:SACommand 15 13 1%
4 [ EAsSACommandzsetCommandText 15 14 1%
4 [ EASACommand:ParseCmd 15 14 1%
4 [3 EA:SACommand::ParselnputMarkers 1 10
4 [ EA:SACommand::CreateParam 8 7
4 [ EAsaParams:find 8 7
4 B EASACommand:Compareldentifier 8 7
4 [ EA:SAString:CompareNoCase 4 4
3 ucrthased 4 4
+ [ EA:SAString:CompareMNoCase 3 2
B EA:SAString:CompareNoCase 1 1 1
» [ EA:SACommand:CreateParam 1 1
b [ EA:SACommand:CreateParam 1 1 v
4 »
The Summary Report Tab
Sampler Report o x
Call Graph Summary Report  Hit Analysis
Functions Inclusive Hits | Depth Modules Occurrences -
@ invoke_main 23682 4 EA 1
&) wWinMain 2392 5 EA 1
@ _ scrt_common_main 2392 2 EA 1
@ _ scrt_commeon_main_seh 2362 3 EA 1
[ CBCGPDialog::DoModal 1 80 EA 2
& CMainFrame:WindowProc 1671 103 EA 9
£ CBCGPFrameWnd::OnCommand 1625 21 EA 1
E CMainFrame:0OnCmdMsg 1625 24 EA 1
E CMainFrame:OnlmportNIEMXSD 1625 27 EA 1
£ CS5Dialog::DoModal 1622 28 EA 1
& CBCGPDialog:PreTranslateMessage 1538 g2 EA 3
[ CSSDialog:PreTranslateMessage 1535 a0 EA 2
£ CBCGPButton:OnLButtonUp 1533 105 EA 2
£ CBCGPDialog:0OnCommand 1533 123 EA 2
£ CNIEMSchemalmperterDlg:OnBnClickedimport 1283 7 EA 1
5 CNIEMSchemalmporter:importSchemas 862 78 EA 1
£ CNIEMNamespaceCreator:CreateMIEMNamespace 398 79 EA 1
£ CDacDataMan:UpdateEx 398 36 EA 20
& CSSRecordset:Update 322 29 EA 23
& CRIEME chamalmnaterlmnnatGrhamas ana 70 En 1 -

The Hit Analysis Tab

The 'Hit Analysis' tab displays a number of columns:

e  Function: the name of the function (or module if no symbols for module)
e Hits: the number of samples taken, in which the function was executing.
e Depth: the frame number or stack depth at which the hit took place.

e Occurrences: the number of times the function was hit at this particular stack depth
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The number of hits on a particular function are aggregated according to the stack frame depth when sampled.

If the function name is unavailable, for example Windows System DLL's such as User32 or DLL's with no debug

information, the module name is shown instead.

Sampler Report

Call Graph Summary Report  Hit Analysis

Functions
USER32
ucrtbased
mfc140ud
GDI32
GDI32
GDI32
mfc140ud
GDI32
USER32
COMCTLI2
ucrtbased
ucrtbased
ntdll
GDI32
mfc140ud
ucrtbased
ucrtbased
USER32
mfc140ud

nethacad

Actual Hits

W a4 a4 a4 R a4 a4 a4 a4 a

Depth

436
213
208
173
172
m
168
167
161
155
153
152
147
146
146
146
145
145

144
142

Occurrences

1
1
1
1
1
1
1
1
1
1
1
1
2
1
1
1
1
1
1
k)
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Stack Profile

The Stack Profiler enables you to set a marker in your source code so that whenever execution hits that marker, a full
stack trace is captured. As the application continues executing and the marked position is accessed from a variety of
places within the running executable, a very detailed and useful picture is built up showing hot spots and usage scenarios
for a particular point in code.

Profiler
O - > ® O [E  stack Profile .
Program; Idsing Analyzer Scripk -
A Temph CS5ampleiMicrosoft METIDelegatesiDelegates2 bint Debug Delegates
Frarnes [4-64]: 20 -
Frofile Paint; Set

Stack holdings:

The Stack Profile report, like the Memory Profile report, is displayed in 'reverse stack' order. This means that the root of
the report is always a single node (in this case the marker) and the tree then fans out to show all the various places the
marked position has been accessed from.

@StartPagE W Sampler Report X
Stack Profile Summary Report

Call Stack
F Stack Profile: EN\Apache\xalan-builds\xerces-src-31\Build\Win32\WCHdebug\s
4 @ werces-C_3 1Dxercesc_3_1:RefHashTableOf<xercesc_3 1. XMLStringPool::PoolElem,xercesc_3 1::5tri
rl FEEI werces-C_3 1Dxercesc_3_l:RefHashTableOf<xercesc_3_1:XMLStringPool::PoolElem,xercesc_3 1:
i @ werces-C_3 1Dxercesc 3 1 XMLStringPoaol: XMLStringPoaol
F] FEEI xerces-C_3 1Dxercesc_3 1:DOMDocumentImpl:DOMDocumentImpl
3 FEEI werces-C_3 1Dxercesc 3 1:DOMImplementationImpl:createDocument
3 @ xerces-C_3 1Dxercesc_3 1:XMLGrammarPoolImpl: XMLGrammarPool Impl
3 @ xerces-C_3 1Dxercesc_3 1:ElemStack: ElemStack
3 @ xerces-c_3 1Dxercesc_3 10SAXZXMLReaderImplinitialize
3 @ xerces-C_3 1Dxercesc_3 1-RangeTokenMap:RangeTokenMap

Usage

Use the Stack Profile mode to produce a report that shows the unique ways in which a function can be invoked during the
running of a program. Determine the parts of the model that rely on this function and their frequency.

(c) Sparx Systems 2025 Page 208 of 253 Created with Enterprise Architect



Visual Execution Analysis 2 September, 2025

Operation

106
107 template <class TVal, class THashers
108 void RefHashTableO0f<TVal, THasher>::initialize(|const EMLSize_t modulus)

109 {
Q 110 if (modulus == 0)
111 ThrowKMLwithMemMgr({IllegalArgqumentException, XMLEzcepts::HshTbl_ZeroMo
112
112 /f Rllocate the bucket list and zero them
114 fBucketlList = (REefHashTableBucketElem<TVal>*+*) fMemoryManager—-=allocate
115 {
116 fHashModulus * sizeof(RefHashTableBuckstElem<TVal>*)
117 i
118 for (EMLSize_ t indexz = 0; indez < fHashModulus; indesz++)
119 fBucketlList[index] = 0O;
120 }
121

Profiler modes are selected using the Profiler control Toolbar. If a Profiler Point is already created, it is displayed. The
Profiler Point is the point at which stack traces are captured. You can set the Profiler Point using the Set button on the
control itself, once the mode is selected. After deciding on the Profile Point, build the project to be sure everything is up
to date, then start the Profiler. The number of unique stack holdings detected is visible during the run.

Results

A results can be produced by clicking the report button on the Profiler control Toolbar. This button is enabled when
either:

e  Capture is turned off (using the Pause Button) or
e  The Profiler is stopped (using the Stop Button)

The results produced are displayed as a weighted call graph, where the lines on the graph represent a unique stack, and
weighted to show the higher frequency stacks first. The report can then be saved, either to file or to the model, using the
context menu of the report itself.
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Memory Profile

Profiler e
g~ b % 0O [3 | Memory Profile -0 @
Program: Using Analyzer Script .

C:\Code Samples\WEA\Microsoft Native\CityLoop\debuc

Frames (4-64): 16 - N Elapsed 3.3 secs
Heap Virtual
Allocations:; 4377 2
Frees: 0 0
Frees not 0 0
Stack holdings: 4375 2
Memory holdings 1 B
Module loaded:api-ms-win-core-datetime-11-1- 1. base: 72940000 -

Module loaded:api-ms-win-core-localization-obsolete-11-2-0, base:7e71
Build version: 3.6, status:0w0003, process heap:0x00110000

Auditor installed.

Module loaded:api-ms-win-appmodel-runtime-11-1-2, base: 7ebb0000
Target process ended.

Audit ended.

@Start Page ElCityLoop i+ *leaks

Memory Profile  Summary Report

 *profile X

Call Stack Instances Bytes Line
4 2 ntdli:RtlAllocateHeap 4,375 1,237,419 -1
» [0 user32:PostMessageA 7 (+0x00BD, +189) 913 233,728 -1

» [7) user32:ShutdownBlockReasonDestroy 7 (+0x0ABA, +2666) 632 40,448 -1

» [Z) ucrtbased:toupper 541 100,374 -1

» [7) user32:GetClientRect 7 (+0x0103, +259) 480 245,760 -1

» [7) gdi32:SetAbortProc 7 (+0x032F, +815) 193 17,756 -1

» [7) gdi32:CreateFontIndirectExW ? (+0x0051, +81) 145 13,340 -1

» [7) winex11:SetFocus ? (+0x0A79, +2681) 121 4,992 -1

» [ ntdll:LdrGetDIIHandle ? (+0x0072, +114) 88 54,628 -1

» [?] ntdil:RtIDosPathNameToNtPathName_U_WithStatus 7 (+0x0300, +768) T4 14,864 -1

» [7] gdi32:SelectObject 7 (+0x00E2, +226) 58 33,456 -1

b [7) user32:GetTitleBarinfo 7 (+0x0D9AF, +2479) 56 16,296 -1

» [7) user32:ShutdownBlockReasonDestroy 7 (+0x0ABA, +2666) 52 29,212 -1

» @) gdi32:GetCharWidthInfo 7 (+0x0461, +1121) 52 832 -1

e  Quickly rate performance of activities that interest you
e Nothing influences a discussion more than evidence

e Reward your efforts by working in those areas that will make a difference
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e  Surprise yourself by delivering optimizations you might not have known existed

Usage

The Memory Profile can be used to reveal how activities perform in regard to memory consumption. Using this mode, a
user would be interested in questioning the frequency of demands made for memory during a task. They would be less
interested in the actual amount consumed. A well managed activity might make relatively few calls to allocate resources
but allocate enough memory to do its job efficiently. Other activities might make many thousands of requests, and that
typically makes them less efficient. This mode is useful for detecting those scenarios.

Operation

The Memory Profile works by hooking the process in question, so that program has to be launched using the tool in
Enterprise Architect. Unlike the Call Graph option, you cannot attach to an existing process. When the program is
started, hooking mechanisms track the allocation of memory; this information is collected and collated in Enterprise
Architect. You can easily monitor the number of allocations being made. Also, the process is controlled; that is, the
memory hooks can be turned on and off on demand. If you might have mistimed some action, you can pause capture,
discard the data and resume capture again easily.

Results

Results can be produced at any time during the session; however, capture must be disabled in order for the Report button
to become active. It is your decision how long you let the Profiler run. You enable the Report button by either pausing
capture or stopping the Profiler altogether.

Results are displayed in a Report view. The report initially opens with two tabs visible; a single weighted Call Graph and
a Function Summary. The Call Graph depicts all the Call Stacks that led to memory allocations, which are aggregated
and weighted according to the frequency of the pattern.

Requirements

For best results, the image and its modules should be built with debug information included, and without optimizations.
Any module with the Frame Pointer Omission (FPO) optimization is likely to produce misleading results.
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Memory Leaks

Profiler v b X
O~ b ®& O [ Memory Leaks * | A @
Program: Using Analyzer Script v

C:\ea\EAl60\Code Samples\VEA\Microsoft Nati

Frames (4-64): 16 - Elapsed 6.1 secs

Heap Virt
Allocations: 3981 2
Frees: 3984 0
Frees not 5 0
Stack holdings: 447 2
Memory holdings 0 0

Analyzing heaps for freed memory blocks.

You can click the SkipHeap button at any time however, it is recom
that you let the analysis complete at least once. This will identify th
that may contain freed blocks that were not detected.

In subsequent runs you can skip these heaps.

Target process ended.

Audit ended.

The Profiler control, showing the count of memory allocations and the count of operations that are memory free.
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@Start Page ECityLOOp " *¥legks x |

Memory Leaks  Summary Report

Call Stack Instances
4 [7) C:\ea\EAL60\Code Samples\VEA\Microsoft Native\CityLoop\debug\CityLoop.exe 0 a

4 [7) ntdll:RtlAllocateHeap 447

4 [7) ucrtbased: toupper 89

4 [7] ucrtbased:toupper 89

» [7] ucrtbased:calloc_dbg 83

4 [7) ucrtbased: malloc_dbg 6

4 [7) ucrtbased 3

» [2) mfcl40ud 2

4 [7] uatbased 1

4 [7) ucrtbased 1

+ 2 dtyloop:CNetwork: :CNetwork 1

4 [&] dtyloop:CCityLoopDlg: :CCit‘yLDopDIg} Show Source for Function

i dtyloop:CCityLoopApp::Initinstar Find in Summary Window

» [2) mfcl40ud
v [E) mfcl40ud Collapse Graph
» [7] gdi32:__wine_set_visible_region 7 (+0x013D, +317) Collapse To Node
v [7) gdi32:ExtTextOutW ? (+0x0C21, +3105)
4 [7] winex11:ImeGetImeMenultems 7 (+0x04F7, +1271) Follow Max Allocations
<@ WInE)l(ll Create Function Graph
4 [7] winex11
4 [7] gdi32:SelectObject ? (+0x00E2, +226) v Autofit
b [7) user32
4 [7) user32:GetNextDIgTabItem 7 (+0x00B8, +18 Display Heaviest Weighted Use
4 [7) user32:CreateDialogIndirectParamW 7 (+0
4 [7) user32
4 |7] user32
A well behaved program.

Memory leak detection is a road well traveled. Although many other good options are available, we believe our approach
has major benefits, such as:

e No changes at all to existing project build
e No header files required by the project code
e No runtime dependencies to worry about

e No system configuration to think about

Usage

A person would use this mode to track memory leaks in an application or in an activity within the application. A memory
leak from the Profiler's point of view is a successful call made to a memory allocation function that returns a memory
address for which no matching call is made to free that address.

Operation

The Memory Leak detection works through hooking. The memory routines of the process are hooked to track when
memory is both allocated and freed. Call Stacks are captured at the point of the allocation and this information is collated
in Enterprise Architect to produce a report in the form of a Call Graph. Capture is controlled; that is, the hooking
mechanisms can be enabled or disabled on demand.

Depending on the type of program and its memory consumption, you could employ an appropriate strategy. For small
programs, you might track the program from start to finish. For larger windowed programs, you would probably do better
by toggling capturing before and after a specific task to avoid tracking too much data.
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Results

Results can be produced at any time during the session; however, capture must be disabled in order for the Report button
to become active. It is your decision how long you let the Profiler run. You enable the Report button by either pausing
capture or stopping the Profiler altogether.

Results are displayed in a Report view. The report initially opens with two tabs visible; a single weighted Call Graph and
a Function Summary. The Call Graph depicts all the Call Stacks that led to memory allocations, and are aggregated and
weighted according to the frequency of the pattern.

Reports can contain a variable amount of 'noise'. To focus on an area you have specific concerns for, locate a function
known to you in the summary report and use that to navigate directly into the line in the graph where it is featured.

Requirements

For best results, the image and its modules should be built with debug information included, and without optimizations.
Any module with the Frame Pointer Omission (FPO) optimization is likely to produce misleading results.
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The first icon on the Profiler window toolbar displays a list of options that you can set to tailor your Profiling session.

# Attach to Rurining Process

*

Load Report

Analyzer Scripts...

Delay Sampling

Shift+F12

CallGraph Aggregates Method

CallGraph Samples Include Wait State

Start Sampling Immediately

+  Discard Fragments
Capture Debug Output

Stop Process on Exit

Options

Option

Attach to Running Process

Switch to Debugger

Load Report

Analyzer Scripts

Delay Sampling

CallGraph Aggregates
Method

CallGraph Samples Include
Wait State

(c) Sparx Systems 2025

Description

Select this option to display the 'Attach to Process' dialog, from which you choose
an active process to Profile.

Select this option to change operations from Profiling to Debugging. The Debugger
has an equivalent drop-down menu option that you can use to switch from
Debugging to Profiling.

Select this option to load a previously saved report from the file system.

Select this option to open the Analyzer Script window, which is the model
repository for configuring builds, debugging, and all other Visual Execution
Analyzer options.

Select this option to set a delay between clicking on a 'Start Profiling' option and
the Profiling actually beginning. The delay can be 3, 5 or 10 seconds. Select 'None'
to cancel any delay set.

When this option is selected, instances of the identical stack sequences are
aggregated by method. That is to say, line numbers / instructions within a method
are ignored, so two stacks will be counted as one where they differ only by line
number in their final frame.

When this option is selected, the Profiler will sample all threads, including those in
Wait states. When unselected, the Profiler only samples threads that have
accumulated CPU time since the last interval expired.
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Start Sampling Select this option to trigger Data Collection immediately on launch. You would
Immediately typically use this option to profile a process during start up.
Discard Fragments When stacks cannot be reconciled to the entry point of a thread they are referred to

as fragments. The number of fragments encountered during sampling is displayed
in the sampler Summary window. You can set this option to collect or discard
fragments; when the Discard Fragments option is:

e Selected, fragments do not appear in the reports, although the number
encountered is still updated

e Deselected, a special collection named 'fragments' is created in the call graph to
house them, and to ensure they data is not mixed in with the complete samples

Capture Debug Output (Applies to Process Sampling). When selected, output normally visible during
debugging is captured and displayed in the Debug window. Note that only debug
builds will typically emit debug output.

Stop Process on Exit This option determines termination behavior for the Profiler. When the option is
selected, the target process will terminate when the Profiler is stopped.
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Start and Stop the Profiler

Profiling is a two stage process of data collection and reporting. In Enterprise Architect the data collection has the
advantage of being a background task - so you are free to do other things while it runs. The information sent back to
Enterprise Architect is stored until you generate a report. To view a report, the capture must be turned off. After the
report is produced you can resume capture with the click of a button. If, for some reason, you decide to scrap your data
and start again, you can do so easily and without having to stop and start the program again.

class Profiler

EA Profiler [Target Application
S aflows | ~ aflows
Access
Ribbon Execute > Tools > Profiler > Open Profiler
Other Execution Analyzer toolbar : Analyzer Windows | Profiler
Actions
Action Detail
Toolb :
oot Profiler
R Call Graph . @
Strategy Selection Select the Profiling strategy from the available options on the Toolbar.
Start the Profiler Click the Run button on the Profiler window
Stop the Profiler The process exits if:
e  You click on the Stop button
e  The target application terminates, or
®  You close the current model
If you stop the Profiler and the process is still running, you can quickly attach to it
again.
Pause and Resume Capture You can pause and resume capture at any time during a session.

When capture is turned on, samples are collected from the target. When paused, the
Profiler enters and remains in a wait state until either capture is enabled, the
Profiler is stopped or the application finishes.
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Generate Reports The Report button is disabled during capture but is available when capture is turned
off.
Mode drop-down Click on the drop-down and select the mode of Profiling - Call Graph, Stack

Profile, Memory Profile or Memory Leaks.

Clear Data Collection You can clear any data samples collected and resume at any time. First suspend
capture by clicking on the Pause button. The Discard button, as for the Report
button, is enabled whenever capture is turned off. In clicking on the Discard button
you will be asked to confirm the operation. This action cannot be undone.
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Function Line Reports

After you have run the Profiler on an executing application and generated a Sampler report, you can further analyze the
activity of a specific function listed in the report by generating a Function Line report from that item. A Function Line
report shows the number of times each line of the function was executed. You produce one Function Line report at a
time, on any method in the Sampler report that has a valid source file. The Function Line report is particularly useful for
functions that perform loops containing conditional branching; the coverage can provide a picture of the most frequently
and least frequently executed portions of code within a single method.

The line report you generate is saved when you save the Sampler report. The body of the function is also saved with the
Function Line report to preserve the function state at that time.

This facility is not applicable to Memory Profile reports.

Platforms supported

Java, Microsoft .NET and Microsoft native code

Create a Line Report

In the Sampler report, right-click on the name of the function to analyze, and select the 'Create Line Report for Function'
option.

Once the Profiler binds the method, the Function Line report is opened on the Sampler Report window. The report shows
the body of the function, including line numbers and text. As each line is executed a hit value will accumulate against
that line. A timer will update the report approximately once every second.
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M 4 » M | CallTree Report | Summary Report | ConsoleApplication:CQuickSort:Quicksort
-

Module:ConsoleApplication

Function: CQuickSort:Quicksort

Date: 20/09/2013 2:53:21 PM

Author smeagher

Iterations: 28679

LineMo Hit= Code

21 28645 {

22 28644 if ir<=1)

23 14460 retum;

24 14184 inti=l-1,j=r.p=,q=r

25 for ;)

26 i

27 439580 while [@[++] < affl) :

23 14185 while (a[-] > alr])

29 if§==I)

30 breal:;

H if i ==j)

3z 14185 break:;

33

4 Exchange(a. i. j);

35 if { alil ==al])

36 Exchangel(a, +p. i);

7

38 if (af] ==alr])

35 Exchangs(a. j. —q):

40

41 }

42 14185 Exchangela.i. r);

43 14185 j=i-1i=is1;

44 14185 forfimt b =1k < p; b=+ j-)

End Line Report Capture

Once enough information is captured, or the function has ended, click on the Profiler toolbar Stop button to stop
recording the capture.

Save Reports

Use the Save button on the Call Stack toolbar to save the Sampler report and any Function Line reports to a file.

Delete Line Reports
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Closing the 'Line Report' tab will close that report but the report data will only be deleted when the report is saved.
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Generate, Save and Load Profile Reports

Reports can be produced at any time during a session, or naturally when a program ends. To enable the Report button
while the program is running, however, you need to suspend Profiling by toggling the Pause/Resume button, or by
terminating the Profiler with the Stop button. You have some options for reviewing and sharing the results:

e  View the report

e  Save the report to File

e Distribute the report as a Model Library resource

e  Attach the report as a document to an Artifact element

e Synchronize the model by reverse engineering the source code that participated in the profile

Access
Ribbon Execute > Tools > Profiler > Create Report from Current Data
Profiler

From the Profiler window, click on the icon in the toolbar.

Load Report from File

The option is available from the drop down menu of the Profiler window

Generate Report

From the Profiler window, click on the icon in the toolbar.

CallFrequency Report
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Hd<|«> a8 | Y |F @

Call Stack Inclusive Hits  Hits
= xercesc_3_1uSAK2ZKMLReaderlmpl:parse 16051
= xercesc_3_luXMLScanner:scanDocument 16031
=1 wercesc_3_l1:1GXMLScanneriscanDocument 160351
= wercesc_3_l1:1GXMLScanner:scanContent 160351
= xercesc_3_1:IGXMLScanner:scanStartTaghs 160351
= xercesc_3_l1:1GXMLScanner:resolveSchemaGrammar 160351
= xercesc_3_l:uSchemaValidator:preContentValidation 16049
= xercesc_3_T:ComplexTypelnfoicheckUniqueParticleAttribution 16049
= xercesc_3_l1uComplexTypelnfoimakeContentModel 16049
= xercesc_3_1:DFAContentModel:DFAContentModel 16047
= xercesc_3 1:DFAContentModel:buildDFL 13998 515
= xercesc_3_1uCMStateSet:ioperator|= 2174 2093
memecpy 32 32
xercesc_3_TuCMStateSetiallocateChunk 27 1
__security_check_cockie 21 21
TraillpVec 1 1
wercesc_3_TuCMStateSet::~ CM5StateSet 3573 4
wercesc_3_lukMemoryioperator delete 24 2
xerces-c_3_10 4416 2
xercesc_3_1uCM5StateSet::getBit 1036 1036
xercesc_3_1uDFAContentModel:buildSyntaxTree 528 3
xercesc_3_1nCMStateSet:: CMStateSet 373 3
xercesc_3_1:CMStateSet:getBitCountlnRange 285 285
xercesc_3_luXMemony:operator new 21 2
xercesc_3_1uCMStateSet::zeroBits 154
xercesc_3_ 1uCMStateSetEnumerator:nextElement 133 136
xercesc_3_luRefHashTableOf<xercesc_3_1:XMLinteger,» 59 2
xercesc_3_1uRefHashTableOf <xercesc_3_Tu¥MLinteger,: 28 2
xercesc_3_luRefHashTableOf <xercesc_3_TuXMLinteger,: 23
xercesc_3_1uDFAContentModel:makeDefStatelist 25 2

Function Summary

@StartPagE W% C\ea\tests\cg-xerces-sax2print ssprf X

MHame Inclusive Hits Occurrences
e £

[ mainCRTStartup 7408 1
(2 _tmainCRTStartup 7407 1
@ xercesc_3_Tu¥XMLFormatter::handleUnEscaped Chars 7351 10
@ xercesc_3_1:XMLFormatter::format Buf 7351 10
@ xercesc_3_Tu¥XMLRormatterispecialFormat 7351 10
@ 5402PrintHandlers:write Chars 7350 10
@ ¥ercesc_3_1uEMLScanner:scanDocument 7350 1
(2] main 7350 1
@ xercesc_3_105802XMLReaderImpl:parse 7350 1
@ xercesc_3_1XNLscanner:scanDocument 7349 1
@ ¥ercesc_3_10IGXMLScanner::scanDocument 7348 1
@ xercesc_3_1:XMLFormatter::format Buf 4042 8

Unfiltered Summary Report listing all participating functions in order of inclusive hits.
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@StartPage o C:\ea\tests\cg-xerces-sax2print.ssprf X

MHame Inclusive Hits Occurrences
SAX x »

@ 524 2PrintHandlers:write Chars 7350 10

@ xercesc_3_1:5Ax2XNMLReaderImpl:parse 7350 1

@ xercesc_3_1:5Ax2XNMLReaderImpl::doc tharacters 3309 2

@ S&2PrintHandlers::characters 3309 2

FED‘ xercesc_3_1nSAXZXMLReaderImpl:endElement 2114 1

FED‘ xercesc_3_1n5AXZXMLReaderimpl:startElement 1925 1

FE“‘ 54x2PrintHandlers::endElerment 1523 1

You can filter and reorganize the information in the report, in the same way as you do for the results of a Model Search.

Report Options

Right-click on the report to display the context menu.

4 [7) ucrtbased 3
» [7] mfcl40ud 2
4 [?) ucrtbased 1
4 [7] uerthased 1
4 21 dtyloop:CNetwork: :CNetwork 1
4 [ dtyloop:CCityLoopDig: :CCityLoupDI_h Show Source for Function
- [ dtyloop:CCityLoopApp::InitInstar Find in Summary Window
+ 12 mfcl40ud
v [7] mfcl40ud Collapse Graph
v [1) gdi32:__wine_set_visible_region ? (+0x013D, +317) Collapse To Node
v [7) gdi32:ExtTextOutW 7 (+0x0C21, +3105)
4 [7) winex11:ImeGetImeMenultems 7 (+0x04F7, +1271) Follow Max Allocations
«0 wme?cll Create Function Graph
4 [7] winex11
4 [7] gdi32:SelectObject 7 (+0x00E2, +226) v Autofit
v [7] user32
4 [7) user32:GetNextDIgTabItem ? (+0x00B8, +18 Display Heaviest Weighted Use
4 [7] user32:CreateDialogIndirectParamw ? (+0
4 [7] user3z
4 [7) user32
: LI‘ L_fezjﬁz Save Report to File
[ dtyloop:CCityLoopApp::Inil Save Report to Artifact
v [7] mfc140ud Help
» [ gdizz J

Note that the options listed depend on the type of report displayed; the report illustrated here is a Memory Profile report.

Action Detail

Show Source for Function For the selected frame, select this option to display the corresponding line of code
in a code editor. Frames that have source available are identifiable by their icon.

Find in Summary Window Select this option to locate the function in the Summary window.
Collapse Graph Select this option to collapse the entire graph including child nodes, visible or not.
Collapse to Node Select this option to collapse the entire graph, then expand and set the focus to the

selected node.
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Follow Max Allocations

Create Line Report for
Function

Create Function Graph

Mark Initial Frame for Call
Stack Diagram

Remove Mark

Create Call Stack Diagram

Create Weighted Call
Graph Diagram

Display the Heaviest
Weighted Use

Display the Next Weighted
Use

Display the Previous
Weighted Use

Import Source Code

Autofit
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Select this option to expand an entire line in the graph.

Select this option to launch the Profiler (if it is not already running), immediately
bind the selected function and ready it for recording. Once bound, an extra tab is
opened in the current Report View. This report will update instantaneously,
showing the number of times each line executed. Of course, the report will continue
to record activity in the function even if is not visible.

Notes:

e [n windowed programs, it is usually necessary to take some action in the
application to cause the function to be invoked

e This option is not applicable to Memory Profile reports

Select this option to create an additional tab, which shows the selected function in
isolation. For a Call Frequency Profile, this produces a graph showing all the lines
that led to this function being called (that is, the callers). For a Memory Profile, this
produces a graph showing all lines that emanate from this function (that is, the
callees).

Use prior to creating a Call Stack Sequence diagram to limit the stack length. When
this option is selected, the frame is marked and its text is highlighted. Frames above
this one will then be excluded from any Sequence diagram produced.

This option is not applicable to Memory Profile reports.

Removes the mark from a frame that was previously marked as 'Initial'.

This option is not applicable to Memory Profile reports.

Generates a Sequence diagram for a single stack in the graph. The selected frame is
depicted as the terminal frame in the stack. The initial frame of the stack defaults to
the root node if no 'Initial' frame has been marked.

This option is not applicable to Memory Profile reports.

Generates a Sequence diagram that presents a sequence for each visible stack
branching from the selected frame. By expanding and collapsing the nodes of
interest, you can tailor the Sequence diagram content to your liking.

This option is not applicable to Memory Profile reports.

Select this option to display the line in the graph with the highest weight in which
this function appears.

Select this option to navigate to the next line in the graph where the function
appears.

You can use the shortcut key combination Ctrl+Down Arrow.
Select this option to navigate to the previous line in the graph where this function
appears.

You can also use the shortcut key combination Ctrl+Up Arrow.

Select this option to import selected source code into the report.

This option is not applicable to Memory Profile reports.

When enabled, automatically fits the columns to the available display area.
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Save Report to File Select this option to display the 'Save As' dialog, allowing you to choose where to
store the report.

Save Report to Artifact Note: Before selecting this option, go to the Browser window and select the
Package or element under which to create the Artifact element.

You are prompted to provide a name for the report (and element); type this in and
click on the OK button.

The Artifact element is created in the Browser window, underneath the selected
Package or element.

If you add the Artifact to a diagram as a simple link, when you double-click on the
element the report is re-opened.

Notes

e Ifyou add the Profiler report to an Artifact element and also attach a Linked Document, the Profiler report takes
precedence and is displayed when you double-click on the element; you can display the Linked Document using the
'Edit Linked Document' context menu option

(c) Sparx Systems 2025 Page 226 of 253 Created with Enterprise Architect



Visual Execution Analysis 2 September, 2025

Save Report in Model Library

You can save any current report as a resource for a Category, Topic or Document in the Model Library. The report can
then be shared and reviewed at any time as it is saved with the model. This helps you to:

e  Preserve a Profiler report to compare against future runs

e Allow other people to investigate the profile

Access

Context Menu Right-click in Library window | Share Resource | Active Profiler Report
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Testpoints

Testpoints present a scheme by which constraints and rules governing the behavior of objects can be taken from the
model and applied to one or more applications. The advantages that schemes such as this offer are tolerance to code
changes - adding and subtracting lines from a function has no effect on the constraints that govern it. Another advantage
is that changes to the behavioral rules do not require a corresponding change to any source code; meaning nothing has to
be re-compiled!

Also, the ability to verify multiple applications using a single test domain is a simple rather than onerous matter. The
Test Domain is a both a logical and relational model; constraints in the Class model can be partitioned with Test Cuts.
These can be aggregated simply into Test Sets and Test Suites using connectors. Due to the decoupling of the Test
Domain from the codebase, it is a simple choice of buttons to run a program normally, or run it for a specific Test
Domain. This system also delivers practical benefits in that no instrumentation is required at all. Test results are
displayed in the report window during the run, in real-time, as the program runs. These results can be retained, and
reviewed at any time in the 'Test Details' dialog or using Enterprise Architect's documentation features.

StockExchange - Enterprise Architect - a
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5 @ testsets Sell Stock
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10 36 36 meagh 2015-09-31
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1 316 316 meagher  2015:09-3)
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>
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Features
Feature Details
Testpoint Composition Testpoint composition is performed using the Testpoints window. The Testpoints

window is context-sensitive and displays the Test Domain for the selected element
in either the Browser window or diagram. Selecting a single Class will display the
Class structure. A 'pencil' icon is displayed against Classes and methods that have

existing constraints.

When you select a Test Cut, Set or Suite Test, the Testpoints window displays the
entire Domain structure, including all the Classes that make up the domain. Note:
You can navigate the domain hierarchy using the 'Navigation' pane on the right.
Testpoints are composed as expressions, using the variable names of the Class
members. The Intelli-sense shortcut Ctrl+Space is available within the editor to
help you find these. Expressions that evaluate to True are taken to mean a pass.
Returning False is taken to mean a fail.
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Testpoints

Tests:Stock P& p/ - 5’]
Tests Id | Constrai..  Evals Passes Fa Parent Collections:
2 & Stock i 538 538 - [ Exchange Stock
= [ Invariant 316 316 ] Buy Stock
@ m_stkSector <= "" 1 316 316 (] Sell Stock
= =% |Stock™ Create(lExchange™, LPCTSTR, F ] p/ 12 12
= [z Pre-Condition 12 12
@ (pExchange=>null) AND (stock 4 12 12
& LPCTSTR GetMName()
= =4 ESector GetSector() ] p/ 70 70
= [z Pre-Condition 70 70
@ m_stkSector |= "secCount” 5 70 70
[= =4 FLOAT GetStockCost() @ ;7 70 70
= a Pre-Condition 70 70
w m_stkUnitCost > 0 2 70 70
4 TStocklD GetStocklD()
= =4 UINT GetStockVolume() o 70 70
3] Pre-Condition 70 70

& void SetStockID(T5tockiD)
You can add or edit an existing Invariant by double-clicking the Class.

You can add or edit an existing pre- or post-condition similarly by double-clicking
the method.

Double-clicking a Testpoint will automatically display the source code if it is
available.

Line conditions are best added from within the code editor using its shortcut menus.

This image is of a pre-condition in the Test domain.

p'"l Testpoint Editor: ; Exchange.Stocks: GetStockVolumef) x
Constraint
Type: Pre-Condition -
Condition: m_stkVolume ==0
Action on Fail: | @ pgreak execution -
Evaluate
When:
Trace
Lewvel: Fail Only =

Statement: | Stock volume: @m_stkVolume is not allowed to be negative

oK Cancel || Help

Testpoint Trace Statements Each Testpoint can have its own Trace statement. The Trace statement is a dynamic
message that can reference variables in its object or local scope. They are output
during the evaluation of a test. They can be configured to be output every time a
constraint is evaluated, or more usually when a test has failed. Trace statements can
be directed to the 'Testpoints' tab of the System Output window, or to an external
file. You can configure this in any Analyzer Script.

Test Domain Composition The Test Domain diagram is a dynamic medium where Testpoints are assembled to
test Use Cases. Use Cases in a Test Domain diagram are provided in three different
stereotypes: Test Cut, Test Set and Test Suite. Management of the domain is as
easy as modeling on any diagram. The toolbox and shortcut menus provide access
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Test Domain and the Class
Model

Testpoint Evaluation
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to any Test Domain Artifacts. In brief, Testpoints from multiple Classes are
aggregated into Test Sets. Test Sets are then linked to form Test Suites. Both Test
Cuts and Test Sets are re-usable assets. Linking the same Test Set to the one or
more Test Suites is a matter of drawing connectors.

«testsets

Sell Stock

«testcuts
Sell Stock

wtestcut»
Sell Broker

«testcut»
Sell Account

| |
| [}
| I
| |
| |
| I
| I

Account Broker Stock

Rarely would a Use Case involve all the methods of a single Class. Most likely it is
realized using a variety of methods from collaborating Classes. We call this subset
of methods a 'cut', and the Test Cut Artifact is the tool we use to make these cuts.
The Testpoints window will adapt depending on the context, to be that for a Test
Domain or Class element. This image shows the Testpoints window when a Test
Cut has been selected. Note the checkboxes, which are only visible for a Test Cut.
They denote the methods (Test Cuts) that are contributing to a Test Set. In this
example the Test domain was generated by the Execution Analyzer, which did the
method identification work for us.

TestCut:AddCustomer s J O E-H@

Tests Id

= [ AddCustomerTC2
= & Customer
& int AddMew()
& int GetAddress(string)
& int GetlD()
i string GetName(string)

Parent Collections:
@ AddCustomer

Constraints

&

Oooo

The Testpoints window is used to evaluate Test domains. The window has a toolbar
for starting or attaching to the target application. The domain to test is always
reflected by the element that has context, so if you select a Class the window will
show only the Class structure and Testpoints of that Class. If you select a Test
Suite, the window will display the entire domain hierarchy and all the Testpoints
included in it. Clicking on the Run button will load the Testpoint domain in the
Execution Analyzer, which will then evaluate, collect and update the report window
as Use Cases pass or fail each test. The exact details of each constraint type and the
when and how of that constraint's capture are:
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e A Class Invariant is evaluated by the Analyzer whenever any method called on
an object of this Class type is completed; the invariant serves to test that the
state of a complying object is both known and permitted

e Pre-conditions are evaluated immediately before an operation is called

e Post-conditions are evaluated (at the same time as a Class invariant) when the
method is completed

e Line-conditions are evaluated if and when their specific line of code comes into
scope during program execution
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Test Domain Diagram

The Test Domain diagram is the medium where you assemble and group test cases for a particular domain. An example
of a Test domain might be 'Customer'. The breadth and depth of the domains you assemble is up to you. You might have
separate domains for 'Add Customer' and 'Delete Customer', depending entirely on how you consider best to balance the
domain hierarchy. The Diagram Toolbox and Shortcut menu provide a number of Artifacts to help model the domain.
Because the medium is dynamic, allowing you to revisit and build on relationships between Test domains, the system is a
great model for delivering reusable assets to an organization that are low overhead and integrate with both the UML view
of the world, and the Software Engineering nuts and bolts of daily life.

Facilities

Facility Details

Test Domain Generation If you think the process of composing a Test Domain is complex, it can be, but help
is at hand! The Execution Analyzer can produce a Test Domain diagram for you. It
cannot write the Tests for you, but it can do some of the leg work. It can identify
the Classes and pick out only those methods that participated in a Use Case. And
this is not guesswork. The Analyzer Test Domain is obtained from a running
program. This image shows the Test Domain generated by the Execution Analyzer
from recording an Example Model program.

wtestsetn

Buy Stock

|
|
|
|
|
|
|
|
’ | \ ~
|
|
|
|
|
|
|
|
|

2 ¥ v N RN

wtestout» ‘ «testcut» «testcuta ‘ «testcuta wtestocut» ‘

Buy Sector Buy Broker Buy Stock Buy Account Buy Exchange

And this is the recording itself (as a Sequence diagram) from which the Test
Domain was generated.

1.1 FindAccount(1): Account®
1.2 Findstock(2):
Stoc 1.3 GetstockVolumef(): UINT

1.4 GetstockCost(): FLOAT

1.08uy(1, 2, 100): bool

?

1.5 GetBalance(): INT

1.6 Credit(2, 100, -100)

"0
B

1.7 Getsector(): Esector
1.8 Updates

i ! |
1.9 GetSector(secEquities): Sector® ! | i

i 110Move i i

! (100) T Q

3

(secEquities, 100)

Test Domain Composition The first task on a Test Domain diagram is to create the Use Cases (Test Sets).
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These define this particular domain's responsibility. The Diagram Toolbox and
shortcut menu provide Artifacts to help you achieve this. The first of these elements
is the Test Cut, which is used in the next step; identifying those methods (from the
Class model) that you consider to be participants in the Use Case. The Test Cut
Artifact is useful because it allows us to partition a Class, selecting only those
methods that are relevant. Test Cuts can be run individually or linked to one or
more Test Sets. Test Sets in turn can be linked to one or more Test Suites. In any
case, any element of the Test Domain tree can be run individually or as a whole.

w«testset»

Buy Stock

(from Buy)
wtestsuites

Trade Stock

wtestsets
Sell Stock

(from Seli)
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Test Cut

atestocuts
TestCutd

Description

A Test Cut element is a stereotyped Object element, used internal to Enterprise Architect for defining Test Sets using the
Testpoint code testing facilities.

A task, such as 'Print', might involve operations on different Classes. In order to create a 'Print' test, you would want to
include only the 'Print' operations of these Classes and exclude any other operations.

A Test Cut enables you to capture only the operations that represent the behavior (in this case, 'Print') defined for a single
Class. You might then place the Test Cut from each of several Classes into a single task as a Test Set.

When you drag a Test Cut element onto a Test Domain diagram, you create a Dependency relationship with the required
Class element. As a result, when you select the Test Cut element on the Testpoints window, the operations of the Class
are listed in the window, each with a checkbox. You then select the checkbox against each Class operation to include in
the Test Cut.

Toolbox icon

Bl TestCut

(c) Sparx Systems 2025 Page 234 of 253 Created with Enterprise Architect



Visual Execution Analysis 2 September, 2025

Test Set

wtestsets

Test5et

Description

A Test Set element is a stereotyped Use Case element used to aggregate one or more groups of methods (Test Cuts),
which perhaps span multiple Classes, into a single task. Test Sets can also be aggregated into Test Suites.

You link the Test Cut elements to the Test Set using Dependency connectors.

Toolbox icon

i Test Set
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Test Suite

wtestsuites

TestSuite]

Description

A Test Suite element is a stereotyped Use Case element, used to aggregate one or more groups of tasks (Test Sets).

You link the Test Set elements to the Test Suite using Dependency connectors.

Toolbox icon

1 Test Suite -
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The Testpoints Window

The Testpoints Window is the hub where Test Domain constraints are composed. It is also the control that lets you verify
a particular Test Domain on a program. The program might be already running or it can be launched using the control's
Toolbar. Here you will also be able to see the results of your tests, as they happen. This control is context-sensitive,
responding to the selection of elements in the Browser window or on a diagram. Depending on the selection, tests can be
carried out on a single Class, a Use Case (Test Set) or a collection of Use Cases (A Test Suite).

Access

Ribbon Execute > Tools > Tester > Show Testpoint Window

Testpoints Window Columns

Column Usage
Tests Displays the name of the selected Testpoint object and the hierarchy of objects
beneath it.

The selected object can be a:
e (lass

e  Operation

e Test Cut

e Test Set or

e  Test Suite

Id For an Operation, this column shows a Testpoint marker icon (G) when the

Analyzer has successfully bound this operation in the target application. If no icon
appears in this column during a run, it indicates that the model and code base might
not be synchronized; perhaps the signature of the function has changed, or the
operation is a new method you are working on that exists in the source code but not
yet in your model.

For a Testpoint, this column shows a generated id number. This id number is used
in trace output to indicate which constraint is being referenced.

Constraints A pencil icon ( ¥ ) in this column indicates that one or more constraints are defined

for this Class or Operation.
Status During a test run, indicates these possible statuses:
e (%) Failed - Constraint has evaluated as false one or more times.
e ( ! ) Invalid Statement - Constraint failed to parse due to invalid syntax.

o ( ? ) Variable not found - A referenced variable name was not found at the
location where the constraint was evaluated.

No icon is shown if a constraint has Passed.
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Evals During a test run, indicates the number of times the Execution Analyzer has
evaluated this constraint.

Passes During a test run, indicates the number of times the test passed.
Fails During a test run, indicates the number of times the test failed.
Last Run By Displays the username of the last person to run this test. (Values are derived from

the Project Author definitions in the 'People’ dialog - 'Settings > Reference Data >
Model Types > People > Project Authors'.)

Last Run Date Displays the date and time this test was last evaluated.
Last Run Result Displays the result of the last test run.
Parent Collections Pane Lists any parent collections that include the selected object as part of their design.

Double-click this collection to make it the selected object in the left pane.

The Parent Collections pane can be hidden by clicking the Show / Hide Parent
Collections pane button on the Testpoints Window Toolbar.
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Testpoints Toolbar

The Testpoints Window Toolbar provides options to execute configured tests on the currently selected Testpoint object,
stop a test run currently in progress, filter the displayed items, and save the results of a completed test run.

Access

Ribbon Execute > Tools > Tester > Show Testpoint Window

Testpoints toolbar options

Toolbar Button Action
TR T AT Field showing the name of the currently selected Testpoint object.
b Execute the test run.
- Stop the test run currently in progress.
2 Toggle between showing all items and showing only those items that have

constraints defined.

] Toggle between showing all items and showing only operations that have been
marked for inclusion in this Test Cut; this button is only enabled when a Test Cut
object is selected.

When a Test Cut is selected, each of the operations of its associated Class are
displayed with a checkbox; you use this checkbox to mark the operations that apply
to this Test Cut.

e Click on the drop arrow next to this icon to display the 'Test Run Options' menu,

providing these options:

e 'Prefix Trace output With Function Call' - Prefix all trace output lines with the
executing function name

e 'Enable Standard Breakpoints during Testing' - When not checked, the test run
ignores any breakpoints in the current breakpoint set, and any attempts to set
breakpoints during the run are ignored

e 'View Trace output' - Display the 'Testpoints' tab of the System Output window

] Click on this icon after completion of a test run to save the results to Test item on

the current object. Saved tests can be viewed using the Testing Workspace.

A prompt displays to select the Test Class - Unit, Integration, System, Inspection,
Acceptance or Scenario. Select the appropriate Test Class and click on the OK
button.
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Display the Testpoint Management Help topic.

Show or hide the Parent Collections pane.
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Testpoint Editor

The Testpoint Editor is used to compose constraints for Classes and Operations. The types of constraint permitted are
dependent on the selected object. For Classes, the type will always be Invariant. For operations, the type can be either
Pre-Condition, Post-Condition or Line-Condition.

Invariants are evaluated by the Analyzer when any method called on an object of the selected Class type completes.
Pre-conditions are evaluated at the beginning of each call to the specified operation. Post-conditions are evaluated upon
completion of each call to the specified operation. Line-conditions are evaluated each time the specified line of code is
executed.

V'J Testpoint Editor: : Exchange.Stock::GetStockVolume() =

Constraint

Type: Pre-Condition -

Conditian: m_stVolume == 0

Action on Fail: | g preak execution -

Evaluate

When:

Trace

Level: Fail Only =

Statemert: | Stock volume: @m_stkVolume is not allowed to be negative

oK Cancel || Help

Access

Ribbon 1. Execute > Tools > Tester > Show Testpoint Window.

2. In the Testpoints window, double-click on a Class or Operation to display the
'"Testpoint Editor' dialog.

Constraint Group fields

Field Usage

Type The type of constraint for the selected Class or Operation:

e [nvariant - Evaluated after any method called on the specified Class has
completed

e Pre-Condition - Evaluated at the beginning of each call to a specific Operation
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e Post-Condition - Evaluated after completion of each call to a specific

Operation
e Line-Condition - Evaluated upon execution of a specific line of code within an
Operation
Offset For Line-Conditions only, the Line number within the specified operation upon

which to evaluate the constraint.

An offset value is automatically set if the Testpoint was created using the Code
Editor context menu.

Condition The constraint to be evaluated when this Testpoint is triggered. A status of pass or
fail will be recorded depending upon whether this constraint condition evaluates as
true or false.

Action on Fail Click on the drop-down arrow and select from the three options:
e 'Continue' - ignore failure of this constraint and continue execution
e 'Break execution' - halt execution and display the Stack trace

e 'Disable on fail' - do not execute the constraint again after failing once

Evaluate When (Optional) An additional constraint which must be met before the main Testpoint
Condition is evaluated, providing greater control over test coverage.

Trace Group fields

Option Action
Level Specifies when the trace statement (if defined) will be output. Available options
are:

e 'Fail Only' - Output trace statement only when this Testpoint condition fails

e 'Always' - Output trace statement every time this Testpoint is evaluated

Statement (Optional) A message to be output when this Testpoint is evaluated.

Variables currently in scope can be included in a trace statement output by
prefixing the variable name with a $ token for string variables, or a @ token for
primitive types such as 'int' or 'long'.

Output from a Trace Statement can be directed either to the 'Testpoints' tab of the
System Output window, or to an external file, as configured by the Analyzer Script
for the parent Package.
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Testpoint Constraints

A Constraint is typically composed using local and member variables in expressions, separated by operators to define
one or more specific criteria that must be met. A constraint must evaluate as true to be considered as Passed. If a
constraint evaluates as false, it is considered as Failed.

Any variables referenced within the constraint must be in scope at the position where the Testpoint or Breakpoint is
evaluated.

General/Arithmetic Operators

Operator Description

+ Add
Example: a+b>0

- Subtract
Example:a-b>0

/ Divide
Example:a/b==

* Multiply

Example:a *b==c¢

% Modulus
Example: a % 2 ==

0 Parentheses - Used to define precedence in complex expressions.
Example: ((a/b) * ¢) <= 100

[] Square Brackets - Used for accessing Arrays.

Example: Names[0].Surname == "Smith"

Dot operator - Used to access member variables of a Class.

Example: Station.Name == "Flinders"
> Alternative notation for the Dot operator.
Example: Station->Name == "Flinders"
Comparison Operators
Operator Description
= Equal To
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Example: a=b

== Equal To

Example: a ==

1= Not Equal To

Example: a !=b

<> Not Equal To

Example: a<>b

> Greater Than

Example: a>b

>= Greater Than or Equal To

Example: a>=b

< Less Than

Example: a<b

<= Less Than or Equal To

Example: a<=b

Logical Operators

Operator Description

AND Logical AND
Example: (a >= 1) AND (a <= 10)

OR Logical OR
Example: (a==1) OR (b==1)

Bitwise Operators

Operator Description

& Bitwise AND
Example: (1 & 1)=1
(1&0)=0

Bitwise OR
Example: (1]1)=1
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(110)=1
A Bitwise XOR (exclusive OR)
Example: (17 1)=0
ar0=1
Additional Examples
Example Description
((m_nValue & Use a Bitwise AND operator (&) with a hexadecimal value as the right operand to
0xFFFF0000) == 0) test that no bits are set in high order bytes of the variable.
((m_nValue & Use a Bitwise AND operator (&) with a hexadecimal value as the right operand to
0x0000FFFF) == 0) test that no bits are set in low order bytes of the variable.
m_value[0][1] =2 Accessing a multi-dimensional array
a AND (b OR ¢) Combining AND and OR operators, using parentheses to ensure precedence. In this

example, variable 'a' must be true, and either 'b' or 'c' must be true.

Notes

e  String comparisons are case-sensitive
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Unit Testing

Enterprise Architect supports integration with unit testing tools in order to make it easier to develop good quality
software.

In sequence:

e  You download and install the NUnit and JUnit applications (NUnit - http://www.nunit.org/ JUnit -
http://www.junit.org/); Enterprise Architect does not include these applications in the installer

e  Enterprise Architect helps you to create test Class stubs with the NUnit and JUnit transformations
®  You define your test code within the Class stubs
e  You set up and run a test script against any Package

e  All test results are automatically recorded inside Enterprise Architect
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Set Up Unit Testing

This topic explains the actions you should take in setting up Unit Testing, after having downloaded and installed the
JUnit and/or NUnit applications.

Actions
Action Details
Create Unit Test Stubs By using the JUnit or NUnit transformations and code generation you can create
test method stubs for all of the public methods in each of your Classes.
(TestFixture)
public class CalculatorTest
{
(Test)
public void testAdd(){
}
(Test)
public void testDivide(){
}
(Test)
public void testMultiply(){
}
(Test)
public void testSubtract() {
}
}
Define Test Cases Write your unit test in the generated code stubs (either in Enterprise Architect or in
your preferred IDE).

This is an NUnit example in C#, although it could also be any other .NET language,
or Java and JUnit.

(TestFixture)
public class CalculatorTest
{
(Test)
public void testAdd(){
Assert.AreEqual(1+1,2);
}
(Test)
public void testDivide(){
Assert.AreEqual(2/2,1);
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(Test)

public void testMultiply() {
Assert.AreEqual(1*1,1);

}

(Test)

public void testSubtract(){
Assert.AreEqual(1-1,1);

Alternatively, if you have not performed an xUnit transformation, you can reverse
engineer the code into Enterprise Architect so that the system can record all test
results against this Class.

Compile Your Code Check that the source code being tested compiles without errors, so that the test
scripts can be run against it.

Set up the Test Scripts Set up the Test scripts against the required Package, and then run the tests.
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Run Unit Tests

On running a test script you generate test results that are stored as Test Cases against the Classes being tested.

Access
Ribbon Execute > Run > Start > Test
Execution Analyzer ToolBar > Run Test Script
Window Context Menu > Test
Tasks
Task Details
Run Tests Select the appropriate Package in the Browser window.
Select the 'Run Test Script' option to run the test script you previously set up for
that Package, in the Execution Analyzer.
View Results The results of xUnit tests are displayed in the System Output window, identifying

which tests have run and which of these have failed.

The results also show which method failed, and the file and line number the failure
occurred at.

Double-click on an error message; Enterprise Architect opens the editor to that line
of code, enabling you to quickly find and fix the error.

Enterprise Architect also records the run status of each test against the Class being
tested; these are stored in the element Test Cases.

A diagram containing the Class can be set to display these Test Cases, by exposing
the test scripts compartment on the diagram elements.
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Record Test Results

Enterprise Architect is able to automatically record all results from tests through a testing script in Enterprise Architect.

Process

In order to use this feature, you must reverse engineer the test Class into the Package containing your test script.

Once your model contains your test Class, on the next run of the test script Enterprise Architect adds Test Cases to the
Class for each test method found; on this and all subsequent test runs all Test Cases are updated with the current run time
and whether they passed or failed, as shown:

Calculator Test

testAdd() : woid
testDivide() : void
testMultiphy() : woid
testSubtract() : woid

o

test scripts
Unit: : (Pass) testAdd
Unit: : (Pass) testDivide
Unit: : (Pass) testhMultiphy
Unit: : (Fail) testSubtract

The error description for each failed test is added to any existing results for that Test Case, along with the current date
and time.

Over time this provides a log of all test runs where each Test Case has failed, which can then be included in generated
documentation, resembling this:

Failed at 05-Jul-2006 1:02:08 PM
expected: <0>

but was: <1>
Failed at 28-Jun-2006 8:45:36 AM

expected: <0>

but was: <2>
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Samples

Enterprise Architect enables you to easily import complete sample models (Packages), including all necessary model
information, code and build scripts. These sample Patterns make it simple to explore and try out the Visual Execution
Analyzer. You can generate an example model for:

e Java

e  Microsoft.NET
e  Microsoft C++
e PHP Apache

Access
Ribbon Develop > Source Code > Create From Pattern > VEA Examples
Display Samples
Field Action
Technology Select the appropriate technology.
Name Displays the samples available for the selected technology; select the required
sample to import.
description field Displays a description of the selected sample.
Destination folder Browse for and select the directory in which to load the source code for the sample.
Use Local Path Enable the selection of an existing local path to place the source code under;
changes the 'Destination folder' field to a drop-down selection.
Compiler command Displays the default compiler command path for the selected technology; you must
either:
e  Confirm that the compiler can be found at this path, or
e  Edit the path to the compiler location
Edit Local Paths Many VEA examples specify their compiler using a local path.
The first time you use any sample you must click on this button to display the
'Local Paths' dialog, on which you check and - if necessary - correct the local path
pointing to the correct compiler location.
Notes
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e Ifrequired, you can define custom samples by adding files to the AppSamples directory in which Enterprise
Architect is installed; top-level directories are listed as Technologies and can contain an icon file to customize the
icon displayed for the technology
Directories below this are defined as groups in the Patterns list; the Patterns are defined by the presence of four files
with a matching name: a zip file (.zip), XMI file (.xml), config file (.cfg) and optional icon (.ico)

e The config file supports these fields:
- [provider], [language], [platform], [url], [description], [version] - all displayed in the 'description’
field
- [xmirootpaths] - the root path of the source code in the exported XMI; this is replaced with the
selected destination folder when the user applies the application pattern
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